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"Leer defijne
kneepjes van
Photoshop en
breng ze direct
inde praktijk!”

www.photoshopmagazine.nl
&4 redactie@photoshopmagazine.nl
£ www.facebook.com/PhotoshopMagazineNL
@photoshop_magNL
www.youtube.com/photoshopmagazine

lle begin is moeilijk. Maar dankzij onze
feature, die je kunt lezen vanaf pagina 18,
geldt dat niet voor je eerste stappen in
Photoshop.
Voor elke vaardigheid is het van het grootste belang
dat je een goede basis hebt. Daarom leiden we je in
het artikel door de belangrijkste functies die je moet
kennen om het programma onder de knie te krijgen.
We maken je wegwijs in de meest gebruikte gereed-
schappen, laten zien hoe je onderwerpen in een foto
selecteert en onthullen wat de kracht van lagen is.
Daarnaast komen ook de filters, aanpassingslagen
en overvloeimodi uitgebreid aan bod. Het mooie van
deze minicursus is dat je de vaardigheden meteen in
een creatief project in de praktijk kunt brengen. Zo
leer je in slechts een week tijd niet alleen de belang-
rijkste kneepjes van het photoshoppen, maar pas je
ze ook direct toe om een schitterende fotomontage
te maken.

Natuurlijk komen ook de meer ervaren creatieve-
lingen in dit nummer uitgebreid aan hun trekken. We
hebben weer een aantal uitdagende workshops voor
je in petto. Mijn persoonlijke favorieten zijn bijvoor-
beeld het sprookjesachtige boomhuis van pagina 74,
het sfeervolle acrylschilderij van pagina 62 en de
workshop op pagina 44, waarin je dag en nacht
combineert.

Deze weken waarin de dagen kort en de avonden
lang zijn is de perfecte tijd om achter je pc te kruipen
en aan de slag te gaan met uitdagende en leerzame
fotoprojecten. Deze uitgave staat er weer bol van!

Veel Photoshopplezier!

Rscal Geegils

Pascal Gerrits
Hoofdredacteur
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MEER DAN

360 Neem nu een'
gy abonnement! 'Workshops

18 Leer Photoshop 62 Kerstsfeerinacryl

Combineer -
dag en nacht

Het samenvoegen van twee
werelden was nog nooit zo leuk:

in 7 dagen
Ontdek de gereed-
schappen en opties

Maak een sfeervolle
afbeelding in acryl-
verfstijl

A4 Combineer dag 68 Verbeter de
en nacht belichting
Voeg twee Zo pak je onder- en
werelden samen overbelichting aan

52 Maakeen 74 Een fantasierijk
sci-fiposter boomhuis
ledereen kan aan- Verander een gewone
trekkelijke posters boom in een magisch
ontwerpen stulpje

60 Vervorming 82 Inside CC -
verwijderen lllustrator
Corrigeer Afbeeldingen overtrek-
vervormde foto's ken en schilderen

voor beginners

Nog niet eerder met Photoshop gewerkt? |
Blader naar het beginnersdeel!

88

90

Automatische
functies
Verbeter je foto's
snel en goed

Rand verfijnen
Maak perfecte
selecties

94 Kleuren verbeteren

Zo laat je een foto
stralen

100 Afbeeldings-

resolutie
Hoe zit het nou
met die pixels?
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Nieuws & Trends Gespot door de redactie

Verrassend compact

Compactcamera's zijn nog =
niet uitontwikkeld

De PowerShot G7 X doet het goed in matige lichtomstandigheden.
Dat heeft vooral te maken met de cmos-sensor van 1inch en de
resolutie van 20,2 megapixel.

Het formaat van de 1-inchsensor maakt ‘m bovendien zo compact
dat hij zo in je jaszak past. De lens is een f1.8-f2.8 zoomlens.

Met dit model gaat Canon de concurrentie aan met de topklas-
se compacts, zoals de RX100-modellen van Sony. Ondanks dat de
markt van compactcamera's het zwaar te verduren heeft, is er
toch innovatie te zien in de bovenkant van dit segment. De Canon
G7 X heeft een adviesprijs van 599 euro.
www.canon.nl

N,
KORG CLIPHIT DRUM KIT

Altijd en overal
drummen Slimme
Wissel beeldschermwerk af met een telefoonhoes

gezonde dosis ritmische gymnastiek Foto's printen met een
smartphonecase

leder jaar vindt in januari de CES, een grote elektroni-
cabeurs, plaats in Las Vegas. Op deze editie introdu-
ceren twee Fransen een bijzondere smartphonecase.
Deze kan namelijk foto's printen die gemaakt zijn op
een smartphone met de speciale Prynt-app. De Prynt
Case is gemaakt voor telefoons met een display van
4 tot 5 inch. Een afdruk maken duurt ongeveer dertig
seconden.

De gebruikte app maakt overigens niet alleen een
foto, maar neemt ook de momenten ervoor en erna
op. De resulterende video wordt naar de servers van
Prynt gestuurd. Je kunt deze vervolgens bekijken
door de originele geprinte foto voor de camera te

Ben jij ook zo'n type dat nooit stil kan zitten en altijd met zijn vingers houden. De prijs voor het hoesje gaat ongeveer 80
overal op trommelt? Til je beweeglijkheid dan nu naar een hoger ni- euro bedragen en inkt kan via de app besteld worden.
veau met de Korg Cliphit Drum Kit. Dit apparaat bestaat uit drie clips www.pryntcases.com

met sensoren en een voetswitch. Deze clips kun je aan van alles en
nog wat vastklikken, zoals aan dit tijdschrift, een bureau of een koffie-
mok. Vervolgens kun je in realtime drummen met echte drumgelui-
den. Het volume verandert mee met de kracht van je slag en kan
bovendien voor elke clip of pedaal afzonderlijk aangepast worden. Via
de AUX-IN kun je een mp3-speler aansluiten om mee te drummen. Er
zijn diverse standen beschikbaar voor verschillende drumkits, waar-
onder standaard, rock, pop en percussie. Naast de optionele adapter
kun je ook 4 AA-batterijen gebruiken om 6 uur zonder stroom uit de
muur te kunnen spelen. En goed nieuws voor de buren: het apparaat
heeft ook een aansluiting voor een koptelefoon.
www.korg.com/us/products/drums/cliphit
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Type Genius

Vind de perfecte combinatie

van lettertypen

Gebeurt het jou ook regelmatig dat je een leuk lettertype hebt ge-
vonden voor je project en dat je vervolgens uren aan het zoeken bent
naar een tweede font dat hier goed bij past? Stop met zoeken en
begin met vinden, want Type Genius neemt je deze klus uit handen.
Kies uit de lijst een font

om mee te beginnen ]

en de website vertelt je
precies welke andere
lettertypen hier goed
bij passen. Zo heb je je
setje snel compleet en
kun je weer verder met

Find the perfect font combo
for your next project.

Comic Serif Pro -

je project. De lijst bevat _

diverse veelgebruikte

webfonts zoals Museo, R ]
|
I

The quick brown fox ¥ | Cute
jumped over the lazy

Comic Serif en Open
Sans, dus dat vormt
alvast een goed uit-

gangspunt. =
www.typegenius.com

Goedkope tablet

Voordelige tablet voor
de kleine portemonnee

Wanneer je op zoek bent naar een
goedkope tablet heeft HP een interes-
sant nieuw model. De HP Stream 7 is
een 7-inchtablet met een volledige
versie van Windows 8.1 voor de vrien-
delijke prijs van 129 euro. Hij wordt
geleverd met een jaar Office 365 Per-
sonal en 60 minuten Skype per
maand. Verder wordt er ook voor een
jaar 1 TB opslagruimte bij Microsoft
OneDrive meegeleverd. Wil je liever
een notebook? HP heeft ook de
Stream 11,6 inch geintroduceerd voor
229 euro. Deze Windows 8.1-laptop is
lekker stil en heeft 32 GB aan opslag-
ruimte aan boord. Verder is hij be-
schikbaar in twee opvallende kleuren:
orchid magenta en horizon blue.
www.hp.nl

GEEF _JE

Koop nu een Intuos Pro met veel voordeel

Wat dacht je bijvoorbeeld van een volledig abonne-
ment op de Creative Cloud voor 3 maanden, een
kadobon ter waarde van 50 euro bij WhiteWall en
abonnement voor 90 dagen bij Autodesk SketchBook.
De Intuos Pro is een must voor iedere beeldbewerker.
Wil je optimaal gebruik maken van je creativiteit dan is
dit grafisch tablet precies wat je nodig hebt. Professio-
nele resultaten liggen binnen handbereik dankzij de
combinatie van de hightech-stylus en intuitieve multi-
touchmogelijkheden. Ervaar zelf de precisie en controle
in samenwerking met professionele software.

Koop je Intuos Pro tussen 1-11-'14 en 28-2-'15 en
registreer hem voor 31-3-'15 op www.wacom.eu/register
om gebruik te maken van deze aanbieding.

.\ <8

Adobe wWacom

[ IWHITE waLL

A S

/ =
\d




Contact Beste redactie

Beste redactie,

Vragen, opmerkingen of iets te delen? Dat kan hier!
redactie@photoshopmagazine.nl

®1 facebook.com/PhotoshopMagazineNL
] @Photoshop_MagNL

Werk delen op Facebook

Ik heb geen idee waar ik dit moet plaatsen, maar ik las in het magazine dat ik
op deze Facebooksite moest zijn. Ik heb een creatie gemaakt die ik graag wil
laten zien. Ik moet eerlijk bekennen dat ik het best eng vind. omdat het de
eerste keer is voor mij buiten Behance om. Ik hoop dat het een beetje aan
de eisen voldoet. Dit is de link naar mijn portfolio: www.behance.net/
angeliqueH

Angelique Bargerink, via Facebook

Hoi Angelique,
Bedankt voor je inzending! Hartstikke leuk dat je iets wilt delen.

Als je een volgende keer werk wilt delen, kun je het beste gewoon iets op
onze tijdlijn posten. Je gebruikt dan het vakje waar in staat “Wat heb je
gedaan?"”. Je kunt ook de knop “Bericht” gebruiken die in onze omslagfoto
staat. In het eerste geval kunnen wij je werk makkelijker delen, en kan iedereen
het al zien voordat we het delen. In het tweede geval stuur je ons een bericht
dat alleen wij kunnen lezen. Dat kan natuurlijk ook, maar als je iets wilt delen
met andere lezers, is het makkelijker als je meteen op onze tijdlijn schrijft.

Christina Cats » Photoshop Magazine
- - 4novermberom14:34 - @

Vraagje: ik heb ondertussen tig nummers verzameld. Ik zoek nu een manier om iets terug
te vinden, een bepaald onderwerp, een besproken techniek. Is er bijvoorbeeld een
overzicht van de covers van de afgelopen jaren?

Vind ik leuk - Reageren - Delen - &5 2

Mirailla A allare b
Mireille Aalbers heeft

Christina Cats Ahalll thx
7 novemberom 14:03-Vind ik leuk
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Workshopsover

anderesoftware

Graag had ik vernomen of er Nederlandsta-
lige boeken en/of schriftelijke cursussen
bestaan over het programma Adobe After
Effects. Zo ja, mag ik dan van jullie de
nodige inlichtingen om hetzij een boek of
cursus te bestellen? Misschien is het )
mogelijk om ook één maal per maandelijkse "yt;s
uitgave een workshop of oefening op te '
nemen in het Photoshop Magazine over dit
programma?

B S 5 .
p % |

“ es B~ b 45 : |
De ultieme gids voor ! i L 2 &

? !

Raymond Lenaerts

Beste Raymond,

Een snelle zoektocht op internet bij bekende
uitgevers van computerboeken heeft helaas
niets opgeleverd. We kunnen via bol.com ' ‘ ‘ B

alleen Engelstalige boeken vinden. Verder Op veler verzoek eindelijk binnenkort te koop: Een speciale uitgave met workshops

hebben wij hierover nooit onderzoek of over lllustrator, InDesign, After Effects en Photoshop!
reviews gedaan, ook niet over cursussen, dus f
wij kunnen daar geen advies over geven. InDesign en natuurlijk ook Photoshop. Bovendien plaatsen we sinds kort in

Je vraag komt echter precies op het juiste Deze speciale uitgave ligt vanaf 23 december  elk nummer ook een workshop uit deze
moment. Op dit moment zijn wij namelijk zelf  in de Nederlandse winkels, maar is een week speciale uitgave in ons reguliere nummer.

een speciale uitgave aan het maken met eerder al te koop via onze webshop In nummer 29 was het de beurt aan After
workshops over After Effects, lllustrator, www.fnl.nl! Effects met een workshop over Chromakey.

Gezien op Facebook

Smokey-skull - Heb je een rood-blauw.
3D brilletje? Zet hem op, geef je.ogen

even de tijd om zich aan te passen
en enjoy...
© Thierry Wybauw

No Hand Feeding
© King Richard Pictures

Fan-art gemaakt voor de premi- SR
ereivan seizoen 3 van Arrow. ; - 5 Fantasiebal gemaakt met Photoshop CC
© Zulfugar Eyvazov. ¥ © Ronald Burgess Fractal Art Paulus

PHOTOSHOP MAGAZINE 9



Community Gallery

10

Galler

www.photoshopmagazine.nl

y

Jouw werk in Photoshop Magazine?
Dat kan op verschillende manieren:

1. E-mail

Mail ons je werk in lage resolutie
(max. 10 MB). Zet in de onderwerp-
regel van je mail ‘Gallery’.
redactie@photoshopmagazine.nl

2. Facebook

Stuur ons een bericht via Facebook.

Dan kunnen andere lezers je werk
meteen becommentariéren.
facebook.com/PhotoshopMagazineNL

Als we plek voor je hebben, nemen we contact met je op.

JackUsephot

“Omdeze afbeel-
| dingtemaken
B gebruikteiktex-
i turen, perspectief
i enveellichten
=22 Kkleur. Ditwerkis
geinspireerd op hetwerkvan
Erik Johansson.”

PHOTOSHOP MAGAZINE

3. Twitter

Stuur een link naar je werk via Twitter.
Eenvoudiger kan bijna niet!
@Photoshop_MagNL
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. Katt Amaral

| www.designbykatt.deviantart.com

e

“Ditfantasywerk
iseencombinatie
| vanstockfoto's
| enmixed-media

schilderwerk. Ik

- concentreerde me

opzachtekleurenenschadu-
wenomditwinterse werkleven
inteblazen.Metaangepaste
penselenvoegde ik sneeuw
toeenikversterkte hiermeede
magische sfeer.”
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Community Gallery

PHOTOSHOP MAGAZINE

LoriKajenna

www.kajenna.weebly.com

# “Dezeafbeelding

§ bestaatuitvier

i lagenwaaropik

i waterverf-en

§ olieverfpenselen

o= hebgemengd. [k

hebhierietsmeerdaneenuur
overgedaan.”
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Community Gallery

Sergey[akhachev

www.ph

| “Oorspronkelijk
| maakteikditwerk
voor eenwedstrijd,
maar toenbesloot
ikommeer details
: - eneenplottoete
voegen. Daarmee werd heteen
heelandere afbeelding. Hetidee
kwam spontaaninmeop.”

JulianaSoave

WWW.j owwhite.com

"Deze fotomani-

pulatie maakte ik

met Photoshop

CS6.lkwildeiets

voor Halloween

maken, dus bracht
ikdiverse afbeeldingen samen
om deze magischevoorstelling
temaken.”
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PasqualeScionti

desig m

“Ik wilde een creatief
werk maken. Toen ik
tijdens hetsurfenop
interneteengratis
wallpapervond, be-
slootikdebestaande
elemententevervangendooreen
stelrockende poesjes.”

“Ditwerk maakte
ikmeteenaantal
| afbeeldingen. Ik
zette ze bijelkaar,
maskeerdeen
: mengde voorna-

melijk met de modi Bedekken
enBleken. Ikgebruikte wat
aangepaste penselenvoorde
belichtingentot slot mixte ik
bovendeanderelagensubtiel
eenpaartexturen.”

PHOTOSHOP MAGAZINE
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Hetgeheimachter de mooiste foto’s

CAMERAFUNCTIES £3S
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basisboek 2014

Photoshop

126 pagina’s creatieve projecten, praktische
tips en stap-voor-stap workshops

Boordevol
tipsvoorde
mooiste foto’s o

OntdeK'meer mogelijkhaden!
vanje spiegelreflexcameray
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immlips voor perfecte foto’s |
nderden inspirerende beelden

pagina’s metti
techniek en inspiratie

e Phott
%rtnplete
Fotografie

- “Boek
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=
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=
i

i
16 pagina’smet i
fotograferene iek =5

voor beginners

Hét ultieme basisboek om alles uit Photoshop Elements te halen




Leer Pbatoshop in 7 dagen




®o @

=
a2

PEa N Ao BRNFAS A S0E

- \\ g
b ; ﬂ
: \ N o
-, >
G S
: Py _ b 4
. ‘\-.:(Jf ek < e
“ (£
: . 4
i~ -
beg Beg e
a O cen leeo e o
Ci o §— g Ca a aa
door alle stappen loodse
) [a) faY¥al aYa @) einae eLee
goed gevuld Lagenpalet te
cinaige bl (el

Gereedschappendiejemoetkennen

=[] Rechthoekig selectickader M |
{ ::. Ovaal selectickader M |
== Selectiekader één rij
E Selectiekader én kolom

Selectiekaders
Maaksnelselectiesopba-
sisivanveelvoorkomende
vormenmetideze kaders.
Combineerze met Altiof
Shiftvoorextracontrole.

w

«IM';. Toverstaf

Selectiegereedschappen
Selecteerpixelsopbasis
vanvoermmetSnellese-
lectie (Quick Selection),
ofopbasisvankleur
met de Toverstaf(Magic
Wand). Ze werkenvooral
goedbijveelcontrast.

= f Snel retouchesrpenses!
’ Retoucheerpenseel 1}
* Reparatie Ji
+® Rode ogen verwijderen J

Retoucheergereedschappen
Hiermeekunjeoneffen-
hedenverdoezelenidoor
erongereptepixelsover-
heenteplakken.

o .‘ Tegenhéuden o
@Bﬁordmkken o

g Spons

Belichtingsgereedschappen
Stuurhetoogvandekijker
doordebelichtingvanver-
schillendelagen te bein-
vloedenmet Tegenhouden
(Dodge), Doordrukken (Burn)
endeSpons(Sponge).

O |

u ‘*ypenseel B
A Poticod B |
-}{’ Kleur vervangen B

h‘/ Mixerpensesl B

Penselen

Mixkleuren, breng

digitaleverfaanen

teken met dit creatieve
schildersgerei.

Vulgereedschappen
Vulofvervaagbepaalde
gebiedendoorkleurrijke
verlopenaantebrengen
envermenglagenopdie
manier. Erzijnvoorinstel-
lingen beschikbaar.

._)Pan P

/. Pen voor vrije vorm p

"E}Ankemunt toevoegen
':,;;.}Ankemun! verwijderen
f\ Ankerpunt omzetten

Pen

Gebruikde Peninalzijn
gedaantenom vlijm-
scherpe,vioeiendevec-
torpadentetekenen.

. ‘.padgehcﬁe'

A
t} Direct selecteren A |

Padgereedschappen
Pasvectorvormenen
padentotindetailaanmet
Padselectie/(Path Selec-
tion)enDirect selecteren
(Direct Selection), zodat
zepreciesdevormkrijgen
diejeingedachtenhad.

 Dagl
- Selecterenop

maandag

v/ Toverstaf

¢ Snelleselectie
¢ Kleurbereik
¢/ Randverfijnen

Dag2
Lagenopdinsdag
v/ Laagstijlen

| ¢ Snhelselecteren

v/ Lagenpalet
v/ Laaggroepen

' Dag3

Retoucheren
opwoensdag

v/ Kloonstempel
v/ Vignetten

¢/ Aanpassingen
v Huidgladstrijken
v/ Filters

Dag4

 Tekenenenschilderen

opdonderdag

v/ Vectors

¢/ Maskers

¢/ Foto'snaschilderen
¢/ HetpaletPenseel

 Dag5

Filtersop vrijdag

¢/ DeFiltergalerie

v/ Vervagen
v/ Artistiekefilters

| ¢ Ruis
| & Verscherpen

Dag6

' Aanpassingslagen

enovervioeimodi
opzaterdag

¢/ Lagenmengselslichtermaken

v Lagenmengselsdonkerder
maken

v/ Lagenmengenopbasisvan
kleur

v/ Lagenmengenopbasisvan
contrast

¢/ Aanpassingslagen

Dag7
De laatste loodjes
opzondag

¢/ Lagenmengen

¢/ Detailsverbeteren

v/ Schaduwenenhooglichten
bewerken

v/ Dekkingondercontrole
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Leer Photoshop in 7 dagen
Maandag
Perfecte selecties

X

b
= Word de selectiegereedschappen de baas,
5 van het eenvoudigste hulpje tot het meest
H,
% complexe exemplaar i ,
3 Hoehetwerkt De Toverstaf (Magic
::‘ Doordat Photoshop een scala aan selec- avanceerdere technieken nodig. Met Pho- 01 Wand) traceert pixels met eenzelfde
R tiemethoden aanbiedt, kun je inbijnaelke  toshop kun je pixels dan bijvoorbeeld op 'I:'eL{[r enbda_tkbetekent dftjef?emdhggbﬁic
% P 2 3 . unt gebruiken om grote, erren, duldeli)
2 denkbare SItugtle gqed uit de voeten. Welk  basis van kleur Qf contrast ;elec‘geren. afgebakende gebieden te selecteren, Open
ﬁ’" gereedschap je nodig hebt, hangt sterkaf ~ Bovendien kun je alle selecties die je de foto die je wilt bewerken.
lil‘ van het beoogde eindresultaat. Vaak vol- maakt bewerken, verfijnen en opslaan. Op
0‘ staat een snelle en ruwe selectie, die je deze pagina's behandelen we de meest
.“ bijvoorbeeld kunt maken met de Toverstaf ~ elementaire selectiemethoden: de Tover-
r:f (Magic Wand) of Snelle selectie (Quick staf, Snelle selectie, Rand verfijnen (Re-
T Selection). Soms heb je echter wat ge- fine Edge) en Kleurbereik (Color Range).
X

' Randdetectie
| Vergroot de Straal (Radius) om
pixels bij de selectie te betrekken
die zich daarbuiten bevinden. Vink
Straal tonen (Show Radius) aan
om in de voorvertoning te zien hoe
groot hij is.

02 Instellingen Neem de Toverstaf uit
de Gereedschappenbalk en richt je
aandacht op de Optiebalk. Tolerantie (Tole-
rance) bepaalt hoe helder de tonen moeten

Teergavemodus - Zijn voor ze opgenomen worden in de selec-
1 het dialoogven- fandyerninel tie. Als je Aangrenzend (Contiguous) aan-
ter Rand verfijnen S vinkt, worden alleen pixels die met elkaar in
?g;‘gge%cé%e%gg'&e 3 P~ T verbinding staan geselecteerd.
2lectie moet R EI lorgned g () '
e e e c—— || Snelleselecties
ewerkt. wf‘* “""u gy Achter de Toverstaf vind je Snelle
e i selectie (Quick Selection). Hiermee
and aanpassen gt kun je delen van een afbeelding met
g%gé?ﬁ;e;adje 1 :::d o de grootste precisie selecteren,
Jfelige randen i U,. il o waarbij je met een enkele klik gebie-
sgen, Doezelaar e L e den toevoegt aan of verwijdert uit
'eef;‘rt‘gg)n"eer';vaagt ey Y de selectie. Pas de grootte van de
lontrast versterkt — Uitvoer punt aan met de vierkante haken op ol
&e};'lsvclzﬁtu?vaemd(Shift | '“'“""“":’;" S je toetsenbord. Klik of sleep om een T o

e T . . ¥ -
dge) maak je de N selectistemalon lBIeslceRy Q3
electie groter of ‘ zoekt het geree;lschap zelf de ran- en minder blokkerig. Laat Monster nemen
leiner. ‘ W“ﬂ*“w““’""} den van het gebied op basis van het van alle lagen (Sample All Layers) en Conti-
ﬂ / Annueren ) ok} contrast tussen de pixels. Houd de guous uitgevinkt, stel Tolerantiein op 100

————————=)  Alt-toets ingedrukt om delen uit de enklik opide lucht.

litvoer Met Kleuren zuiveren (Decon- 5 <
aminate Colors) ga je kleurschifting selectie te verwijderen.
agen en verwerk je de instellingen tot
en verbeterde selectie, een nieuwe

1ag of een masker.

Kleurbereik

Defunctie Kleurbereik(ColorRange)lijkt op.de
Toverstaf(Magic Wand) omdathijeenselectie
maaktopbasisvankleur, beperkttoteenspecifiek
gebiedofide heleafbeelding. Je kuntbijvoorbeeld al
allepixelsmeteenbepaalde kleuroflichtheid kiezen
doordebijbehorendeoptieinhetuitklapmenute

kiezen. Je kunookmethetPipet(Eyedropper)een
monsternemenenkleurenaandeselectietoevoe-
genofze eraanonttrekken.

O 4 Selectie omkeren Ga naar Selec-

teren>Selectie omkeren (Select>
Inverse) of toets Ctri+Shift+l. Toets Ctrl+J
om het geselecteerde onderwerp naar een
nieuwe laag te kopieren en schakel de
zichtbaarheid van de Achtergrondlaag uit
T : . f ! doorinhet Lagenpalet op het oogje ervoor
| selectievoorvertoning: e — - | : h ¥ R | te klikken.

o

- selacte_® Abeeldng

=
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1 Start een creatief project

Breng je opgedane kennis meteen in de praktijk en voltooi
de eerste stappen van het grote project dat je aan het eind
van de week kunt afronden

In deze feature laten we zien hoe je een betoverend kunst- De wolken isoleren we met behulp van de Opties voor
werk kunt maken terwijl je Photoshop leert kennen en overvloeien (Blending Options). Als deze niet in jouw
oefent met de besproken gereedschappen en technieken. versie van Photoshop voorkomen, kun je als alternatief
We beginnen met de achtergrond en gebruiken de meest een masker toevoegen aan de wolkenlaag en de randen
praktische selectiefuncties, waaronder Rand verfijnen wegschilderen met een zwart Penseel (Brush). We gaan
(Refine Edge). Daarmee scheiden we het meisje van sowieso aan de slag met dat gereedschap, maar ook
haar omgeving en plaatsen we haar op een nieuwe laag. met Slimme objecten (Smart Objects) en diverse filters.
Op die manier kun je later elementen voor en achter Verschillende aanpassingslagen zorgen voor de finishing
het meisje toevoegen, waardoor je diepte cregert. touches van deze wonderlijke compositie.

Ruweselectie Open de startfoto % ¥ Randverfijnen Ganaar Selecteren> @ “% OpschonenNeem het Penseel
(opde cd) enneem het Rechthoekig '=n Rand verfijnen (Select>Refine Edge)  “’ud (Brush)en stel hem via de Optiebalk

selectiekader (Rectangular Marquee). Maak  of klik op de gelijknamige knop in de Optie- in op 80% Dekking (Opacity) en 50% Hardheid

een selectie rond het meisje en kopieerhaar  balk. Schilder met dit venster geopendrond  (Hardness). Schilder met zwart op het laagmas-
naar een nieuwe laag door Ctrl+J te toet- deselectieranden enkies Laagmasker (Lay-  ker om de achtergrond te bedekken en met wit
sen. Gebruik vervolgens Snelle selectie er Mask) bij Uitvoer naar (Output To). Klikop ~ omdelen van het meisje weer te geven. Maak
(Quick Selection) om een nauwkeurigere OK enmaak de Achtergrondlaag onzicht- daarnade Achtergrondlaag weer zichtbaar.
selectie van het meisje te maken. baar (klik op het oogje).

Selecties die ertoe doen In dit geval is het
| heel belangrijk dat je een goede selectie
maakt als basis voor het masker.
Daardoor kun je de kwaliteit van het
eindresultaat enorm verhogen.

en klik op de maskerminiatuur in het Lagen-
palet, zodat het laagmasker zwart-wit wordt
weergegeven op het canvas. Nu kun je goed
zien hoe hard de randen zijn. Zet op strategi-
| sche plekken wat penseelstreken om dingen
zichtbaar te maken of te verbergen.

Masker bewerken Houd de Alt-toets ingedrukt 1

Masker loskoppelen Om het masker en de
| laag los van elkaar te kunnen schalen
| envervormen, moet je ze ontkoppelen.
| Dat doe je door op het kettingsymbool
tussen de miniaturen te klikken. De
| transformatiegereedschappen activeer
| je door Ctrl+T te toetsen.

PRN A SN0 7

Jre

| Selectiegereedschappen combineren
| Door het Rechthoekig selectiekader
| (Rectangular Marquee) en Snelle selectie
| (Quick Selection) in stap 1 te combine-
ren, kun je het meisje razendsnel op een
nieuwe laag zetten en uitknippen.

= f 0 06 0 3§
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Leer Photoshop in 7 dagen

Dinsdag

TIpy,

= L 1 NDE pxp.
.| Leren over lagen o, 13388 TOG L T
] ; er meer.

o Werk verantwoord en gebruik meerdere lagen o de bovensta ¢ 1agen oo,
reek nd,

e toets Cry,. hift-i ee;;rzte
=, Lagen zijn zonder twijfel het beste dat ooit aan Het is voor alle digitale kunstenaars in de dop erLgen i een groes Netes op te
:i Photoshop is toegevoegd. Zonder hen zouden belangrijk om het Lagenpalet van binnen en o\‘/ae%_e’?Palet. 5 fqu.ap in het
&, de bewerkingsmogelijkheden veel beperkter buiten te leren kennen, want het bevat een #Icht beter bewfrget
zijn. Terug in de tijd gaan om dingen ongedaan aantal geheimen die de deuren naar je eigen i

"_- te maken of instellingen te veranderen is dan creativiteit kunnen openen.

@ onmogelijk. o~ .

4 Wat zijnlaagstijlen?

. Lagen aanpassen Er bestaan ook Flexibel karakter Zonder |

0, aanpassingen in de vorm van lagen, lagen zou het moeilijk zijn | 3 - ;

Q waarmee je de kleur en belichting van om kleine elementen ‘ Laagstijlenzijncreatieve effecten

f[} i/l;ldi_\/iccljuele eleme'ntenlktlmt aangassketn. zoals glasschervsen E(e 3 diejeaaneenlaagtoevoegt.

Q s je de aanpassing als laag gebruikt, perfectioneren. Stukjes i it

T, | kun je instellingen achteraf op ieder die op een aparte laag Erlsvana.ﬂles OGRS ECE

%, M gewenst moment veranderen. staan kun je echter eenvoudige Slagschaduw

@ — . | afzonderlijk verplaatsen, (Drop'Shadow) toteencomplexe

) 3 schalen en vervormen. Patroonbedekking(Pattern

Q Overlay)waarmeejestructuurkunt

B g toevoegen.lLaagstijlengevenije

| | werkdiepte endetail. Jehoeftgeen

ol nieuwelaagtemakenomdezeef-

fectentoetevoegen,wantzeworden
alseensoortiaanhangselverbon-
denaandelaagwaarzebijhoren.
Dubbelklikopeenlaagofganaar
Laag>Nieuwelaagstijl(Layer>New.
Layer Style)omereentekiezen.
Deinstellingenkun jeachterafnog
wijzigen!

Lagen verwijderen Door lagen
toe te voegen en te verwijderen
kunnen we een dynamische
compositie zoals deze maken.
Het is ook mogelijk om lagen te
verplaatsen of om de volgorde

| te wijzigen. Zo kun je spelen
met diepte.

Optias voor overviosien: standaard At st ﬁ;ﬁé;u@; . Annuleren

(0] Slagschaduw Dekking: e 75 % Hieuwe stil..
I

| |91 Gloed buten
[7] Gloed binnen Afgtand: e (e

| Nieuwelagen Maak razendsnel een nieuwe
] Schuine kant en retisf Inperken; (e g . \

| laag door Ctrl+Shift+N te toetsen, of klik
| op de knop Een nieuwe laag maken (Create

i [ Contour Grootte: ~—(}—
| a New Layer) onder in het Lagenpalet. B i
[l setn e
|| | [ Keurbedekking “’"’“‘"Am anerasm:w
[T¥edocpbadskking Py LA g 1 |

i| | [ Patroonbedekking e J[ herstelien ]

Plaats op het canvas Ctrl-klik op
een laagminiatuur om een
selectie te laden, zodat je kunt
. | zien welke ruimte de bewuste
laag op het canvas inneemt.
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2 Kleed de achtergrond aan

Ga een stapje verder en haal de wolken erbij

} m%& Optlesvoorovervloelen Ganaar
Bestand>Plaatsen (File>Place) en
blader naar Wolkenl.jpg op de cd. Schaal
de foto en toets Enter. Klik op het zwarte
pijltje rechtsbovenin het Lagenpaleten
kies Overvloeiopties (Blending Options).
Sleep het zwarte driehoekje onder Deze
laag (This Layer) naar rechts om de don-
kere delen te verbergen. Alt-klik op de re-
gelaar om hem te splijten, zodat je de

overgang subtieler kunt maken. Klik op OK.

g.“% ™ Wolkenplaatsen Voeg een laag-
WWed) masker toe aan de wolkenlaag via
de knopin het Lagenpalet (die met het witte
rondje erin). Neem een zacht, rond Penseel,
ingesteld op 40% Dekking (Opacity) en
verberg hiermee de harde randen en on-
gewenste delenvande laag. Plaats nu ook
Wolken2.jpg op dezelfde manier. Kopieer
de wolkenlagen meerdere keren (Ctrl+J)

en pas de bijpehorende maskers aan.

Elementen stapelen Hier begin
je echt met het maken van de
compositie. Met behulp van een
laagmasker kun je delen van de
| wolkenlaag onzichtbaar maken.

Huishouden Geef alle lagen een
i duidelijke naam, zodat je ze later
| eenvoudig terug kunt vinden.
" Onthoud dat je ook groepsmap-
. pen kunt maken om lagen van
eenzelfde soort in op te bergen.

Transformeer Gebruik Vrije trans-

V2D formatie (Free Transform, Ctrl+T)
om de wolken te schalen, roteren en ver-
vormen voor de nodige variatie. Klik in het
Lagenpalet op de bovenste wolkenlaag,
Shift-klik op de onderste en toets vervol-
gens Ctrl+G om ze te groeperen. Plaats
de groepsmap onder de laag met het uit-
geknipte meisje. Voeg daarboven eventueel
ook wat wolken toe.

| Dekking onder controle Meng de

| verschillende wolkenlagen met de rest

. van het werk door de Dekking (Opacity)

| in het Lagenpalet aan te passen. Zo kun
je doorzichtige, luchtige wolken maken.

| Doorheen halen

| veror: [ o/ + @

® v [ Voor mesje

v (7] wolken
P 3 Rechtsboven
¥ L1 Lnks
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Leer Photoshopin 7 dagen

Woensdag

et Fogo it vy,

/tev gen
Retoucheer je foto’s e o oo i

af'rn f/t
"(85))
Ontdek hoe je een eenvoudig Cw%%a%?
(Cy

portret een vleugje glamour geeft

Bij fotografie staat licht centraal
en met lichteffecten, toegevoegd
of versterkt met Photoshop, kun
je een portretfoto dan ook laten
stralen. De meest effectieve ge-
reedschappen om hooglichten en
schaduwpartijen te versterken zijn
Tegenhouden (Dodge) en Doordruk-
ken (Burn). Hiermee kun je al schil-
derend de belichting beinvioeden.
Als je subtiel te werk gaat,
kunnen heldere hooglichten en
diepe schaduwen een afbeelding
op spectaculaire wijze verrijken.
Het allermooist is echter dat je de
technieken die we op deze pagina
bespreken kunt toepassen zonder
de originele foto onherstelbaar te
wijzigen. Voor de veiligheid maken
we namelijk eerst een kopie van de
Achtergrondlaag.

Rimpels wegvagen

Een van de meest effectieve middelen
om een huid glad te strijken is het
filter Gaussiaans vervagen (Gaussian
Blur). Pas hem toe op een kopie van
de Achtergrondlaag. Verwijder de
vervaging op de ogen met het Gum-
metje (Eraser), ingesteld op 90%
Dekking. Je kunt ook een masker ge-
bruiken om het effect deels onzicht-
baar te maken. Fijne lijntjes en
rimpels schilder je weg met het Snel
retoucheerpenseel (Spot Healing
Brush). Verhoog tot slot de helder-
heid en het contrast met zo'n 5%.

Verwijderimperfecties

Photoshop bevat eenreeks opties, waarender
het Retoucheerpenseel (Healing Brushy),
Reparatie (Pateh) en het Kloonstempel (Clone
Stamp), waarmee je huid kunt retoucheren en
opschonen. Met het Kloonstempel kun je een
monster nemen van een ongeschonden stukje
huid'en dat aanbrengen op eenviekje of puist-
je. Het grote voordeel hiervan is dat je zelf kunt
bepalen met wat voor een pixels je oneffen-
hedenirepareert. Vooral in gebiedenimet een
afwijkende kleur, een bijzondere lichtsterkte

o Vignet doordrukken Schilder een
mooi donker vignet rond het model
met het gereedschap Doordrukken (Burn),
ingesteld op Middentonen (Midtones) en
een Belichting (Exposure) van 25%. Gebruik
voor de punt een Grootte (Size) van circa
825 px en een Hardheid (Hardness) van 0%.

0 Hooglichten op de huid Neem
het gereedschap Tegenhouden
(Dodge), stel Grootte in op 120 px en Be-
lichting op 5%. Schilder nu voorzichtig
over de lichtste gebieden van het gelaat.
Verander de waarde bij Belichting in 2%
om nieuwe hooglichten aan te brengen.

03 Ogen mtensnveren Zoomin tot
300%. Kies Tegenhouden, stel
Bereik (Range) in op Hooglichten (High-
lights), neem een penseelgrootte van 12
px en zet Belichting op 20-30%. Schilder
vervolgens over de iris om de helderheid
van dit deel van het oog te verhogen.

0 Afronden De laatste stap bestaat

uit het aanbrengen van een vignet

' met het gereedschap Doordrukken (Burn).

Stel Belichting in op 11% enschilder rond
de randen van de foto. Welk Bereik je moet
gebrwken voor het optimale resultaat
hangt af vanije startfoto, maar meestal

of bij randen is dat handig. & werkt Middentoneniprima.
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3 Laagmaskers in de praktijk

Voeg meer elementen toe en creéer de perfecte mix

@ ¥ Plaatsdeeenhoorn Voeg Een-

W &/ hoorn.pngvande cdtoe. Neem
Doordrukken (Burn) uit de Gereedschap-
penbalk, stel Bereik (Range) in op Midden-
tonen (Midtones) en zet Belichting
(Exposure) op 50%. Rechtsklik op de een-
hoornlaag in het Lagenpalet en kies Laag
omzettenin pixels (Rasterize Layers).
Voeg schaduw toe door over delen van de
eenhoorn te schilderen. Verander het Be-
reik tussendoor in Schaduwen (Shadows).

—y

@ D Doezelen meteen masker Maak
WD opdezelfde manier wat gebieden
lichter met Tegenhouden (Dodge). Voeg
daarnaeenlaagmasker toe via de knop in
het Lagenpalet. Neem een groot, zacht,
rond penseel met 30-40% Dekking (Opa-
city) en schilder met zwart langs de harde
randenvan de laag. Raak niet in paniek als

) Mysterieuze dierentuin Voeg ook

2 Draak.png, Elf. pngen Viinderl.png
en/of Vlinder2.pngtoe (op de cd). Dupliceer
devlinders en schaal enroteer de kopieén
met Vrije transformatie. Gebruik de mas-
keertechniek uit de vorige stap omderan-
dente verdichten, zodat de elementen
naadloos in hun nieuwe omgeving opgaan.

te veelvan de laag verdwijnt, want door
met wit te schilderen kun je die delen weer
zichtbaar maken.

Maskeren en mengen Voeg aan elk

| dier dat je plaatst een laagmasker

toe en schilder over de randen met
een zachte, zwarte penseelpunt om

| zachte overgangen te creéren.

| Selectiefaanpassen Als je een aanpas-

| singslaag toevoegt aan een element,

| dan kun je die op maat snijden door er

~ een Uitknipmasker (Clipping Mask) van
& te maken door Ctri+Alt+G te toetsen. Zo

| beinvloedt de bewerking alleen de
onderliggende laag en niet de rest van

| de compositie.

Hooglichten vervagen Te heldere
hooglichten zijn makkelijk te tem-
peren door een laagmasker toe

te voegen en dan met een zwart
penseel met 10% Dekking over de
probleemgebieden te schilderen.

. Aanpassingen Je kunt de kleur van ieder

| element dat je toevoegt afstemmen op de
i restvan de afbeelding met een aanpas-

singslaag Kleurtoon/verzadiging (Hue/

| Saturation) of Levendigheid (Vibrance).

| De aanwezige kleuren worden zwakker als
i je de Levendigheid vermindert. Ze zullen

| de aandacht daardoor minder afleiden
| van het hoofdonderwerp.
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Leer Photoshop in 7 dagen

'Donderdag . @
= Tekenen en schilderen

L3
Leer werken met het Penseel en de Pen
en maak zowel pixel- als vectorkunst

T

Het Penseel (Brush) en de Pen werken weliswaar beiden heel anders,
maar ze hebben ieder hun eigen kracht. Met het Penseel breng je
nogal rechttoe rechtaan gekleurde pixels aan op het canvas, maar
met de Pen maak je vectors. Dat betekent dat je alles wat je ermee
tekent kunt schalen zonder kwaliteitsverlies. Met de Pen creéer je
vlijmscherpe, gladde lijnen en vormen, waardoor hij erg geschikt is
voor het uitknippen van complexe objecten.

R A T IR S i

Besturingselement

Met deze optie kun je
gave dingen bewerkstel-
ligen. In combinatie met
Hoek — jitter (Angle
Jitter) kun je een draai-

Vectorkunst maken

5 Vormaynamiek [~

effect cregren als je hem e B NG Neem de Pen uit de Gereed-

instelt op Rotatie J : i schappenbalk of toets P en kies

(Rotation). & Vormlagen (Shape Layers) in de
- oystprn & Optiebalk (klik op de eerste van de
F ; drie pictogrammen). Teken een pad
5 Structuur Voeg wat '

op de contouren van een element
uit je referentiefoto om een vorm te
maken. Dubbelklik op de kleurstaal
in het Lagenpalet om de kleur van
de vorm te veranderen. Gebruik bij
voorkeur een wat donkerdere tint
voor de basis. Ga verder met een
nieuwe vorm en snijd deze toe op
de basisvorm door hem in een Uit-
knipmasker (Clipping Mask) te ver-
anderen (toets Ctrl+Alt+G). Blijf
vormen stapelen tot je tevreden
bent met de hoeveelheid diepte
en het aantal kleuren in je werk.

structuur toe aan je
penseelpunt voor de
nodige diepte. Met de
schuifregelaars kun je
het effect eenvoudig
tussendoor aanpassen.

Overbrengen Stel het Besturings-
element (Control) in op Pendruk
(Pen Pressure) om met de druk die
je met je stylus uitoefent de Dekking
(Opacity) te bepalen.

Tussenruimte Wil je stempe-

len met het Penseel? Stel dan

een hoog percentage in bij

Tussenruimte (Spacing).

Bij een laag getal krijg je een
vloeiende penseelstreek.

\

Maskers bewerken

Door met zwart op een laagmas-
ker te schilderen verberg je delen
van de bijbehorende laag, terwijl
je ze met wit juist weergeeft. Klik

26

Eenfotonaschilderen

Stellom te beginnenije referentiefotonaast je lege canvas
opiin Photeshop via Venster=>0rdenen>Naast elkaar
(Window>Arrange>Tile). Een raster kan ook goed van pas
komen bij deze klus, dus toets Ctrl+ om er een te activeren.
Kies een vertrouwde penseelpunt enschilder eem aantal
kleurvlakken op het canvas. Begin met de grootste vormen

| en gebruik daarbij een flinke penseelgrootte. Reduceer de

diameter vervolgens steeds een beetje terwijlije jeverderin
de details verdiept.

PHOTOSHOP MAGAZINE

voordat je het Penseel gebruikt
altijd eerst even op de maskermi-
niatuur in het Lagenpalet om er
zeker van te zijn dat het masker
actief is.

Als de laag (en dus niet het
masker) actief is, kun je de
Snelmaskermodus (Quick Mask
Mode) openen door Q te toetsen.
In deze modus kun je door met
zwart te schilderen een negatieve
selectie maken. Als je opnieuw
Q toetst, verlaat je de Snelmasker-
modus en blijft er een selectie
over. Als je dan meteen een
masker toevoegt, worden de delen
die je hebt beschilderd verborgen.




4 Penseelstreken stapelen

Gebruik penseelpunten en kleuren in je voordeel en kleed de compOSItle aan

I Bestand Bewe«km Albteldng bmg Selecteren  Filter \‘c:rrgm vm H‘p | m - i‘j

+ Dok

Kalligrafische penselen

» Penselenladen Neem het Penseel 4
4 (Brush) uit de Gereedschappenbalk. LB laag om op te schilderen (toets
Klikin de Optiebalk op de penseelpunt,open  Ctrl+Shift+N). Zet de Dekking (Opacity)

het uitklapmenu en kies Penselen laden van het Penseel via de Optiebalk op 80%.
(Load Brushes). Laad Sterren.abr van de Stel zowel de voor- als de achtergrondkle
cd enselecteer de punt vervolgens in de inop wit. Klik en sleep op de nieuwe laag
Penseelkiezer (Brush Picker). Hij staat die je zojuist hebt gemaakt om herender
helemaal onderaanin de lijst. wat sterren toe te voegen.

N -

Leven toevoegen We Schilder oplagen Gebruik steeds een

voegden sterren in de nieuwe laag voor je schilderwerk, ze-
| vorm van witte, ronde ker als je je op een ander gebied richt.
| spikkels met een hel- | Dat is handig als je achteraf dingen

| dere gloed toe rond de wilt aanpassen, zoals de scherpte.
| belangrijkste elementen

om ze te laten stralen.

% Voortgang De afbeelding
begint zo langzamerhand een
interessant kunstwerkje met
een dromerige uitstraling
te worden, nu we een aantal
wezens en extra elementen
zoals sterrenstof hebben
toegevoegd.

hebt geleerd.

Sterren toevoegen Maak een nieuwe f‘i B Meer sterren Pas de Grootte (Size)
j 1 van het Penseel aan en schilder op
weer een nieuwe laag meer sterren. In het
Penselenpalet (F5) kun je bij Vormdyna-
ur  miek (Shape Dynamics) instellen in welke
mate de penseelgrootte mag variéren.
Gebruik ook laagmaskers zoals je gisteren

Spreiding Om de sterren ogen-
schijnlijk nonchalant rond te
strooien, moet je waarschijnlijk de
Spreldmg (Scattering) en Vorm-
dynamiek (Shape Dynamics) in

| het Penselenpalet aanpassen.




Leer Photoshopin 7 dagen

Vrijda ‘5
ik jaag . TTZI A"’Dl:g
f.] Kom alles te weten over filters et o S st XPERy,
& Denk niet dat werken met filters omslachtig is... We laten br’j;?'kghveoLoiy/ZZ;”f:;EZ”F,-“};Zi;ecu aZ(N
«| Op deze pagina zien hoe je er prachtige platen mee maakt! ";’;;;;v"l°Tegf77efrfi§‘;<;§§;;enkg§§
2, De reputatie van Photoshopfilters is volgens ken voor Photoshops filters. Want ze hebben f’;’fl.jfig's?;gg}etiiggﬁ,f/’/‘f‘grtfggen
sommigen twijfelachtig. Hoewel ze je de noodza- heel wat te bieden, of je nu net begint en je filters i N v, Nde

kelijk functionaliteit bieden om je foto's te ver-
scherpen, ruisvrij te maken en vervorming tegen
te gaan, zijn er ook mensen die ze alleen associé-
ren met povere pogingen om digitale kunst te
vervaardigen. We gaan hier echter een lans bre-

een belangrijk deel van je werk wilt laten vormen,
of dat je meer ervaren bent en ze alleen als start-
punt gebruikt. Op deze pagina ontleden we de
Filtergalerie (Filter Gallery) voor je en leggen we
uit hoe filters je afbeeldingen kunnen verbeteren.
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Weergave wijzigen Gebruik
de pictogrammen of het
uitklapmenu linksonder in
het venster om te zoomen.
Je kunt ook rechtstreeks
een percentage intypen.

| Stapelenmaar! Meestal gebruik je
| een filter één keer, maar als je het
effect wilt versterken of filters wilt
i combineren kan dat door een
SRR nieuwe filterlaag toe te voegen.

e ]k Klik hiervoor op deze knop.
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Hetis mogelijkomfoto'somte
tovereninaangenaam ogende
digitale kunstwerkenmetde Ar-
tistieke (Artistic) en Schetsfilters
(SketchFilters). Opende groepen
enjevindtopties zoals Houtskool
(Charcoal), Waterverf (Waterco-
lor), Ruw pastel (RoughPastel)en
Kleurpotlood (Colored Pencil).
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Defilters Vervagen (Blur) zijn
breedinzetbaar, vanhet toe-
voegenvanscherptediepteaan
jefoto'stothetverzachtenvan
overgangenen harderanden bij
creatieve projecten. Met Op-
pervlakvervagen(Surface Blur)
kunjebovendien ook uitstekend
retoucheerwerkverrichten.

Erzijnfilterswaarmeejeruis
kunttoevoegenvooreenvintage
uitstraling, maaralsje imperfec-
tiesjuistwilt verwijderen, danis
hetfilter Ruisreduceren(Reduce
Noise) meerietsvoorjou. Voerde
Sterkte(Strength) enKleurruis
reduceren (Reduce ColorNoise)
opzoveralsnodigis.

Erzijneen aantalfiltersomte
Verscherpen(Sharpen), maar
onze favorietis Onscherp masker
(Unsharp Mask). Met Hoeveelheid
(Amount) bepaal je de sterkte,
met Straal (Radius) geefjeaan
hoegroot hetwerkingsgebied
moetzijnenDrempel (Threshold)
werktals eensoortdemper.




5 Slim(me) filters gebruiken

Geef je compositie op slinkse wijze een abstract tintje met gouden confetti
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Confetti Stel de voorgrondkleurin
op #DEFFOO en de achtergrond-
kleur op #86730B. Neem de Rechthoek
(Rectangle) ingesteld op Vormlagen
(Shape Layers) en sleep een flintertje goud
op het canvas. Dubbelklik op de laag om
het venster Laagstijl (Layer Style) te ope-
nenenvoeg een Verloopbedekking (Gra-
dient Overlay) toe. Kies Voorgrond naar
Achtergrond (Foreground to Background),
zet Type (Style) op Radiaal (Radial) en
Schaal (Scale) op 150%.
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fg Goudenregen Rechtsklik op de laag
L™2E metderechthoekinhet Lagenpalet
enkies Omzettenin slim object (Convert
to Smart Object). Kopieer de vorm razend-
snel door hem met het gereedschap Ver-
plaatsen (Move) te verslepen terwijl je de
Alt-toets ingedrukt houdt. Gebruik Vrije
transformatie (Free Transform, Ctrl+T)
om de kopieén elk een ander uiterlijk te
geven en varieer ook de Dekking (Opacity).
Maak één fragment aanzienlijk groter dan
derest.

Zoek naar een teken Slimme objecten
(Smart Objects) kun je herkennen aan
het pictogram met de rechthoeken
rechts onderin de laagminiatuur.
Dubbelklik erop om het laagbestand
in een nieuwe interface te openen en
te bewerken.

ﬁ Gaussiaans vervagen Activeer de
laag met de grote goudsnipper en
ganaar Filter>Vervagen>Gaussiaans ver-
vagen (Filter>Blur>Gaussian Blur). Ver-
groot de Straal (Radius) om hem onscherp
te maken. Druk de Alt-toets in en sleep de
aanpassing naar andere Slimme objecten
om het filter ook daarop toe te passen.
Dubbelklik op de filternaam om de instel-
lingen te wijzigen. Verminder de vervaging
plaatselijk door met zwart op het masker
van het filter te schilderen.

Slimme objecten Als je een filter
op een Slim object (Smart Object)
toepast, kun je de instellingen
later altijd nog aanpassen. Je
compositie blijft op deze manier
tot op het laatste moment
flexibel, wat er ook gebeurt.

] | Gouden confetti Omdat we de

- | goudsnippers maken met de
Rechthoek (Rectangle), hebben ze
vectoreigenschappen en zijn ze dus
schaalbaar zonder kwaliteitsverlies.
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Zaterdag

Leer Photoshop in 7 dagen

Aanpassingslagen en
overvloeimodi

Hiermee voer je non-destructief bewerkingen uit
en kun je twee of meer effecten combineren

Als je een afbeelding wilt bewerken, is het altijd een goed idee om de aanpassingen op
een aparte laag te verrichten. Zo loop je niet het risico dat het origineel onherstelbaar
beschadigt en bovendien werk je op deze manier een stuk flexibeler, omdat je de instellin-
gen van aanpassingslagen achteraf kunt wijzigen. Een ander groot voordeel van deze non-
destructieve manier van bewerken is dat je het effect kunt verfijnen met een masker en
dat je de overvloeimodus van de aanpassingslaag kunt veranderen. Dankzij de verschil-
lende modi is het mogelijk om twee of meer effecten op geheel eigen wijze te combineren.
Een compleet nieuwe reeks aan creatieve mogelijkheden ligt aan je voeten!

Branpeed SIS i007 B

Lichtemodi

Detweedesectieindelijstmet overvloeimodi
heeftbetrekking op belichting van een afbeel-
ding. De modus Lichter (Lighten) speelt metde
schaduwen, dus hij zal zijn uitwerking vooral in
donkere gebiedenhebben. Als je een afbeel-
dinglichter wiltmaken, kunje hetbeste de
overvloeimodus Bleken (Screen) gebruiken.
Dezedoetongeveer hettegenovergestelde
van Vermenigvuldigen (Multiply). Vooreen
watextremer effectleentKleurtegenhouden
(Color Dodge) zichgoed.

ELE

Kleurmodi

Erzijneenaantal overvlioeimodidie gebruik-
makenvandekleureninjewerk, zonder het
contrastteveranderen. Modizoals Kleur
(Color), Kleurtoon (Hue) of Verzadiging (Satu-
ration) zorgenervoordatjedekleurenvaneen
afbeelding creatief kuntinzetten, vooralalsje
zecombineert metde laagstijl Verloopbedek-
king (Gradient Map) of eenaanpassingslaag
zoals Selectieve kleur (Selective Color).
De modiKleurtoonen Verzadiging doen
hetgoedbijzwart-witafbeeldingen.

Donkeremodi

Eenafbeeldingdonkerder maken doe je met
eenovervloeimodus uit de eerste sectie,
bijvoorbeeld Donkerder (Darken), Vermenig-
vuldigen (Multiply), Kleur doordrukken (Color
Burn), Lineair doordrukken (Linear Burn) of
Donkerderekleur (Darker Color). Ze verhogen
stukvoorstuk hetcontrastvaneenafbeelding,
waardoor deze donkerder oogt. De sterkteis
afhankelijk van de gekozen aanpassingslaag
endebijbehorendeinstellingen. Gebruik het
laagmasker of de Dekking (Opacity) omhet
resultaatte verfijnen.

Contrastmodi

Andere veelgebruikte overvlioeimodi zijn Zwak
licht (Soft Light), Bedekken (Overlay), Fel
licht (Hard Light), Levendiglicht (Vivid Light)
enLineairlicht(LinearLight). Met deze modi
beinvloedje het contrastvaneenafbeelding
vaak zodanigdat hetbeterisomze nietop
volle sterkte te gebruiken. Eenverminderde
laagdekking doetin zulke gevallen wonderen.
Vooralde aanpassingslagen Verloop (Gra-
dient), Fotofilter (Photo Filter) en Kleurbalans
(ColorBalance) lijken onlosmakelijk met deze
modiverbonden.

Aanpassingen
combineren

Fris de kleuren en belichting van een
foto op met aanpassingslagen.

o Analyseer je afbeelding Als je een

aanpassingslaag toevoegt, krijg je
daar automatisch een laagmasker bij
waarmee je de bewerking plaatselijk on-
zichtbaar kunt maken. Dat is handig, want
in het voorbeeld is de lucht prima, maar
de weg te donker.

Utvaemivesus: o

0 Aanpassingen maken We voegen
eerst een aanpassingslaag Niveaus

(Levels) toe om de onderkant van de foto

lichter te maken. Daarna veranderen we

de kleur van de lucht een beetje met Selec-

tieve kleur (Selective Color).

0 Maskeren met het Verloop Nu
is de lucht te helder en de kleur
van de weg is ook niet zoals hij moet zijn.
Om dit op te lossen, bewerken we de laag-
maskers met het gereedschap Verloop
(Gradient) ingesteld op Lineair (Linear).

0 Verfijn de overgang Neem een

redelijk zacht Penseel met een
lage Dekking (Opacity) en Stroom (Flow)
en schilder daarmee op het laagmasker
om het effect plaatselijk te verbergen
(met zwart) of te onthullen (met wit).



6 Versterk de sfeer

Bewerk kleur en contrast en verbeter zo de
uitstraling van je werk

g’ Kleurbalans Activeer de bovenste
40 laag en klik op de knop Nieuwe op-
vullaag of aanpassingslaag maken (Create
New Fill or Adjustment Layer) onder in het
Lagenpalet. Kies Kleurbalans (Color Ba-
lance). Vul bijMiddentonen (Midtones)
van boven naar beneden de volgende
waardenin: O, -25en +21. Schilder met een

“’“}* Mystieke gloed Voeg via dezelfde

I ¥/ knop een opvullaag Volle kleur (So-
lid Color) toe. Vul de kleurcode E19C0OQ in
achter het hekje en verander de overvioei-
modus in Zwak licht (Soft Light). Vul het
masker met zwart (Alt+Backspace). Voeg
hier en daar gloed toe door met een wit
penseel met 60% Dekking op het masker
te stempelen. Herhaal deze stap, maar
gebruik daarbij de overvioeimodus Fel

zwart Penseel ingesteld op 80% Dekking

licht (Hard Light) en stel het Penseel
(Opacity) rond het meisje.

(Brush) in op 10% Dekking.

» Zwart-witKlik weer op de cirkelvor-
€D mige knop onder in het Lagenpalet
en kies nu Zwart-wit (Black & White) uit de
lijst met aanpassingslagen. Stel de over-
vloeimodus in op Fellicht en verlaag de
Dekking tot 50%. Schilder met een zwart
penseel ingesteld op 80% Dekking op het
masker over gebieden die te donker zijn
geworden door deze aanpassing. Werk
indien nodig de maskers van de overige
lagen bij.

het masker om te draaien maak je de hele
aanpassingslaag onzichtbaar. Onthul hem

doorschemeren.

Oranje opvullagen De gloeiende viekken op de
achtergrond maakten we met behulp van
enkele opvullagen Volle kleur (Solid Color).
Combineer ze met verschillende overvloei-
modi, zoals Zwak licht (Soft Light) en Fel licht
(Hard Licht), voor een gevarieerd resultaat.

e
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| Effecttemperen De aanpassingslaag Zwart-wit
~| zorgtin combinatie met de overvloeimodus Fel

| licht (Hard Light) voor een intense belichting en
een sterk contrast. We hebben de Dekking
(Opacity) van de laag echter wel moeten terug-
| schroeven naar 50% voor een subtiel effect.

Masker omKkeren Als je een aanpassingslaag
hebt toegevoegd, kun je het masker eenvou-
dig zwart maken door Ctrl+| te toetsen. Door

weer door te schilderen met een wit penseel.
Deze werkwijze komt goed van pas als je het
effect slechts op enkele plaatsen wilt laten




Leer Photoshop in 7 dagen
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. Dynamischelagen
= De aanpassing Schaduwen/hoog-
—@—‘ lichten (Shadows/Highlights) kan
Q je helpen om je compositie en alle
s lagen die ze bevat beter in balans
O te brengen. Activeer eerst de laag
o die je wilt bewerken en ga dan naar

Afbeelding>Aanpassingen>
Schaduwen/hooglichten (Image>
Adjustments>Shadows/High-
lights). Door Hoeveel (Amount) en
Toonbreedte (Tonal Width) aan te
passen voor zowel de schaduwen
als de hooglichten kom je al een
heel eind. Geef ook de regelaar
Contrast middentonen (Midtone
Contrast) een zetje en maak op die
manier afzonderlijke lagen lichter
of donkerder, zodat ze beter bij de
rest van het werk passen.

Schaduwen/nooglichten

|| — Schaduwen
Hoeveel: ?1]_— %

Toonbreedte: 3B %

Straal: 149 -

— Hooglichten
Hoeveeheid: 0 %
(83

- fi| | Toonbreedte: 52 %

g
e
5

Straal: 78 px
e B S TN RS 2 LT

|| | Kleurcorectie:
il

Contrast middentonen:

|| | Zwartgrens: F,BT %

| | Witgrens:

| [[Opsiaan s standaardnstelingen
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Bijschaven en afwerken
Sluit deze Photoshopweek in stijl af door je
werk te verbeteren en te verscherpen

Deze Photoshopmarathon loopt op zijn einde en de belangrijkste bewerkingen hebben
we reeds uitgevoerd. Nu is het tijd voor de finishing touches die van de afbeelding een
samenhangend geheel zullen maken. Denk daarbij aan het verfijnen van de kleuren en
de belichting om je werk perfect in balans te brengen. Het is ook een goed idee om in dit
stadium te verscherpen, zodat details extra opvallen. We gaan ook aan de slag met de
aanpassing Schaduwen/hooglichten (Shadows/Highlights). Dit alles is de kroon op je
werk, dat je over enkele ogenblikken vol trots aan je familie en vrienden kunt tonen.

' Hoogdoorlaat
onder deloep

Onthul verborgen details in je kunstwerk

i .-
|
TRy

0 Lagen verenigen Het beste kun je
‘ het filter Hoogdoorlaat (High Pass)
toepassen als je alle overige bewerkingen
hebt afgerond. Klik op de bovenste laag in
het Lagenpalet en toets Ctrl+Alt+Shift+E

om alle lagen te verzamelen op één nieu-

| we laag.

e
e g
Lowsetghoden

De perfecte mix

Als je meerdere stockfoto's samenveegt, kun
jeleen trucje gebruikeniom ze stuk voor stk
naadlooes te integreren. Vervaag het laagmasker:
van ieder element een klein beetje met Gaussi-
aans vervagen (Gaussian Blur), met een Straal
(Radius) van maximaal 0,5-1,0 px. Zo worden
de randen van de objecten zachter en oogt het
geheel'wat natuurlijker.

02 Felle overvloeimodus Verander
de overvloeimodus van de boven-
ste laag in Fel licht (Hard Light). Hierdoor
neemt het contrast drastisch toe, maar dit
is slechts tijdelijk. Ga naar Filter>Overige>
Hoogdoorlaat (Filter>0ther>High Pass)
en zorg ervoor dat Voorvertoning (Pre-
view) is aangevinkt.

| 03 Hoogdoorlaat Verlaag de Straal
(Radius) eerst naar 0,1 en verhoog

hem geleidelijk, tot de afbeelding door het
grijs in de voorvertoning begint te schij-
nen. Op deze manier kun je eenvoudig de
juiste sterkte bepalen. Klik op OK en scha-
kel de zichtbaarheid van de laag in en uit
om het resultaat goed te kunnenzien.




7 Voeg de final touch toe

Maak de laatste aanpassmgen enrond je meestervverk af

"”i (% EénlaagmakenVoegallelagen

1, =+ Samen op éénnieuwe laag door
Ctri+Alt+Shift+E te toetsen. Rechtsklik op
de nieuwe laag en kies Omzetteninslim
object (Convertto Smart Object). Toets
Ctrl+J om hem te kopiéren en maak de
kopie onzichtbaar door op het oogje voor
de laag te klikken. Activeer de originele
samengestelde laag.

% EenlikjeverfGa nu naar Filter>

& Artistiek>Klodder (Filter>Artistic>
Pamt Daubs). Hiermee geefje het werk
snel een schilderachtige, uniforme uitstra-
ling. Stel Penseelgrootte (Brush Size) in op
20, Scherpte (Sharpness) op 25 en Type
op Eenvoudig (Simple). Klik op OK, voeg
een laagmasker toe en schilder met zwart
om het effect lokaal af te zwakken.

Omin telijsten Nu we alle bestudeer-
de technieken hebben toegepast, is
dit het eindresultaat.

Selectief verscherpen We pasten het filter
¥ Hoogdoorlaat (High Pass) plaatselijk toe
met behulp van een masker. Door met
¢ zwart over de gebieden te schilderen die
we een beetje vaag wilden houden,
maakten we het verscherpingseffect
daar onzichtbaar.

Q}i Hoogdoorlaat Maak tot slot de
bovenste laag zichtbaaren ga

naar Filter>Overige>Hoogdoorlaat
(Filter>Other>High Pass). Stel de Straal
(Radius) inop 7 px en klik op OK. Verander
vervolgens de overvloeimodus in Lineair
licht (Linear Light) en voeg een laagmas-
ker toe. Schilder met zwart over delenvan
de verscherpte laag die je wilt bedekken.

| Schilderachtig effect Met het artistieke
 filter Klodder (Paint Daubs) vermengden
we de lagen een beetje en verfijnden we

de details.
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Op bezoek bij Stef Ringoot

www.stefringoot.com

64 et is een cliché voor veel
ontwerpers, maar ik ben
ik altijd met tekenen en

creativiteit bezig geweest”,
vertelt de in Vlaanderen geboren en ge-
togen Stef Ringoot.
Als tienjarige ging hij ie-
dere week twee keer, op
woensdagmiddag en za-
terdagochtend, naar de
‘tekenschool’ in Dender-
monde. “Ik werd daarin
vooral gesteund door mijn
grootvader Pieter Ringoot,
letterzetter, decorateur en kunst-
schilder. Hij bracht mij de liefde
voor het grafische vak bij en
leerde mij om altijd met een
kritische blik naar mijn werk
te kijken. Hij is door de jaren
heen mijn grote inspiratiebron
geweest”, aldus Stef.
Ook al was hij altijd al
met tekenen bezig, het
echte striptekenen

jelle

Op bezoek bij

Beeld: Stef Ringoot

kwam pas later van de grond, tijdens zijn
middelbare studie Grafisch vormgeven
aan de SITO in Mechelen. “Een klasgenoot
kon heel mooie stripfiguren tekenen en
door hem ben ik het ook gaan proberen.
De strips van Biebel, getekend door Marc

66 Fen opleiding
striptekenen was er
destijds nog niet, dus
werd het animatiefilm.
Dat is ongeveer het-
zelfde. Dacht ik.. *?

Legendre, en Brammetje Bram van Eddy
Ryssack hebben ook bijgedragen aan het
feit dat ik wou leren striptekenen. Dit wa-
ren en zijn nog steeds mijn grote voor-
beelden.”

Omdat hij verder wilde studeren na de

Stef Ringoot (1971) is zelfstandig illustrator, cartoonist,
grafisch en ruimtelijk vormgever. Daarnaast geeft hij als
vakdocent twee dagen in de week les. Hij vertelt aan
Photoshop Magazine hoe hij zich zo veelzijdig heeft
weten te ontwikkelen.

Tekst: Helga Kluiter

middelbare opleiding, ging Stef na de SITO
naar de Koninklijke Academie voor Schone
Kunsten in Gent, alwaar hij de opleiding
Animatiefilm volgde. “Een opleiding strip-
tekenen was er toen nog niet, dus werd het
animatiefilm”, legt hij uit. “Dat is ongeveer
hetzelfde. Dacht ik.."

In de kinderschoenen

Eind jaren ‘80 maakte Stef voor het eerst
kennis met computers toen er thuis een pc
werd aangeschaft. “Behalve tekstverwer-
ken kon je er niet echt veel mee, maar ik
probeerde er wel al de typografie van mijn
ontwerpen mee te verbeteren’, blikt hij
terug. Tijdens zijn studie stond het anime-
ren met de computer nog in de kinder-
schoenen en het proces van animeren was
behoorlijk tijdrovend. “Er waren een aantal
Amigacomputers met daarop een ‘lijntest’-
programma en deze computers waren
verbonden met een camera. Met een
muisklik konden wij telkens één op papier
getekend beeld opnemen. Vervolgens kon-
den we testen of alle gescande beelden

JAWEL BUURMAN, OOK
EEN 55 PLUSSER MOET
‘2 MET 21IIN TIID meg!

NU KAN IK OVERAL WAAR
IK WIL BERICHTIES
SCHRIJVEN!

ALLEEN HET VERZENDEN
IS NOGAL ONHANDIG ...

VIND MAAR

EENS EEN
ENVELOPPE
WAAR DAT

DING IN PAST!

A Stripstrook uit Jelle magazine, een lifestyletijdschrift voor senioren uit Flevoland en een uitgave van |Jsvogel Media uit Biddinghuizen.
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goed op elkaar volgden en de bewegingen
netjes verliepen. Daarna werden de teke-
ningen met de hand verder afgewerkt. De
nette, ingekleurde tekeningen, werden
vervolgens met een gigantische camera,
beeld voor beeld, op pellicule gefilmd. Na-
dat de 16-mm-film in een speciaal labora-
torium ontwikkeld was, konden we alles
met veel knip- en plakwerk aan elkaar
monteren en voorzien van muziek.”

Stef maakte voor het eerst echt kennis
met digitaal werken in 1994, toen hem
nadat hij was afgestudeerd een baan werd
aangeboden bij een televisiestudio. “Deze
studio verzorgde voor de regionale televi-
sie van West-Vlaanderen de opnames, het
camerawerk en de uitzendingen. Ook wer-
den er reclamefilms gemaakt. Ik begon in
de regiekamer op een computer die eigen-
lijk maar drie dingen kon; beelden scan-
nen via een camera, deze op een
Photoshop- en lllustratorachtige manier
bewerken en vervolgens doorsturen naar
de regisseur. Op deze manier werden on-
der andere de weerkaarten gemaakt en
uitzendingen voorzien van ondertitels en
logo's. Na een tijdje werd mij gevraagd of
ik ook andere dingen wilde doen, waarna
ik mijn eerst stappen in Photoshop, Illus-
trator en Director (de voorloper van Flash)
zette. Photoshop verschilde niet zoveel
van het werk op de andere computer en
de overgang verliep vrij vlot. Wat later ging
ik ook nog werken op een Silicon Graphics-
machine, in die tijd het beste wat je op
grafisch gebied en 3D-bewerking kon krij-
gen en razend duur...”

Naar Nederland

Na zijn opleiding woonde en werkte Stef
eerst tien jaar in Brugge, waar hij een
aantal jaar werkzaam was bij eerderge-
noemde regionale televisiestudio. Vervol-
gens ging hij aan de slag als ontwerper bij
een stand- en decorbouwbedrijf, tot hij in
september 2003 naar Nederland ver-
huisde. Maar waarom zou je Brugge ver-
ruilen voor Lelystad? Brugge is zo mooi...
“Maar mijn vrouw is nog mooier”, vindt
Stef. “Zij woonde in Lelystad en via haar
kon ik een baan krijgen in Amsterdam. En
Lelystad is zo erg nog niet. Het is er rus-
tig, er is veel natuur, water en het ligt heel
centraal waardoor je makkelijk overal
komt. Ik begon in Amsterdam als carto-
graaf en vormgever en vervolgens als
studiomanager bij een bedrijf in Lelystad
dat presentatiesystemen verkocht en
stands ontwierp. Jarenlang maakte ik
naast mijn vaste baan werk in opdracht
en dit werd steeds meer. In 2008 heb ik
de stap gezet en ben helemaal voor me-
zelf begonnen. Gesteund door mijn vrouw
en mijn Nederlandse familie, want mijn
schoonvader Hans Sturris is ook illustra-

A Ontwerp van de praalwagen “Margaretha van Oostenrijk” voor de Hanswijkcavalcade en
processie te Mechelen (Belgié) in opdracht van het Bisdom Mechelen-Brussel. De wagens
werden gebouwd door de ervaren vakmensen van JVL Interieur bvba uit Oostkamp (Belgié).

WatervisiQi

2 fiir LED Schwimmbadbeleuchtund

» Ein optimales Lichtbild unter Wasser
* Hohe Sicherheit |
. Enelglninsparung

A Ontwerp voor pop-upwand in opdracht van Watervision, Expert in led-zwembadverlichting.
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A Zoekplaat in opdracht van full service reclamebureau Different View uit Almere voor een iPadgame.

tor en een bevlogen kunstschilder.”
Inmiddels heeft Stef ook nog een didac-
tische graad behaald, zodat hij ook les
mag geven. De keuze voor het leraarschap
was voor hem een logische stap. “lk heb
eigenlijk altijd al les gegeven. Toen ik nog
in Belgié woonde, hield ik mij op vrijwil-
ligersbasis al bezig met het opleiden van
jeugdwerkers. Ik deed vooral de creatieve
onderdelen van de opleidingen. Later gaf
ik ook af en toe cursussen Photoshop,
lllustrator en InDesign bij een aantal oplei-
dingsinstituten. Toen het ROC A12 te Ede
mij in 2010 benaderde om aan de oplei-
ding Multimedia vormgeven les te komen
geven, was dat niet zo'n grote stap voor
mij. Alhoewel ik al een aantal didactische
diploma'’s had uit Belgié heb ik in 2013
toch een PDB-opleiding gevolgd (pedago-
gisch didactische bekwaamheid - red). Dit
diploma heb je immers nodig om te mo-
gen lesgeven. |k geef als zzp'er maar twee
dagen per week les. Als vakdocent vind ik
het immers vooral belangrijk dat ik met
beide benen in het vak blijf staan. Wat ik

PHOTOSHOP MAGAZINE

aan mijn studenten vertel en als oefening
meegeef, komt in vele gevallen recht-
streeks uit de praktijk.”

Van animatie tot praalwagens
Wanneer je naar Stef zijn werk kijkt, besef
je ook meteen dat hij van vele markten

6 Als vakdocent vind ik
het vooral belangrijk
dat ik met beide benen
in het vak blijf staan *?

thuis is: van grafische vormgeving en
animatie tot kartografie, 3D-ontwerp en
praalwagens. Vanwaar deze brede ont-
wikkeling? “Van het een kwam het ander”,
vertelt Stef. “Ook het feit dat ik bij ver-
schillende soorten grafische bedrijven
heb gewerkt zal wel meespelen, denk ik.
Misschien heeft het ook iets te maken

met de manier waarop ik werk, want mijn
stijl laat veel verschillende oplossingen
toe. Van mijn illustraties kan ik makkelijk
animaties maken en zelfs decors of pop-
ups. Maar een goed vormgever moet een
beetje all-round zijn, vertel ik altijd aan
mijn studenten. Het gaat immers om het
overbrengen van een boodschap. Het
gebruikte medium zou daar min of meer
ondergeschikt aan moeten zijn."

Stefs eigen tekenstijl, ongeacht het
gebruikte medium, is vooral stripachtig.
Deze stijl is min of meer voortgekomen
uit zijn liefde voor strips. “Ik hou vooral
van de strips waarin deze tekenstijl ook
wordt toegepast en heb altijd geprobeerd
om mij deze stijl eigen te maken. Na jaren
tekenen enillustreren is het een eigen
leven gaan leiden en mijn kenmerk ge-
worden.” Een ander kenmerk van zijn
werk is dat het een bepaalde vrolijkheid
uitstraalt en veel leuke ideeén laat zien.
Hoe komt hij aan al die leuke ideeén?
“Door veel rond te kijken en heel veel
schetsen te maken. Ideeén liggen immers



STEF Y12

JA, DE
BEZUINIGINGEN
IN PE 20R6 BLIJVEN
2ICH OPSTAPELEN!

—

A Clip&Claar-cartoon “Stapelen”. De cartoons worden ontworpen in opdracht van Stichting Clip en stichting Stimulansz. Ze verschijnen al bijna

10 jaar maandelijks op de website.

overal. Ik heb dan ook altijd een schets-
boek bij me”, vertelt hij. "Ook veel over-
leggen met klanten en de teksten lezen
die ze aanleveren helpt bij het vinden van
de juiste ideeén. En verder komt mijn
vrouw ook wel vaak met goeie ideeén
voor illustraties en cartoons. Waar ik veel
studenten de fout in zie gaan, is dat ze
denken dat de ideeén in hun computer
zitten. Google is een goed hulpmiddel,
maar er ligt nog veel meer inspiratie in de
directe omgeving, in boeken, in tijdschrif-
ten, enzovoorts.”

Hij vervolgt: “Verder komt de vrolijkheid
ook wel door mijn kleurgebruik en de
cel-shading-techniek die ik gebruik. Cel-
shading is een verwijzing naar het animatie-
proces. Daarbij worden transparante
plastic bladen of cellen beschilderd met
kleur. De tekening staat meestal op de
voorzijde van de cel. De kleur wordt aan
de achterkant toegevoegd. Cel-shading
maakt op een heel gestileerde manier
gebruik van felle en scherp afgetekende
kleuren.”

@ TWITTER; IK BEN
AAN HET INBREKEN BIJ
DE FAMILIE JANSSENS ! 2 Wi @ TWITTER; HANDEN
N S < OMHOO06 !

INBREKER GEVAT VIA TWITTER

A Cartoon “Let op met wat je twittert!” - vrij werk.
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Op bezoek bij Stef Ringoot

Breed creatief arsenaal

Stef werkt voor het maken van zijn illus-
traties voornamelijk met Adobe lllustrator,
maar zijn creatieve arsenaal is veel breder
dan dat. "Ik werk haast dagelijks met lllus-
trator en gebruik het zelfs wel eens om
stands of decors te ontwerpen. Toch ont-
werp ik nooit een illustratie rechtstreeks
op de computer en ontstaat al mijn werk
nog steeds op papier. Hierdoor blijft mijn
stripachtige en persoonlijke tekenstijl ook
behouden in mijn werk’, legt hij uit.

“Het maken van complete illustraties en
cartoons in lllustrator is arbeidsintensief.
Het voordeel is echter dat de illustraties
vectorieel zijn, waardoor ze makkelijk kun-
nen worden aangepast, vergroot of ver-
kleind. Meestal klopt de compositie die ik
op papier heb uitgedacht nog niet hele-
maal, maar dankzij mijn werkwijze kan ik
hier nog veranderingen in aanbrengen.
Vectorillustraties zijn wat mij betreft dan
ook makkelijker te verwerken dan pixel-
illustraties. Soms worden illustraties ook
nog verder bewerkt in Photoshop, afhan-
kelijk van wat de klant wenst. Photoshop
gebruik ik, samen met InDesign, vooral
voor dtp-werkzaamheden en fotocorrec-
tie. Adobe Flash gebruikte ik tot voor kort
voor het maken van animaties. Tegen-
woordig werk ik met ToonBoom Harmo-
nie.

“Voor 3D is Google SketchUp een uitste-
kend hulpmiddel, omdat je daar zo mak-
kelijk in kan modelleren. Werken met het
programma lijkt een beetje op beeldhou-
wen. Het werkt totaal anders dan andere
3D-programma’s. SketchUp is niet echt
bedoeld om high-end afbeeldingen te ma-

k : ken, want daarvoor heb je minimaal een
A Poster op rotonde in opdracht van Printshop TLO repro. extra renderprogramma nodig, maar voor

o Voor het ontwerpen van eenillus- -

tratie maak ik altijd eerst een aan-
tal schetsontwerpen in mijn schetsboek. Na goedkeuring van de klant wordt
Deze schetsontwerpen worden als een de illustratie vervolgens met be- o De laag met de originele schets
nette potloodschets uitgewerkt op teken- hulp van de brush tool in Adobe lllustrator wordt verwijderd. De nieuwe
papier en vervolgens gescand. en een Cintiq tekentablet overgetrokken. schets is nu volledig digitaal.

38 PHOTOSHOP MAGAZINE



A lllustratie voor een folder over de verhuur van een mobiele “Biergarten”.

het ontwerp van een decor of stand werkt
het prima. Bovendien werkt het makkelijk
samen met Photoshop.”

Niet leunen op de computer

Ondanks dat Stef veel gebruik maakt van
diverse soorten software, blijft hij altijd
kritisch kijken naar de manier waarop hij
de technologie gebruikt. “Van elk werk

wil ik iets leren, zodat ik het de volgende
keer beter kan doen, vooral wat betreft de
lay-out, vorm, lijnvoering en inhoud. De
software en de computer moeten onder-
geschikt zijn aan het werk dat ik maak. Ze
zijn niet meer dan een andere soort teken-

pen. Ooit had ik een gesprek met een
vormgever die altijd de laatste versie van
de software nodig had om ‘goed’ werk te
kunnen opleveren. Zijn creativiteit werd
bepaald door zijn kennis van de software,
waardoor alles wat met oudere software
gemaakt is gedegradeerd wordt tot slecht
werk. Dat vind ik een foute redenering. Ik
zie tegenwoordig meer en meer studenten
en vormgevers die hetzelfde doen en hun
resultaat laten bepalen door de software.
Hierdoor krijgt heel veel werk hetzelfde
uiterlijk. Vaak zie je in veel illustraties, af-
beeldingen en opmaken dezelfde techniek
of hetzelfde effect terug, waardoor de ori-

O Vervolgens wordt de illustratie digitaal inge-
kleurd met Adobe lllustrator. Dit doe ik door
een kopie van de zwart-wit lijntekening in een nieuwe
laag te plaatsen en vervolgens met behulp van de
Live Paint-functie in te kleuren. Hierna worden er ook

nog schaduwen en highlights aan toe gevoegd.

O De kleur- en zwart-witteke-
ningen worden daarna
samengevoegd. De lijntekening ligt
in een tweede laag boven op de

kleurlaag.

ginaliteit en geloofwaardigheid verdwijnen.
Alle ontwerpen gaan op elkaar lijken.
Daarom maak ik dan ook weinig gebruik
van speciale effecten in mijn werk. Less is
in dit geval more.”

Voor beginnende ontwerpers heeft Stef
ook nog enkele goede adviezen. “Vormge-
ven is iets wat je niet van vandaag op mor-
gen leert en ook niet na een drie- of
vierjarige opleiding. Het is vooral heel veel
doen en nooit opgeven. En zoals eerder
vermeld: probeer je werk origineel en ge-
loofwaardig te houden. Creativiteit komt
niet uit een computer maar uit jezelf. Pro-
beer daarom af en toe de computer eens
uit te zetten en ga aan de slag met allerlei
materialen, maak dummies in papier, 3D-
modellen met klei, werk eens met zand...
Ook zonder computer kan je namelijk nog
steeds vormgeven. En het allerbelangrijk-
ste: sta open voor kritiek. Je leert meer
van iemand die opmerkingen heeft over je
werk dan van iemand die alleen maar zegt
dat het mooi is. Alhoewel ook dat wel eens
belangrijk is.”

Volg Stef Ringoot via
www.linkedin.com/in/stefringoot
www.twitter.com/stefringoot
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De uitdaging

& @ ;
p deze pagina maken we de win-
naar bekend van De vitdaging uit
Photoshop Magazine 27. De all-

in-one inkjetprinter XP-710 van
Epson is gewonnen door Frederique Van-

Deze |ezers gingen onze UItdaglﬂg 220 den Broecke. Hiernaast zie je een selectie

van de overige favoriete inzendingen.

COSY COW

Frederique
Vanden Broecke

“Mijn werk maakt onderdeel uit van
een portretreeks van dieren in een
nieuw jasje. Met deze reeks wil ik de
schoonheid van de dieren naar
voren brengen op mijn eigen crea-
tieve manier en met eigen fotoma-
teriaal. Er verstrijkt een hele tijd
tussen het nemen van de eerste
foto en de laatste foto vooraleer ik
met Photoshop aan de slag ga om
tot een geslaagde compositie te
komen."

Waarom is dit de winnaar?
Dit bizarre beeld heeft indruk ge-
maakt, omdat de blik en de non-
chalante houding van de koe het
menselijke element accentueren.
Daarnaast is het werk goed gepho-
toshopt, zijn de kleuren mooi in
balans en is het geheel netjes en
sfeervol afgewerkt.
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TOKZILLA

Kevin Lohstroh

Kevin maakte gebruik van eigen
materiaal en stockfoto's. “Dit
ontwerp is tot stand gekomen
met behulpvan veel laagmas-
kers, gedupliceerde foto's, aan-
passingslagen en filters. De
gedachte was om een soort
Godzilla te creéren in de vorm
van een kip.”

DARK SEA
Obed Akihary

“In dit werk deed ik veel met het Penseel. Voor het
maken van de regen en de schuimkoppen heb ik
gespeeld met de opties Tussenruimte, Spreiden en
Vormdynamiek. De golven zijn opgebouwd uit ver-
schillende lagen waarbij verschillende overvloei-
modi zorgen voor een natuurlijk geheel. Vervolgens
maakte ik aanpassingslagen Niveaus, Curven en
Kleurbalans om de lucht een dramatische look te
geven. De vogels en bergen op de achtergrond ko-
men uit foto's die ik eerder heb gemaakt.”
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De uitdaging

De uitdaging

Stuur ons je beste Photoshop-
werk en maak kans op een
jaarabonnement

Wat moet je doen?
Stuur ons je mooiste Photoshopwerk. Je mag alles
inzenden, of het nu een eenvoudige fotomontage is of
een gedetailleerd digitaal schilderij. Zolang het maar in
Photoshop of Photoshop Elements is gemaakt. Je kunt
aan de slag gaan met de door ons aangeleverde foto's
(kijk op de cd), maar werken met ander materiaal is
ook toegestaan.

Naast je inzending stuur je ook je bronbestanden
mee én het ingevulde wedstrijdformulier. Dat kun
je downloaden via www.photoshopmagazine.nl/
uitdaging/wedstrijdformulier/ of van de cd halen.

""'W:S ;
Op dit formulier vind je alle informatie die je nodig hebt
om je kunstwerk in te sturen. Je werk moet voor 16 f.rmUhCr VOOr 16 maa'rt 2‘15 1n om

maart 2015 binnen zijn en de uitslag wordt in Photo- kans te maken Op ee]j‘l ]aarabonnemen
shop Magazine 33 bekend gemaakt.

Door mee te doen aan deze wedstrijd geef je
Photoshop Magazine toestemming om je werk in het
blad en online te publiceren in het kader van De
uitdaging.

“Een jaarabonnement op
Photoshop Magazine

Of een ander F&L-blad naar keuze

Wil jij tien keer per jaar als eerste een verse dosis workshops en inspiratie
ontvangen? Dan neem je natuurlijk een jaarabonnement op Photoshop
Magazine!

Geen geld? Geen nood! Want je kunt nu een jaarabonnement winnen
door je mooiste werk in te sturen. Als je al een trouwe lezer met abonne-
ment bent, kun je er ook voor kiezen om je huidige abonnement nog een
jaartje gratis door te laten lopen. Of je neemt een van de vele ander titels
van F&L, waaronder Chip Foto-Video, Auto Review, iCreate, Webdesigner,
Healthy You, FIT of Foodies.

We hoeven je natuurlijk niets meer te vertellen over dit prachtige blad,
dus stop met lezen en ga aan de slag!

Pa’fecfwmw :
JEFOTO'S
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Mac-sneltoetsen
De sneltoetsen die in de workshops worden ge-

noemd, zijnibedoeld voor Windowsgebruikers.

PhOtOShOp Maga21ne 30 gﬂ;fieg‘:gcilkers kiezen de volgende toetsen:

: BN At - Opt
44 Combineer dag | b Rechtsklikken = Ctrl-klikken
en nacht o i
Voeg twee werelden R Ry # Opdecdvind je voor zowel Windows als Mac
samen ! Y cen uitgebreid sneltoetsenoverzicht.
1. 8. 8¢ ' .

52 Maak een sci-fiposter

ledereen kan aantrekkelijke
posters ontwerpen
* %

60 Vervorming
verwijderen
Corrigeer vervormde foto's

*

62 Kerstsfeerinacryl
Maak een sfeervolle
afbeelding
in acrylverfstijl

* %

68 Verbeter de belichting
in je foto’s
Zo pak je onder- en
overbelichting aan

*

74 Maak een fantasierijk
boomhuis
Verander een gewone
boom in een magisch

stulpje
Yk Kk

82 Inside CC - lllustrator
Afbeeldingen overtrekken .
en schilderen MT 7
kK

10 i
Fantasykunst\ :

Wat betekenen
de sterren?

Makkelijk * ok
Gemiddeld *
Moeilijk ;
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dag en nacht

Creatief bezig zijn was nog nooit zo leuk

Is ervaren photoshopper heb

je vast vaker twee werelden

samengevoegd.

Het is één van de leukste projecten
om te ondernemen met je favoriete pro-

gramma. En als je zelf originele ideeén hebt,

zijn er talloze combinaties mogelijk.
In deze workshop kun je weer een paar
fantastische afbeeldingen mixen en

PHOTOSHOP MAGAZINE

manipuleren tot je een onwaarschijnlijk
geheel krijgt. Je ziet dat het tafereel een
geschilderd doek moet voorstellen en dus
nep is, maar toch krijg je het gevoel dat je
zo het nachtelijke landschap in kunt lopen.
Dat krijg je voor elkaar door slimme
Photoshoptechnieken te gebruikenen door
op details te letten.

Op de volgende pagina’s laten we stap

‘Z*:
by
1]

e
ﬂ,‘_‘.

Y
¥

voor stap zien hoeje zelf deze wereld kunt
scheppen. De technieken zijn niet erg
moeilijk, maar we houden de vaart er flink
in. Kun je heel nauwkeurig selecteren en ben
jevertrouwd met zaken als laagvolgorde?
Dan ben je klaar om dit avontuur aan te
gaan! Pak nog wat te drinken en laat je naas-
ten weten dat je de komende uren op
planeet Photoshop vertoeft.







Workshop Combineer dag en nacht

Overzicht 0 Deachterr |[mimee: aeer iE i : =
grond .

*** Werk je met eigen
foto's? Zorger

DE EXPERT { danvoor dat het

Andy Hau perspectief van
de foto met de
voorgrond over-

)
EN

LB oG Ernl AXERNFAS i) LT

PSCS5+ eenkomt met het
perpectlet vap
N defotometde
(/¥ Downloadenvan achtergrond. Je !
internet(opde begint met de ‘
cdvindjeeenlijst foto van de ach-
metlinks)

tergrond. Zet de
horizonnen dus
op gelijke hoogte.

Modus:  Normaal
Dekking: 100 %
{ Transparantie behouden

o
gy
¥
5
"
2
®|
@
Z,
"
LA
»,
a
2.1
T |
k|
LA
5|
Q
-
. my
o

0 Vullen Wil je de achtergrondfoto op een specifiek
formaat gebruiken? Versleep de foto dan naar een m Corrigeren Vaak krijg je met Inhoud behouden mooie resultaten
canvas met dat formaat. Als er nog lege plekken op de enzieje niet dat er beeld bijis verzonnen. Als er toch lelijke ran-

achtergrond zichtbaar zijn, selecteer je die met de Tover- den zijn ontstaan, gebruik je het Kloonstempel (Clone Stamp) om ze te
staf (Magic Wand) en ga je naar Bewerken>Vullen corrigeren. Klik met Alt om een bron te selecteren en schilder vervol-
(Edit>Fill). Kies Inhoud behouden (Content Aware). gens over hette corrigeren deel.

Za42 O

TEe s F oS

Q4 Devolgende afbeeldingen Sleep de voorgrondafbeelding, de
foto met de sterren en de foto met de maan naar je werkbe-

stand. Pas de Verzadiging (Saturation) en Lichtheid (Lightness) van — — : ‘ : o
de voorgrond aan met een aanpassingslaag Kleurtoon/verzadiging 05 Perspectief Teken met de Pen twee perspectieflijnen.
(Hue/Saturation). Ga naar Laag>Uitknipmasker maken (Layer> Zet alle lagen die bij de voorgrond horen in een groep

I — —

=

Create Clipping Mask). Zet de overvloeimodus van de sterrenlaag op enverplaats ze een stuk naar links. Knip vervolgens een hou-
Bleken (Screen) en knip de maan uit met je favoriete selectiemethode.  ten paaltje uit de bronfoto en zet hemin het werkbestand.
Zethem op een mooie plek. Met een laagmasker op de sterrenlaag Verleng hem met het Kloonstempel en gebruik de perspec-
bedek je de voorgrond. tieflijinen om hem op een goede plek te zetten.
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Touwen Plaats meerdere palenin je werk. Verbind
=/ ze door metde Pen de touwen te tekenen. Klik en
sleep met de Pen om het pad gebogen te maken en omlijn
het pad met zwart op een nieuwe laag. Voeg de laagstijl
Schuine kant en relief (Bevel and Emboss) toe om de lijnen
op touwen te laten lijken.

% Hanghetop Teken op dezelfde manier een grote stang waar het
v/ & doek metdevoorgrondafbeelding aan hangt. Gebruik nu rech-
telijnen en pas de dikte en de laagstijl hierop aan. Vergeet de kleine
houders waaraan de banen hangen niet. Daarna maak je gebogen pa-
den waar de doeken doorhangen. Zet de paden om naar een selectie en
gebruik een laagmasker op de voorgrondgroep om de achtergrond
plaatselijk weer zichtbaar te maken.

Banen vanstof Knip ook wat gaten in het doek, zodat
het lijkt alsof ze een beetje uit elkaar waaien. Je kunt
meer beweging creéren door de foto van het witte doek boven

de sterrenlucht te plaatsen en de laag op de overvioeimodus

Vermenigvuldigen (Multiply) te zetten.

4 Dupliceer de
laag met de voor-
grondfoto. Selecteer
dande witte vulling, |
maar houd de kopie-
laag actief. Ga naar
Bewerken>Vullen
(Edit>Fill) enkies
Inhoud behouden
(Content Aware). Zet
de kopielaag boven
de witte vullingen ga
naar Laag>Uit-
knipmasker maken.

Meer doek Teken met de Pen het deel van het doek dat op
de grond ligt. Vul dit met wit.

TIP
Uitknipmaskers

Het werken met uitknipmas-
kers is eenvoudig, maar je
moet het wel op de juiste
manier doen. Het is van belang
dat de laag waar de aanpas-
singslaag invloed op moet heb-
ben onder de aanpassingslaag
staat. Door het uitknipmasker |
te activeren zorg je ervoor |
dat de aanpassing alleen
invloed heeft op de laag direct
eronder. Wil je het
hele werk bewerken?
Dan zet je de aanpas-
singslaag zénder uit-

knipmasker bovenop
de laagstapel.
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4 4 Textuurerbij Kopieer de foto van de zwarte textuur naar je werk-
ILJL bestand en verwijder de witte delen via Selecteren>Kleurbereik
(Select>Color Range). Met de zwarte delen van de textuur geselecteerd
activeer je de kopie van de voorgrondlaag. Voeg er een laagmasker aan
toe en maak de textuurlaag onzichtbaar. Verbreek de koppeling tussen
het masker en de laag en verplaats de textuur tot je tevreden bent. In-

dien nodig werk je het masker bij door met wit of zwart te schilderen.

| *9 Deschilder
Gebruik je favo-
riete selectiemethode
omde schilder op de
ladder uit te knippen.
Zetheminje werkbe-
stand en gebruik een
aanpassingslaag
Kleurbalans (Color
Balance) met uitknip-
masker om hem mooi
bij de omgeving te
laten passen. Voeg
ook de laagstijl Slag-
schaduw (Drop Sha-
dow) toe omdiepte te
creéren.

| Contrasts

-
.

" Eenboelbeesten De vogels vormen een verbinding tussen de

m§§ twee werelden. Knip ze uit de bronfoto met de Toverstaf. Plaats
de vogels zoin je werkbestand dat er een aantal in de achtergrondfoto
vliegen en een aantal in de voorgrondfoto. Verander de belichting met

een aanpassingslaag Helderheid/contrast (Brightness/Contrast).
Plaats nu ook de hyenain je werkbestand en schilder er wat schaduw

onder.

PHOTOSHOP MAGAZINE

1 7§ Canvastextuur Kopieer nu de groene textuur (met
L&a dank aan EIné) naar je werkbestand. Verwijder de
kleur via Afbeelding>Aanpassingen>Minder verzadiging
(Image>Adjustments>Desaturate). Zet deze laag boven
de witte vulling en maak een uitknipmasker als dat niet
automatisch gebeurt.

41 /i Emmers Knip wat emmers uit de bronfoto en plak ze
IL"3E inhet werkbestand. Pas de grootte aan (Ctrl+T) en
zet ze op een geschikte plek. Schilder op een nieuwe laag
schaduwen onder de emmers met een zacht, zwart Pen-
seel. Zet deze laag op een lage Dekking (Opacity).

4 % Details Controleer alle details in je werk en beoor-
| deel of het een gebalanceerd geheel vormt. Kloon
bijvoorbeeld wat gras of aarde op de onderkant van de
palen, zodat ze in de omgeving thuis lijken. En voeg over
het geheel of op losse onderdelen nog wat aanpassingsla-
gentoe om kleur en belichting in overeenstemming met

elkaar te brengen. Daarnais je werk klaar!
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Deze maand op decd

oede bronnen vormen de basis van elk geslaagd Photoshop-

project. Daarom hebben we de workshopbestanden voor je

op een cd gezet, samen met nog veel meer gratis extra’s. Je

vindt op dit schijfje onder meer penselen, texturen en stock-
foto's. Kijk snel wat we dit keer voor je verzameld hebben!

Wallpapers
Zoek jemooie achtergrondenvoor
jebureaublad,iPhone ofiPad? Haal
dansnelwatwallpapersvandecd!

Texturen

Doordeze honderdtexturenvanGo
Media's Arsenal (www.gomedia.
us/arsenal)inPhotoshopte
combineren metdejuiste overvloei-
modikun je jewerk spannenderen
realistischer maken.

Workshopbestanden
Debestandendiejenodighebtom
deworkshopsindezeuitgavete
makenvindjeopdecd.

| gratisgebruiken!Kijk voormeerinformatie enafbeeldingen op
. www.freedigitalphotos.net.

Penselen

Texturemate (www.texturemate.
com)schenktjedertigabstracte
penselen, verdeeld overdrie sets,
waarmeeje zelfdemooiste achter-
grondenkunt maken.

Uitdaging

Wil je meedoen met De uitdaging,
maar hebjegeeneigenfoto’'s? Ge-
bruikdan de afbeeldingenopdecd.

| Vectors

Van Go Media's Arsneal (www.
gomedia.us/arsenal)krijgje
twintigoneindig schaalbare kaders,
waarmeejeinlllustratorsnelen
eenvoudigeengrungerandjeaan
jekunstwerkentoevoegt. Je kunt
zetrouwensookinPhotoshop
importeren.

™

Stockfoto’s

FreeDigitalPhotos.netis eenstockfotowebsite dietienjaar erva-
ringbinnende creatieve industrie combineert meteengezonde
dosisrespectvoorfotografenenontwerpers. Zijvormenimmers
debasisvanhetsucces van het bedrijf, is de gedachte. Zeventig
procentvandeopbrengstvaneenafbeelding gaat dan ook naar
defotograaf, die daarnaastde kanskrijgt om zijn portfolio te to-
nenop eenvande meestvindbare stockfotosites (via Google). Je
betaaltalleenvoor de afbeeldingen die je downloadt. Ook leuk:
onder bepaalde voorwaarden magje een miniatuur van elke foto
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Maak een
sci-fiposter

ledereen kan aantrekkelijke posters ontwerpen

et samenstellen van pakkende postersis  Op de volgende pagina’s leer je hoe je met kleur Overzicht
de ideale klus voor Photoshop. en licht een bepaalde sfeer kunt neerzetten.
In deze workshop maak je een plaat in Daarnaast ontdek je handige technieken om de **
sci-fistijl. Het idee achter deze posterisde  elementen in de poster te arrangeren, zoals selec-
fascinatie voor het onbekende. Hoe vaak heb je zelf  teren, knippen en gummen. Tot slot maak je zelf de DEEXRERT, )

niet in de lucht gekeken en je afgevraagd wat daar

allemaal te vinden is waar we nog niets van weten?
Als je eenmaal een idee voor een verhaal hebt, is

het eenvoudig om een poster te maken met zelf-

sci-fitekens die je in de achtergrond ziet. Hiervoor
kun je gebruik maken van kant en klare aangepaste
vormen of je tekent ze zelf met de Pen.

Sommige technieken zijn een tikje moeilijk, maar

Thomas Ciccone

gekozen thema's en elementen. Dus nadat je deze
workshop hebt afgerond heb je genoeg kennis in
huis om zelf een thematische poster te maken. Er
is niets leuker dan je eigen idee vorm te geven in
een mooi, afgerond project.

met de uitleg, de voorbeelden en een flinke dosis BRONBESTANDEN
vastberadenheid kom je vast al een heel eind! Dus ‘} Opdecd

ook al denk je nog niet klaar te zijn voor workshops

met deze moeilijkheidsgraad, is dit typisch zo'n work-

shop die je toch eens moet proberen.

I

Stap voor stap Buitenaards goed
Maak een sci-fiposter door foto's en abstracte vormente combineren

“ [7] Straal tonen (3)
7 Weergeven: | A0

g ﬁ [TJorigineel tonen (P)
L3
i | [F]slimme straal

*‘ Straal: [(}—— O b
<,

L‘ ~— Rand

: Viosiend: (}————————— § |
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| 3) | =
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T‘ ["Kleuren zuiveren
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@i Uttvoer naar: gelactie -
Q Dlnﬁelfmgenemhom

-
&

[__Annuleren ]

|

Foto'sstapelen Open de model- en landschaps-
foto van de cd en kopieer ze naar een nieuw can-
vas. Bepaal zelf de formaten van dit bestand en plaats
het landschap beeldvullend. Zet de Modellaag boven het
landschap. Met de Magnetische lasso (Magnetic Lasso)
maak je een selectie rond het model.

Rand verfijnen Ga naar Selecteren>Rand verfijnen (Select>Refine
- Edge). Zet Vloeiend (Smooth) op 5 px en klik op OK. Ga naar
Selecteren>Bewerken>S|mken (Select>Modify>Shrink) en kies 1 px. Keer
de selectie om met Ctrl+Shift+l en toets Delete zodat de achtergrond van
de Modellaag verdwijnt.
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Planeettextuur

0 Textuur toevoegen Open

Planeet_textuur.jpg van de
cd ensleep dit naar je werkbestand.
Zet de textuur boven de Planeet-
laag. Stel de overvlioeimodusin op
Bedekken (Overlay) en de Dekking
(Opacity) op 90%.

O Verdraaien Ga naar

Bewerken>Transformatie>
Verdraaien (Edit>Transform>
Warp). Versleep het kader zodanig
dat de textuur zich rond de planeet
lijkt te vormen.

T

0 Netjes afwerken Ctrl+klik

op de miniatuur van de Pla-
neetlaag en activeer de textuurlaag.
Keer de selectie om (Ctrl+Shift+l) en
toets Delete om de overbodige tex-
tuur te verwijderen.

PHOTOSHOP MAGAZINE

O Kopiéren

Deselec-
teer met Ctrl+D
en zet het model
ineen geschikt
formaat op een
mooie plek. Dat
doe je met Ctrl+T.
Maak daarna een
kopie vande
Modellaag met
de sneltoets
Ctrl+J.

b todet kapie

'm

| 0 4 Kleur veranderen

;‘ We gaan de kleuren

' vanhetlandschap aanpassen
middels een aanpassingslaag
Kleurbalans (Color Balance).
Klik hiertoe op de zwart-witte
knop in het Lagenpalet terwijl
je de Landschaplaag geacti-
veerd hebt. Vink Middento-
nen (Midtones) aan en zet
Rood (Red) op-30, Groen
(Green) op O en Blauw (Blue)
op -40. Vink dan Schaduwen
(Shadows) aan en zet Rood
op 25, Groenop -25en Blauw
op -20. Daarnavink je Hoog-
lichten (Highlights) aan en zet
jeRoodop 15, Groenop O en
Blauw op -20.

Acktergrond a

m b ‘.’ Helderheid/contrast 1

O Belichting veranderen Voeg nu een aanpassingslaag Helderheid/contrast (Bright-

ness/Contrast) toe. Stel Helderheid in op 10 en Contrast op 37, zodat de belichting
in de achtergrond wat contrastrijker en lichter wordt. Bedenk dat je altijd kunt terugkeren
naar deze laag om met een dubbelklik de instellingen aan te passen.



0 Fotofilters
Nu veran-
derje dekleur van
het geheel meteen
aanpassingslaag
Fotofilter (Photo
Filter), die je boven-
op de laagstapel
zet. Steldekleurin
op Oranje (Orange)
ende Dichtheid
(Density) op 60%.

i N

r— Doel
Document: scifi_werkbestand.psd

Naam Kanaal: Nieuw

Naam: - Horizon

9 Nieuw kanaal
Toevoegen aan kanaal

O Luchtselecteren We gaan de lucht selecteren om later de pla-

neet te kunnen plaatsen. Gebruik nogmaals de Magnetische
lasso en werk de randen bij door met Rechthoekig selectiekader (Rec-
tangular Marquee) terwijl je Shiftingedrukt houdt. Pas Rand verfijnen
toe met dezelfde instellingen. Verwijder de selectie niet, maar ga naar
Selecteren>Selectie opslaan (Select>Save Selection). Noem de selectie
Horizon en toets Ctrl+D.

0 Dering Teken nu op twee aparte lagen twee ovalen envul ze met
rode tinten. Met beide lagen geactiveerd toets je Ctrl+T, roteer je
de ovalen en zet je ze op de planeet. De bovenste ovaal moet wat kleiner
ziindan de andere en zet je iets uit het midden. Ctrl+klik op deze laag-
miniatuur en activeer de laag met de onderste, grotere ovaal. Toets Delete
omeenring over te houden en verwijder daarna de bovenste ovaallaag.

o

kader (Elliptical Marquee). Kies het gereedschap Verloop
(Gradient), stel een mooi verloop in via de Optiebalk en
sleepom de selectie met het verloop te vullen.

TIP
Ogenen huid

Door de kleurbewerking zijn de
ogen van het model wat flets
geworden. Neem een licht-
blauwe kleur en schilder op een
nieuwe laag met een zacht, klein
Penseel (Brush) over de irissen.
Verminder de laagdekking voor
sprankelende ogen. Wil je de
huid ook nog wat opfrissen?
Gebruik dan de gereedschappen
Doordrukken (Burn) en
Tegenhouden (Dodge)
om de schaduwen en
hooglichten nog wat bij
te werken naar je eigen
smaak.

Deplaneet Op een nieuwe laag onder de model-
lagen teken je een cirkel met het Ovaal selectie-

Ring 2 Bepaal met Ctrl+T de definitieve positie van
dering ende planeet. Ctrl+klik op de Planeetlaag
en activeer dan de Ringlaag. Neem het Gummetje (Era-
ser) enverwijder dat deel van de ring dat achter de pla-
neet moet vallen. Maak een tweede ring.
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Document: scfi_werkbestandpsd v
Haam Kanaal: [ SR ~
[l omkeren

ki

verkng
Il | © Nieuwe selectie
Toevoegen 2an selectie
Verwijderen utt selectie
Doorsnede met selectie

e

,.«..%L (R

11 Ring met verloop Dubbelklik op de Ringlaag om de Laagstijl
(Layer Style) Verloopbedekking (Gradient Overlay) toe te pas-
sen. Kies geschikte kleuren, bijvoorbeeld wit en roze. Maak daarna
eentweedering. Ganaar Selecteren>Selectie laden (Load Selection)
en kies Horizon. Keer de selectie om met Ctrl+Shift+l en activeer
beurtelings de lagen met de planeet enringen. Toets telkens Delete
omde planeet achter de horizon te zetten.

1 Land uitknippen Laad opnieuw de Horizonselectie en keer de
selectie om. Druk op Delete om het effect van het Zonfilter
alleen op de lucht te zien. Daarna neem je het Snel retoucheerpen-
seel (Spot Healing Brush) en activeer je de onderste Landschaps-
laag. Klik één of meerdere keren op de zonnevlekjes die in de foto

zitten om ze te verwijderen.

PHOTOSHOP MAGAZINE

1 Techniek Gebruik het

gereedschap Aange-
paste vorm (Custom Shape)
om technische vormente
tekenen. Je kunt ook de Pen
gebruiken omvormen te
maken. Met het gereed-

. schap Tekst (Type) typ je wat

rijen eentjes en nulletjes.
Gebruik zwart, grijs en licht-
roze tinten envarieer de

- overvloeimodivande lagen

om ze transparant te maken.
Wij gebruikten Bedekken
(Overlay), Bleken (Screen)
en Lineair doordrukken (Li-
near Burn). Varieer ook met
de Dekking (Opacity) van de
verschillende lagen.

1

1 Zonlicht Dupli-

ceerde Land-
schaplaag en ganaar
Filter>Rendering>Zon
(Filter>Render>Lens
Flare). Vink 50-300
mm zoomen aan en
zet Helderheid
(Brightness) op 155%.
Verplaatsin het voor-
vertoningsvenster het
kruisje om de positie
van de zonnevlekken
te bepalen.

Lichterland Maak boven de Landschaplaag een aan-
passingslaag Helderheid/contrast. Zet Helderheid op

10 en Contrast op 32 om het landschap lichter te maken.

1

S e )

Verscherpen Activeer de bovenste Modellaag en ga
naar Filter>Overige>Hoogdoorlaat (Filter>Other>

High Pass). Stel Straal (Radius) in op 7 en zet de overvloeimo-
dus van de laag op Bedekken. Controleer een laatste keer alle
details om te kijken of je tevreden bent met de kleuren, de
belichting en de plaatsing van alle elementen.



Alternatieve postereffecten

Gavoorretro
Ontdek verschil-
lende resultaten door
andere kleuren enver-
lopen te gebruiken. Pas
op elke laag de Laagstijl
(Layer Style) Verloop-
bedekking (Gradient
Overlay) toe en kies kleu-
renalsroze, bruinen
aqua, of neemvan één
kleur diverse tinten.

Rastereffect

Zet de voorgrond-
kleurin de Gereedschap-
penbalk op bruin of zwart.
Rechtsklik op de bovenste
laag en kies Verenigen;
zichtbaar (Merge Visible)
uit het menu. Ga naar
Filter>Schets>Halftoon-
raster (Filter>Sketch>
Halftone Pattern). Zet
Grootte (Size) op5-6en
Contrast op 25-30. Kies
bij Patroon (Pattern Type)
Stip (Dot).

Perkament
Maak boven de
lagen een aanpassings-
laag Zwart-wit (Black &
White). Verhoog het geel
enrood. Kopieer dan een
papier- of perkament-
textuur naar je werkbe-
stand en plaats hemals
bovenste laag. Zet de
overvloeimodus op
Bedekken (Overlay).

Helemaal digitaal
& Activeer de
bovenste laag en toets
Ctrl+Alt+Shift+E. Ga naar
Filter>Pixel>Mozaiek
(Filter>Pixelate>Mosaic).
Stel Celgrootte (Cell Size)
inop 18-25. Zet dan de
overvloeimodus van de
laag op Lineair doordruk-
ken (Linear Burn) en ver-
ander de kleur van de
aanpassingslaag
Fotofilter (Photo Filter).

Kijkeensop
gratis stock-
fotosites voor
zulke texturen.
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Top 10 Fantasykunst

oewel Je verbeelding het ee e en belang
e eleme eb Je ook Photo op
e eke odig o e fanta e to
eve e brenge
Op deze pagina gle de gereed appe
an Photoshop waa eeje zo nproje onderne
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et he ar Ve
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{“} £ *Maak een nieuwe laag onder de
(‘a @ afbeeldmgen vuldle met wit. Voeg een laagmasker
toe aan de afbeeldingslaag en neem het gereedschap Verloop
(Gradient). Stel ditin op Lineair (Linear) van zwart naar trans-
parant. Pas het verloop toe op het laagmasker voor een verva-
gend effect.

-Gebruik eenlaagmasker en een zacht,
rond Penseel omderanden van een uitgeknipt object
te vervagen. Je voegt het laagmasker toe aan de laag met het
objecten schildert met zwart heel voorzichtig langs de rand.

a : ~ Gebruik het filter Vervagen>
JO GauSSIaans vervagen (Blur>Gaussian Blur) om per-
spectief te creéren en een beetje dramatiek toe te voegen. Zo
maak je bijvoorbeeld de achtergrond zachter, waardoor de

voorgrond meer aandacht trekt.

schil 1 Boven de

Iaag met de modus
Uitsluiting (Exclusion, tip 2)
1 maak je een nieuwe laag
| dieje Iinstelt op Bleken

' (Screen) of Zwak licht (Soft
i Light). Klik met een
| wolkenpenseel en een
{ lichte kleur om een
| misteffect te creéren.

-
e

!

|
|

Pt

Als je de kleurenin je werk wilt bewerken,
is Kleurbalans (Color Balance) een goed hulpmiddel.
Voeg dus een aanpassingslaag Kleurbalans toe via de zwart-
witte knop in het Lagenpalet en gebruik de schuiven om be-
paalde kleuren af te zwakken of juist te versterken.

ST,
\.{ P
&

y Haarp Na het schilderen van haren kun je via
W Bewerken>Transformat|e>Verdraa|en(Ed|t>Trans—
form>Warp) de laag vervormen, zodat het haar lijkt te golven.
Dupliceer de laag en kies Bewerken>Transformatie>Roteren
(Rotate) om een natuurlijker resultaat te krijgen. Voeg ook
hooglichten toe of een tweede haarkleur door op een nieuwe
laag meer haarlokken te schilderen.

vvan: www.auroradreams.deviantart.com, www.
atropo stock deviantart. com, www.elanordh.deviantart.com,
www.hellonlegs.deviantart.com
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Vervorming

verwijderen

Corrigeer vervormde foto's en zet gebogen randen of een scheve horizon recht

Overzicht

Simon Skellon

PHOTOSHOP MAGAZINE

onvervorming komt meestal voor bij fo-
to’s die gemaakt zijn met een groothoek-
of fish-eyelens. Het is een lenseffect dat
je creatief en artistiek kunt gebruiken,
maar soms past het niet bij de foto en wil je alle
elementen zo snel mogelijk rechtzetten.
Gelukkig is er een manier om de vervorming te
verwijderen in Photoshop, en in deze workshop
laten we zien hoe dat werkt. Veel photoshoppers
kiezen voor het filter Lenscorrectie om vervorming
en andere lensfoutjes te lijf te gaan. Dat is een po-
pulaire en goede keuze, maar we laten je in deze
workshop een alternatief zien: we vertellen hoe je
met Transformatie en enkele andere aanpassingen
volledige controle hebt over het eindresultaat.
In de startfoto hierboven zie je duidelijk vervor-

ming: de masten van de boten zijn niet helemaal
recht en de reflecties in het water zijn ook verbo-
gen. Als je goed kijkt, zie je zelfs een lichte bolver-
tekening. Dit effect kan heel handig zijn, bijvoor-
beeld als je interieurfoto’'s maakt van een krappe
ruimte, maar soms is de vertekening aanwezig op
een plek waar je hem niet wilt hebben.

In deze workshop gebruiken we Transformatie
om de foto in de goede vorm te buigen. Daarna
roteren we hem en verbeteren we het perspectief.
Deze methode werkt bijna altijd, maar het resul-
taat is wel afhankelijk van de vervorming van de
foto. De vervorming in onze startafbeelding is een
beetje overdreven, maar hierdoor kunnen we je
goed laten zien hoe je het probleem gemakkelijk
kunt oplossen.




Stapvoorstap Laathet vervormenbeginnen
Verdraaien, Perspectief en Uitsnijden

o

Dupliceren en verbergen Open de foto boten.
jpg vande cd. De tonvervorming is in deze foto
het best te zien bij de masten van de boten. Dupliceer
de Achtergrondlaag via Laag>Dupliceren (Layer>
Duplicate Layer). Verberg de Achtergrondlaag door
op het oogje voor de laagminiatuur te klikken.

Nieuwericht-
liinOmeen
beter idee te krijgen van
de vervorming, voeg je
een verticale hulplijn
toe via Weergave>
Nieuwe hulplijn (View>
New Guide). Kies bij
Oriéntatie (Orientation)
Verticaal en klik OK.

Je ziet nueen gekleurde
hulplijn links van de
foto verschijnen. Met
het gereedschap Ver-
plaatsen (Move) sleep
je deze naar eenvan
de hoofdmasten.

| TIP
Vervorming
tegengaan
Eris eenan-

dere manier om
problemen met
tonvervorming
op telossen. In
Photoshop kun je
kiez en voor het
filter Lenscorrec-
tie (Lens Correc-
tion). Je vindt dit
filter sinds CS2

in het filtermenu.
De regelaars en
aanpassingsop-
ties bieden alles
wat je nodig hebt
op één plek. Met
het filter ga je niet
alleen vervorming
te lijf, maar ook

Bewerkingsopties Zorg

Rechtzetten Begin bijde

Vervormdemast Voeg

onge- ST
wenste / q
vignetten

en kleur- L f
schifting. &3

dat de kopie van de Ach-
tergrondlaag actief is en ga naar
Bewerken>Transformatie>Ver-

draaien (Edit>Transform>Warp).

Er verschijnt eenraster dat be-
staat uit negen gelijke viakken.
De hoekpunten van deze viakken

kun je verslepen om zo de afbeel-

ding te vervormen.

hoogste mastin het midden
van de afbeelding. Sleep aan de ras-
terlijn links van de mast, totdat de
mast evenwijdig loopt aan de hulplijn.
Klik op het groene vinkje in de Optie-
balk of toets Enter om de veranderin-
gente bevestigen. Gebruik deze als
referentie voor de rest van de foto. De
foto hoeft nu nog niet perfect te zijn

/ nog eenverticale hulp-
lijn toe als referentie en plaats
deze naast een andere verbo-
genmast. Ga naar Bewerken>
Transformatie>Verdraaien en
sleep aan de foto totdat de
mast rechtis. Hierna moet je de
horizon aanpassen, zodat het
geheel weer bij elkaar past.

Opéénlijn Verplaats de
hulplijn van de linkerkant
naar rechts en zet hem naast de der-
de mast. Herhaal het verdraaien en
bewerk alle masten aan de rechter-
kant van de foto. Zorg dat het mid-
denvan de foto zijn vorm behoudt.
Nu staan alle mastenin je foto recht.

Perspectief aanpassen De masten staan nu
& recht, maar de foto heeft nog steeds een
gebogen horizon. Los dit op door een horizontale
hulplijn toe te voegen via Weergave>Nieuwe hulplijn
(View>New Guide). Plaats deze op het midden van
de foto, ga naar Transformatie>Verdraaien en duw,
net zoals in ons plaatje, de luchtin het midden naar
beneden en het water in het midden naar boven.

Slinken enbijsnijden
=2/ De foto heeft nog steeds niet
de goede vorm, dus verdraai de vier
hoeken naar buiten om de randen en
reflecties in het water aan te passen.
Toets Enter om de aanpassingen vast
te leggen en gavervolgens naar Weer-
gave>Hulplijnen wissen (View>Clear
Guides). Gebruik het gereedschap
Uitsnijden (Crop) om alle overtollige
delenvan het canvas weg te snijden.
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Bex Glover

WERKT MET

PSCS2+
wz Opdecd

eigen tekeningen.

94 Lijnenvoorbereiden Je kunt het
At j‘ voorbeeldbestand acryl_sjabloon.
psdvande cd openen. Hierin staan de
getekende lijnen op afzonderlijke lagen.
Zodraje deze workshop hebt volbracht,
kun je hetzelfde proces loslaten op je

Kerstsfeer in acryl Workshop

Kerstsfeer

in acryl

Leer hoe je een afbeelding in acrylverfstijl maakt met
behulp van Penselen, selecties en lagen

eze workshop leidt je door diverse tips en
technieken om een afbeelding te creéren
die met acrylverf geschilderd lijkt te zijn.
Het is daarbij de bedoeling om iets te
maken met dikke verfstreken en felle kleuren.
Je kunt voor deze workshop ons sjabloon gebrui-
ken. Dat is een gelaagd Photoshopbestand met
de getekende lijnen. Daarmee heb je meteen een
voorsprong. We gaan vervolgens aan de slag met
selecties, lagen en laaggroepen, eenvoudige
handigheidjes van de Penselen, schalen, dekking

& 2 W N

en laageffecten. Het is de moeite van het vermel-
den waard dat voor deze workshop (en in het alge-
meen bij het nabootsen van artistieke effecten in
Photoshop) je echt niet zonder een tekentablet
kunt. Hiermee werk je namelijk veel natuurlijker en
effectiever dan met de muis.

Zodra je klaar bent met deze workshop ben je in
staat om je eigen acrylscenes te creéren. Teken
gewoon zelf een schets en volg de principes die wij
hier uitleggen. Alvast veel plezier met het perfectio-
neren van je acrylverfstijl!

zo dadelijk nader zullen bekijken.

@9 7D MaakkennismetdelagenOm het
/& schilderij op te bouwen wordt de
scéne opgesplitstin een aantal mappen,
ofwel laaggroepen, namelijk de achter-
grond, het midden en de voorgrond. Elke
laaggroep bevat verschillende elementen.
Het hert heeft zijn eigen map en er is ook
een laaggroep genaamd Extra, die we

3 WerkenmeteenkleurenpaletOm
&

Vwd) te beginnen voegen we wat kleur
toe aan de achtergrond. In de map Extra
inhet Lagenpalet vind je een laag met de
naam Kleurenpalet. Klik op het cogsym-
boolvoor deze [aag en er verschijnt een
laag met voorgeselecteerde kleuren.
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Workshop Kerstsfeer in acryl

| TIP
Afwerking

Voeg wat hooglichten
toe aan gebieden die

het licht zouden moeten
vangen. We hebben
vooral bladeren en tak-
ken gekozen en op een
aparte laag wat witte
accenten aangebracht.
Bedenk of je wellicht wat
textuur moet toevoegen
aan je afbeelding om
hem meer tastbaar te
maken. Hier hebben

we een canvastextuur
toegepast (ingesteld op
een lage dekking) in de @
map Extra. De m
zichtbaarheid
hiervan kun je
naar wens in- of
uitschakelen.

7
+

PERIALACSRNEFASHALOD

=
2

ﬂ KleSJekleuren Schakel de Kleu- ' Beginachteraan Om kleur toe te voegen kun je het

4. renpaletlaag naar behoefteinen »)) beste beginnen met de achtergrond. Schakel de
uit en kies hieruit de kleuren die je nodig zichtbaarheid van de andere lagen uit en selecteer de laag
hebt met het Pipet (Eyedropper, toets I). Heuvels. Gebruik de Toverstaf (Magic Wand, toets W) om
Voeljevrijomdekleurente veranderenals  de gebieden die je wilt opvullen te selecteren. Kies dan de
je met eenander kleurenpalet wilt werken.  gewenste kleur.

/

737 MeerbasiskleurenHerhaal stap 5en 6 nuvoor alle gebie-
WD (Layer>New Layer) of Ctrl+Shift+N een nieuwe laag &t xf denwaaraan je een basiskleur wilt toevoegen. Probeer
onderdelaag Heuvels. Vulhem met de geselecteerde kleur met om de verschillende kleuren op afzonderlijke lagen te zetten, zo-

het Emmertje (Paint Bucket, toets G) en gadan naar dat je meer controle over de bewerking hebt. Om sneller kleuren
Selecteren>Selectie opheffen (Select>Deselect) of toets Ctrl+D. te selecteren, lees je het kader over dit onderwerp op pagina 66.

| [ SN

3 { Verwijder delijnlagen Nu je de basiskleuren hebt inge-
J e vuld, kun je de omtreklagen verwijderen. Maar voordat je

&) Verderekleuropbouw Blijf kleuren toevoegentot je iets hebt

1 |

: dat op ons voorbeeld lijkt. Het resultaat hoeft niet perfect te dat doet, slaje voor de zekerheid een kopie van het bestand met
7 zijn, want dit zijn nog slechts de achtergrondkleuren waarop je straks delijnlagen op voor het geval je terug moet naar een oudere ver-
J dedigitale acrylverf en details gaat aanbrengen. sie. Je kunt natuurlijk ook gewoon deze lagen onzichtbaar maken.
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Aanpassingen
Alinea
Animatie
Bron Klonen
Handeingen
Histogesm
Historie:

Info

Kanalen

Kleur
Lasgsamensteliingen

Penselen Voor dit acrylverfwerk willen we een dikke,
expressionistische sfeer creéren en dus hebben we een
klein arsenaal aan Penselen verzameld die helpen bij het berei-
kenvandit effect. Ga naar Venster>Voorinstellingen voor pen-
seel (Window>Brush Preset) om het gelijknamige palet te
openen.

Ruwe platte kwast

" Ronde kwast
100

)
%" Gldde ronde kwast
104

1
B Ruwe ronde kwast
104

4 ¥) Deachtergrondopbouwen Kies de Platte kwast (Flat Bris-
L& tle) en maak een nieuwe laaggroep (toets Ctrl+G) voor je
achtergrondkleuren. Op een nieuwe laag begin je met kleine
penseelstreken en diverse kleuren met het toevoegen van de-
tails aan de achtergrond. Een tekentablet maakt dit proces veel
gemakkelijker!

Uiteindelijkeschets Delaagstijl Rand

Voeg snel contourentoe
met dezetrucs [=

Voegwat contourentoeom
deexpressionistische stijlte
versterken. We willendit ef-
fectvooralopdevoorgrond-
elementeneneenaantalvan
degroterebomentoepassen
omzemeernadrukte geven.
Dubbelklikop de laag die
jevaneenschetseffect wilt
voorzienomde Laagstijlen

teopenen.Klikopde optie ]
RandofLijn (Stroke) omdeze inte schakelenende ove-
rigeopties weer te geven. Klikdanop hetkleurvakjeen
kieseenkleur. Stel ook de breedtevandelijnin.

3 41 Dejuiste penselenkiezen In de rechter bovenhoek van het
ILJL paletklik je op het driehoekje om een uitklapmenu te ope-
nen. Kies hieruit Dikke zware penselen (Thick Heavy Brushes).
Klik op OK wanneer er wordt gevraagd om de huidige Penselen
te vervangen. Selecteer nu het gereedschap Penseel (Brush,
toets B).

Batind | Boonton | Albariig| Lowg | Satenn Pt Wewgme | Vensae e | B B9 9o mmie @Be Mt

| D B et s w0 f e o 0 !

3 N

Lttt

#9 Penseelaanpassen Vergeet niet om de grootte van het
f.mwﬂ}’ Penseel te verkleinen wanneer je verder weg richting de
achtergrond werkt. Dit kun je regelen via het Penselenpalet of
via de Optiebalk boven in het scherm onder het hoofdmenu.
Hier kun je ook experimenteren met de Dekking (Opacity) en de
Stroom (Flow) van de verf.

Snellelijnen Met de
laagstijl Rand kun je een
| schetslijn toevoegen en
tegelijkertijd de controle
| behouden over de kleur
| en de dikte.
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Workshop Kerstsfeer in acryl

Gebruiklagen Probeer veel lagen te gebruiken, bijvoor-
beeld voor verschillende kleuren of onderdelen van het
SChI]deI’I Voeg op nieuwe lagen wat basiskleuren en details toe
aande maan ende lucht. Experimenteer en wees expressief bij
het zetten van nieuwe penseelstreken.

Details dupliceren Bij het tekenen van elementen zoals

= hetgras kun je door onderdelen te dupliceren snel details
opbouwen. Sleep met de Lasso (toets L) om een gebied dat je
wilt kopiéren en toets dan Ctrl+J om dit gedeelte te dupliceren.
Ditresulteertin een nieuwe laag die je kunt verplaatsen, verklei-
nen, roteren of spiegelen.

Vooral doorgaan Met alle hiervoor beschreven technieken
kun je steeds meer details toevoegen, waarbij je naar de
voorgrond toe steeds groter werkt. Maak nieuwe lagen voor de
verschillende elementen en vergeet niet om stukken te duplice-
ren, te transformeren en de kleuren aan te passen.

PHOTOSHOP MAGAZINE

B D (0 Heat

P {1 voorgrond

E\i < Hetmiddenstuk Voeg in een nieuwe laaggroep details toe
Le’ aan het midden, zoals boomschors, bladerenen gras.
Probeer te werken met een klein, zacht, rond Penseel. De stre-
ken moeten nu nauwkeuriger zijn dan die van de achtergrond,
dus neem de tijd om elk element zorgvuldig te tekenen.

=T Ongedianmeken

Shiff Ctl+F

Ctbe X
€
Shifts Ctle C
Ciey

Zo schelen dat inhoud behouden bfjft
Marionet verdrasien

ShiftCtrl+ Q

CtrisT

R S e e

- Roteren
| Schuintrekken
| Vevormen

Schalenenaanpassen Gebruik Bewerken>Transformatie
(Edit>Transform) of toets Ctrl+T om elementen te schalen.
Houd de Shift-toets ingedrukt tijdens het slepen om de verhoudin-
gente behouden. Voor meer variatie pas je kleuren aan met behulp
van een Laagstijl (Layer Style). Klik hiertoe op het Fx-pictogram
onder inhet Lagenpalet en kies Kleurbedekking (Color Overlay).

Stalen
Selecteren enopslaan
Werk efficieénter met kleur

Als je razendsnel de juiste kleuren wilt selecteren tijdens het werken
met het Emmertje, gebruik je de Alt-toets. Bij een aantal gereed-
schappen die werken met kleur, zoals het Emmertje en het Penseel,
kun je door de Alt-toets in te drukken de cursor tijdelijk veranderen in
een pipetje. Hiermee selecteer je snel een kleur uit je werk.. Wan-
neer je de Alt-toets loslaat, verandert de cursor weer in het gereed-
schap waarmee je aan het werken was. Verder kun je het Stalenpalet
(Swatches) goed gebruiken als
alternatief voor een laag met
kleuren zoals je in stap 4 ziet. Als
je een kleur gekozen hebt en met
de muis boven een leeg gebied in
het Stalenpalet zweeft, verandert
de cursor in een emmertje. Klik
dan om de kleur toe te voegen
enklik op OK. Vanaf nu kun je

ook via deze weg je kleuren snel
selecteren.
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Photoshop

Zo leer /é Fhotoshoppem

126 pagina’s creatieve projecten, praktische
tips en stap-voor-stap workshops
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ENPHOTOSHOP ELEMENTS 13

N Ruim 30% korting op de winkelprijs
N Voor zowel beginners als gevorderde

N Ontvang het Basisboek Photoshop
met cd cadeau

Bestel nu op:

www.fnl.nl/photoshop

Deze actie is geldig tot 10 februari 2015 of zolang de voorraad strekt. Je abonneert tot wederopzegging en voor ten minste de actieperiode van 10 nummers.
Na de actieperiode wordt het abonnement automatisch verlengd tegen het dan geldende standaardtarief.
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Verbeter de belichting in je foto’'s Workshop

Verbeter de
belichting in je foto’s

Z0 pak je onder- en overbelichting aan

et is niet altijd gemakkelijk om een goed

belichte foto te maken, hoe bedreven je

ook bent als fotograaf.

Het instellen van de goede sluitertijd, het
diafragma en ISO-waarde is niet altijd de sleutel
tot succes, bijvoorbeeld omdat de lichtomstandig-
heden te snel wisselen of heel lastig zijn om vast te
leggen. Ook als je veel in de automatische modus
fotografeert, kun je te maken krijgen met foto's die
onder- of overbelicht zijn.

Zoals je weet, is er genoeg software voorhanden
om je te helpen zulke foto's op te knappen.
Photoshop is één van de mogelijkheden en op de
volgende pagina's laten we stap voor stap zien hoe
je over- en onderbelichting corrigeert. Onthoud dat
je niet altijd alle over- of onderbelichting kunt laten

verdwijnen, omdat uitgebeten hooglichten of Overzicht
dichtgelopen schaduwen simpelweg geen verdere
beeldinformatie meer bevatten.

De techniek die je hier leert leunt onder meer op
het gebruik van aanpassingslagen. Dit zijn extra
lagen in het Lagenpalet die de corrigerende
informatie bevatten. Deze lagen zijn non-destruc-
tief; wat wil zeggen dat je ze altijd nog kunt
aanpassen (door de aanpassingslaag opnieuw te
activeren), ze kunt verwijderen (door ze naar het
prullenbakje te slepen) of gedeeltelijk kunt
toepassen. Dat laatste laten we in het eerste
project zien. Wat ook handig is, is dat je snel kunt
beoordelen of de aanpassingslaag naar wens is
door hem in- en uit te schakelen met een klik op
het oogje voor de laag.

*

Hayley Paterek

WERKT MET

BRONBESTANDEN

|

&

B®l Gebruikeigenfoto's

Project1 Onderbelichting corrigeren
Erzitten dingen inde schaduw!

{| Dupliceerdelaag Neem een te donkere foto uit je eigen (W
44 archief en open hemin Photoshop. Rechtsklik op de Ach-
tergrondlaag en kies Laag dupliceren (Duplicate Layer).

Levendigheid...
Kleurtoon/verzadiging...
Kleubalans...
Zwat-wit...

Fotofilter...
Kanasimier...

Omieren

Verloop toewijzen...
Selectieve Keur...

") Curven Dubbelklik op de laagnaam en verander hemin

=1 Correctie. Toets Enter enklik op de zwart-witte knop in het
Lagenpalet. Inhet menu selecteer je Curven (Curves) en er opent
een Aanpassingenvenster.
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Workshop Verbeter de belichting in je foto’s

) TweepuntenKlik op ongeveer drie-
oD kwart hoogte op delijn in het venster
met de Curvenaanpassing. Sleep dit punt
een beetje naar links. Dit punt vertegen-
woordigt de hooglichten en je ziet dat de foto
lichter wordt door het slepen. Sleep een
tweede punt op ongeveer een kwart van de
lijn een beetje naar rechts om de schaduwen
iets donkerder te maken.

y

Qo

% Schilderen Schilder over de lucht. De zwarte kleur be-

./ dektheteffect vande aanpassingslaag Curven, dus op
dle plek zie je de originele foto. Verklein de penseelgrootte als je
nauwkeuriger moet werken. Maak je een foutje? Schilder er dan
met wit overheen.

G- I

fi g@ Selecteerhetlaagmasker Helaas

& maakt deze aanpassing de toch al
lichte lucht te bleek. Om de wolken, en dus
details, weer meer zichtbaar te maken
activeer je het laagmasker van de aanpas-
singslaag. Klik dus op de witte miniatuur in
het Lagenpalet omheminde volgende
stap te kunnen bewerken.

' & grond bedekken. Versleep daartoe het laagmasker van
de onderste aanpassingslaag naar de bovenste terwijl je Alt inge-
drukt houdt. In het waarschuwingsvenster kies je voor de optie
om het laagmasker te vervangen. Toets dan Ctrl+l om dit laag-
masker negatief te maken.

PHOTOSHOP MAGAZINE
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\ “”?ﬂ HetPenseelNeem het Penseel
JJ (Brush) uit de Gereedschap-
penbalk en zet de voorgrondkleur op
zwart. Via de Optiebalk selecteer je
een zachte, ronde punt en zet je Dek-
king (Opacity) op 80%.

)7 Meerwolken De lucht kan er beter uitzien. Dat doe je

\J 4 meteentweede aanpassingslaag Curven. Zet op de-
zelfde plek als in stap 3 twee puntenin de curve en sleep de bo-
venste naar beneden en de onderste naar rechts. Je ziet meer
wolken verschijnenin de foto.

Helderheid en contrast Je kunt de algehele belichting nog
=2 beter maken met een laatste aanpassingslaag. Kies nu
Helderheid/contrast (Brightness/Contrast). In het Aanpassin-
genvenster zet je Helderheid op 120 en Contrast op 20. Indien
nodig werk je ook dit laagmasker bij.

ﬁ) Q



Project2 Fix overbelichting
Effe dimmendie hooglichten

IR Ly Secwen Fiae Vieogwe vess Hep | OB PIe v e M-

L AAlEEe wul b
..

W

Hoeveeheid; 7 i
RSO e S e
Toonbreedta:

R ]

i mo—— Hooglichten aanpassen Bij Hooglichten (Highlights)
Schaduwen enhooglichten Open een overbelichte foto, dupli- X 1 zet je de knop Hoeveelheid (Amount) op zo'n 7%. Zet
ceer de Achtergrondlaag en hernoem hem. We gaan nu de deze optie niet te hoog, anders krijg je lelijke viekken in beeld.

hooglichten zachter maken via Afbeelding>Aanpassingen>Schaduw Verander Toonbreedte (Tonal Width) naar 35% zodat er niet
en/hooglichten (Image>Adjustments>Shadows/Highlights). te veel contrast verloren gaat en zet Straal (Radius) op 60 px.

{
! #IVoorvertoning
= HOOGCHEEN —— -
i ] | Hoevaenen: 7%
2
,,,,,,, Toonbreedts: 3 %
LR
Straat 60 px
X gl
[~ Aarpassngen e
AR e A e e i
2 3.8 e Keurcomacta: )
Contrast middentonen: o N i i3 23
G T ‘Contrast middentonen: 3
00 % a
Goi % Zvartgrens: 001 %

Middentinten met contrast Om het contrast intact te
heid op ongeveer 9% en Toonbreedte op 35%. Straal kan op ¢ houden zet je Contrast middentonen (Midtone Con-
30 px blijven staan. trast) op +3. Daarnaklik je op OK.

|

i
8

B o

! ks

" Curven Maak een aanpassingslaag Curven. Zet
Y/ eenpuntinhet bovenste kwart vandelijnen
sleep een stukje naar rechts. Hiermee demp je de hoog-

AN mxxﬁéf

i
¥

'Al] wwN g

5

&
;

1

" Gebalanceerdebelichting Sleep tot slot een derde punt in het
onderste kwart wat naar links om niet te veel contrast te verlie-

lichten een beetje en krijg je wat detail terug. Zet een zen. Benje nog niet helemaal tevreden, voeg dan een aanpassingslaag
tweede puntin het midden van de lijn en sleep een beetje Helderheid/contrast toe. Verlaag Helderheid naar zo'n -40 en verhoog
naar rechts. Contrast een beetje naar ongeveer 10.
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5 Toptips Creatieve plug-ins

Creatieve plug-ins

Dit zijn de beste plug-ins voor
ongelooflijke effecten

Uttra Sketcher

Van Gogh Flow withou...

Voyager 2

hotoshop wordt nog leuker als je het com- 0 soom

bineert met plug-ins.

Zoals het woord al doet vermoeden koppel

je dergelijke software aan Photoshop als een
insteekmodule. Hiermee breid je de mogelijkheden
van het programma aanzienlijk uit. De ene keer gaat
het om extra functionaliteit en de andere keer om
snellere bewerking.

Er zijn honderden plug-ins te krijgen. Bij het
samenstellen van deze top 5 letten we op een paar e
belangrijke kenmerken: makkelijk te gebruiken, leuk e [ etngs T o 5
om mee te experimenteren en vol met creatieve
effecten of handige functies.

Wished-ot Vintage.

@ﬁ, cFilter Forgereikt je niet alleen
een ﬂmke reeks filters aan, want je kunt ze

hiermee ook zelf maken en delen. Dankzij naadloze
patronen, bump mapping (structuuropbouw) en
resolutieafhankelijke rendering kun je de filters op
afbeeldingen van alle formaten toepassen, of ze nu
3D of 2D zijn. Op www.filterforge.com kun je de
plug-in aanschaffen en vind je ook allerlei gratis
filters. De software kost 399 dollar.

Met de plug:{n 'I;ilztﬁer
Forge kun je helemaal
zelf effecten maken. J

'? ltimate Genlindit programma
@i ZItten veel art[stleke grafische en fotografi-
sche effecten waarmee je je afbeeldingen kunt ver-
anderen. Je verbeterter niet alleen de resultaten
van Photoshopfilters mee, maar je krijgt er ook
nieuwe effecten bij, zoals Crystal Painter en Liquid
Metal. Je koopt de software via www.autofx.com
voor 199 dollar.

- W' @ Resize (6 swetn )

DocumentSize | gxg =]

Ll
]

@ Width soo| ... .
_,._; e inches ;j

Height 8.00

7 :% 12 Als je foto's gaat vergroten, blijven
“ Resolution | 300 ! [pixelsin 3]

Y eafbeeldmgen dankzij Blow up 3 zeer
scherp Sporenvan beeldfouten dooreenlagere-
solutie zijn nauwelijks te zien. Ditis een plug-in die
je gewoon moet hebben. Koop hem voor 99 dollar
viawww.alienskin.com.

Original Resized
Width 1795 2400 134%
Height 2012 2400 119%

~Enlargement Tuning

1 Instagram is niet het

I Shar Ed
JEL enige hulpmlddelom oude effecten op el SRS | e
je foto's toe te passen. Voor zo'n 99 dollar, via 5
. . Grai:
www.misterretro.com, doe je helemaal mee met S Lo etk e L e

de retrotrend en kun je flitsvlekjes toevoegen, ont-
wikkeltechnieken nabootsen, oude texturen
toepassen en nog veel meer.

@it Deze gratis

‘% plug inis ontworpen voor Photoshop CS5
en nieuwer. Het biedt veel penselen met traditio-

| Sharpening For QutputMedivmn .
T —
[ Screen (web) 5l (g 2}

Custom Sharpening Radius,

Reset All Controls

nele effecten zoals potlood, houtskool en verf.
Er zitten ook texturen bij als papier en canvas en it -

gereedschappen omtexturen toe te voegen.
Ontdek deze en meer functies via tinyurl.com/
NKS5-Essential-Media.

foto's op haar superfor—
maat met deze plug-in
met de toepasselijke
naam Blow up.

[' na " Blaas je
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PHOTOSHUP ALTERS YEETOR ARTAPPS MERCEANBSE Oe SuER Jo s |

e —,
r Load Save |
r Select Beam Style..
%’?‘“ [ 20 ¥]
Fade Out 1
FadeOut [FWES
5““",“‘

A e

Select Atmosphere.

Strength '__j [ 80 b
Softness i :
H 1€ 0 ¥
Density, (‘s
Variation < 0 b

ER RETRO®

(&5
0 >
> A

de ruime hoeveelheid
effecten die in bijna al je
beeldbewerkingsbe-
hoeften voorziet.

populaire retro
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Terug in de tijc Met
Retrographer pas je
moeiteloos de oh zo

foto-effecten toe.
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Maak een L
fantasierijk
boombhuis

Gebruik wat eenvoudige schildertechnieken en laagstijlen
om van een gewone boom een magisch landschap te maken

antasie draait volledig om het verkennen
van je verbeelding. In deze workshop leer
je hoe je je eigen verbeeldingskracht kunt
omzetten in een aansprekend beeld.
We leiden je door de aanpassingen en laagmaskers
die je nodig hebt om een foto te verbeteren en
door de verschillende overvloeimodi waarmee je
eenvoudig lagen kunt beinvloeden. Daarnaast leer
je de magie achter het maken van je eigen vormen.
De trappen die naar het huis leiden zijn helemaal
gemaakt door donkere vormen rechtstreeks op de
sneeuw te schilderen. Met schaduw en licht is de
illusie gewekt van een driedimensionale trap op

Maak een fantasierijk boomhuis Workshop

8 ',&

&
tartfoto’s .

een plat oppervlak. Op dezelfde manier zijn de ra-
men gemaakt door lichtere tinten met gloed te
schilderen. De kozijnen zijn geproduceerd met
behulp van laagstijlen. Deze schildertechniek biedt
je de mogelijkheid om je scene volledig naar wens
vorm te geven met iedere vorm die je maar wilt.

ledere stap is goed gevuld met technieken en
uiteenlopende gereedschappen, van aangepaste
penselen tot paden die zijn gemaakt met de Pen.
Neem dus de tijd en volg de stappen op je eigen
tempo. Wanneer de basisafbeelding af is, gebruik
je verder je eigen creativiteit om nieuwe elementen
toe te voegen.

/
4

overige begroeiing.

f% Verzadiging handmatig verhogen Open om te beginnen Boom.
AL jpgvande cd. Het fantasieboomhuis wordt levendig, dus maak
eennieuwe laag door Ctrl+Shift+N te toetsen en zet de overvioeimo-
dus op Verzadiging (Saturation). Kies het Penseel (Brush, toets B) en
stelhemin op een vrij grote diameter, 0% Hardheid (Hardness) en
15% Dekking (Opacity). Schilder met geel op de nieuwe laag om de
verzadiging te verhogen. Besteed extra aandacht aan het mos en de

™9 Eenzachtebokeh Ga naar Bestand>Plaatsen

=1 (File>Place) en kies het bestand Bokehl.jpg van de
cd. Deze laagis nuautomatisch een Slim object geworden,
wat betekent dat je hem zonder kwaliteitsverlies kunt scha-
len en verdraaien tot je hem definitief omzet naar pixels. Ge-
bruik dus Vrije transformatie (Free Transform, Ctrl+T) om
hem te draaien en links van de boom neer te zetten.

Overzicht

* ok %k

JenniSanders
WERKT MET iz
PSCS2+

BRONBESTANDEN
i;} Opdecd

|

WY Opinternet (gratis)

| .

N R CAEE

I

—
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Workshop Maak een fantasierijk boomhuis

I

Laagmaskers Voeg een laagmasker toe aan beide lagen

/ . door onder in het Lagenpalet te klikken op het rechthoe-
kige pictogram met de witte cirkel erin. Je activeert het masker
Overvloeien enherhalen Zet de overvioeimodus van de van een laag door eenmaal op de maskerminiatuur te klikken. Kies

Fe i R R

bokehlaag op Bleken (Screen), zodat alleen de lichte het Penseel, stel de voorgrondkleur in op zwart en zet de Hardheid
delen van de laag zichtbaar blijven. Dupliceer de laag vervol- dit keer op ongeveer 50%. Schilder hiermee op de maskers over
gens door Ctrl+J te toetsen en gebruik nogmaals Ctrl+T om de de gebieden waar je het bokeheffect wilt verbergen, zoals op de
laag de draaien. Zet hem ditmaal rechts van de boom neer. boomen het gras.

Donkere schadu-
wen Zet jezelf
schrap, want er moeten
nu een boel aanpassingen
gemaakt worden! Maak
om te beginnen een aan-
passingslaag Niveaus
(Levels). Klik daarvoor
onder inhet Lagenpalet
op het zwart-witte rondje.
Sleep de middelste schuif
in het Niveausvenster een
stuk naarrechtsomde
hele afbeelding donkerder
te maken. :

Maskervullen Vul het bijbehorende masker
met zwart, bijvoorbeeld met het Emmertje
(Paint Bucket) en schilder dan met een wit Penseel
op een lage Dekking over de schaduwgebieden van
de boom. Maak op dezelfde manier als zojuist een
aanpassingslaag Curven (Curves).

%77 Lichterehoog-

<+ & lichtenKIlik in het
middenvandelijninhet
Curvenvenster enlaat de
muis niet los, maar sleep
delijn wat omhoog omde
afbeelding lichter te ma-
ken. Vul daarna het mas-
ker met zwart en schilder
met wit op eenlage Dek-
king over de lichtere de-
len van de boom om deze
te versterken.

) Achtergrond verbe-
teren Maak nog
twee aanpassingslagen
Niveaus en stel de middelste
schuifvan de eerste aanpas-
singslaaginop 0,77. Zet bij
Uitvoerniveaus (Output Le-
vels) de rechterschuif op 197.
Zetvandetweede aanpas- Vw13, is de gloed die we straks toevoegen beter
singslaag de middelste schuif zichtbaar. Verberg het grootste deel van de effecten

op 0,48 en laat derest onge- op de boom met maskers, zodat vooral de achtergrond
moeid. wmes @0 wosjemes = «os  endesneeuw beinvioed worden.
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ﬁ,@ Warmerekleuren

Maak een aanpassings-
laag Selectieve kleur (Selective
Color) en pas de verschillende
kleurenaanomde tinten te in-
tensiveren. Deze laag versterkt

Tipvande expert
Snelle raamkozijnen

Uitgehbreide weergave

Selectieve Kewr 130, Parameter automatisch selectesen

lectieve kleur opslaan...

Kieuren: [l Rode tieten -

Mot "4 s | Seectieve Keur herstellen

i Helderheid/contrast
te groentinten, maakt rood don- e e T
S Curven
kerder en versterkt de algehele o o @
warmte en het contrast. Onze 5 o
instellingen kun je laden doorin (@ ey D el Kieurtoonsverzadiging
het venster van Selectieve kleur Lo :
op hetknopje rechtsboven te i 0 Buitenkant kozijn Gebruik de
klikken en te kiezen voor Voor- 9B 8. e Pen om een vorm langs de

instelling laden.Kies dan het
asv-bestandvandecd.

A (A buitenkant van het geschilderde raam

Drempel te maken. Klik om punten te zetten.
Werk vrij grof en vergeet niet het pad
te sluiten door weer op het eerste punt
te klikken.

% ﬁm Meer warmte

4Ll Voegeenlaag
Volle kleur (Solid Co-
lor) toe via de aanpas-
singslagenknop en zet
de overvloeimodus op
Verdelen (Divide) om
de afbeeldingin zijn
geheel warmer te ma- -
ken. Voeg een nieuwe 0

Binnenkant kozijn Begin nu
met het maken van een pad
met dezelfde vorm als in de vorige stap
en sluit het pad weer om de vorm te
voltooien. Samen vormen deze paden
het raamkozijn.

aanpassingslaag Ni-
veaus toe om het ma-
kenvandetrappen
voor te bereiden.

Beginmetdetrap-
,»J&. penZet derege-
Iaars bij Invoer (Input) op
112,0,01en 255 en bij
Uitvoer (Output) opOen
28. Daardoor wordt de
afbeelding extreem don-
ker. Vul het laagmasker

met zwart via Bewerken>
Vullen (Edit>Fill) en ge-
bruik een wit Penseel op
100% Dekking om wat
lijnen in de sneeuwjacht
rechts te tekenen.

ﬁ, Trappenen

deur Ga verder
met het schilderen
van trappentotje de
boom bereikten
schilder daniets wat
eendeur zou kunnen

voorstellen. Begin
met het schilderen

vantraptredeninde
sneeuw links met
een wit Penseel. Kijk

daarbij goed naar de
hoek van de trap,

. ."‘“’"“

aangezien detreden
meer L-vormig zijn.

0 Selecteer en vul Selecteer nu

beide paden door er met het
gereedschap Padselectie (Path Selec-
tion) overheen te slepen. Zet de voor-
grondkleur op lichtbruin, rechtsklik op
de paden en kies Pad vullen>Voor-
grondkleur (Fill Path>Foreground Co-
lor). Klik OK.

O Opties voor overvloeien Te-
ken een kruis in het midden
met dezelfde technieken als hierbo-
ven. Klik op het Fx-pictogram onder in
het Lagenpalet en kies Opties voor
overvloeien (Blending Options). Kies
dan Schuine kant en reliéf (Bevel &
Emboss) en Gloed binnen (Inner Glow).

PHOTOSHOP MAGAZINE
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Raamgloed

o Maak een nieuwe
laag met Ctrl+Shift+N
en begin met het schil-
derenvanramen met
eenlevendige gele kleur
in de natuurlijke inke-
pingenvan de boom.
Voeg wat lichtgeel toe
in het middel, klik op
het Fx-pictogram onder
inhetLagenpaleten
kies Opties voor over-
vloeien (Blending Opti-
ons). Voeg een oranje
Gloed buiten (Outer
Glow) toe en stel deze
inop Bleken (Screen)
eneen Groote (Size)
van 128 px.

Kozijnenmet
structuur Kies in
dit venster Schuine
kant enreliéf (Bevel &
Emboss) met een Diep-
te (Depth) van 348%,
de Grootte (Size) op
109 px en de Hoek (An-
gle) op 30 graden. Voeg
een oranje Gloed bin-
nen (Inner Glow) toe
met de overvloeimodus
op Bleken en 60% Dek-
king. Hiermee geef je
de kozijnen een 3D-
uiterlijk en lijkt het alsof
er licht door de ramen
naar buiten schijnt.

~‘ ) Elfenlampjes Plaats Lamp.psdin
| je werkbestand en gebruik
Ctrl+T om de lamp de schalen, draaien
enbovende deur links te zetten. Maak
hierboven een nieuwe laag en schilder
met geelin de lamp. Voeg de laagstijl
Gloed buiten toe, zodat het lijkt alsof
de lamp brandt.

PHOTOSHOP MAGAZINE

' Dekozijnen Dupliceer de Gloed buiten-
) laag en zet de overvloeimodus op Ver-

delen (Divide). Maak een nieuwe laag en

gebruik de Pen (toets P) om een grove ovaal-
vormen kruislatjes in het raam te maken. Vul

3 Sagachadum | Dekking: i} g
| Rui ) ~ 0 %
oW o BRI
Tachniaki Zchter v
Speidog: |- T
Grootta: {3 i e
wm [jAnt-siased
Bareks oy} 0%
Tetars 1 T

de vorm met Bruin (zie de stappenin het ka-
der hiernaast voor meer uitleg). Rechtsklik op

A 1}

7 @) Meergloed Schilder opde
LD gelegloedlagen die je voor de
ramen hebt gemaakt om een gloed
achter delampen te creéren. Ge-
bruik Ctrl+J om de lagen te duplice-
ren en gebruik Vrije transformatie
om de nieuwe lamp te spiegelen,
draaien enverplaatsen. Dupliceer
enkele malen enverspreid de ko-
pieén helemaal over de boom.

de laag en kies weer Opties voor overvloeien.

>

Baeg, . = =3
i % Meer bokeh Voeg de afbeelding Bokeh2.jpg
Lt toe.Plaats hemlinks, netals de eerste zach-

te bokeh, zet de overvloeimodus op Bleken en voeg

een laagmasker toe om de delen op de boom te

verbergen. Dupliceer, transformeer en zet de kopie

rechts. Pas het laagmasker aan de positie aan.




“% Eenpaar elfjes

& Ganaar http://bit.
ly/Y57Rj3 om een penseel-
set met elfjes te downloaden.
Laad ze viade penseelkiezer
in de Optiebalk en blader
naar het gedownloade be- [
stand. Klik op OK. Je vindt de
nieuwe penselen nu achter-
aande lijst met al aanwezige
penselen. Maak een nieuwe
laag en stempel de elfjes één
voor éénerop. Gebruik de
overvloeimodus Lineair licht
(Linear Light).

(=] ﬁ'-‘ G Ir
= !‘ -
o fx 0 © 3 34§

§ GloedmetdePen Selecteer de Pen

. enmaak een nieuwe laag. Klik met
de Penonder hetelfje links om het eerste
ankerpunt te zetten. Klik in het midden om
een tweede punt te zetten en laat de muis
nietlos, maar sleep om een gebogen pad te
maken. Zet dan een derde puntaande
rechterkant van de boom. Klik met Alt inge-
drukt op de ankerpunten om ze aan te pas-
senals datnodigis.

Vieerinstelingen pensssl

| -

| | | ¥ vormdymamiek &

I | ¥ spreiding &
I structuur &
{}Secundair pensesl  ff
[ Kieurdynamiek | -
JRus 1
T Natta randen &
(| Arbrush &
Veserdraken G|
JStructuur 6|

£

5 ¥ ‘

Penseelinstellingen aanpassen

@ Pak het Penseel en open het Pen-
selenpalet Zet Grootte (Size) op 90 px,
Hardheid (Hardness) op 0% en Spreiding
(Scattering) op 141%. Bij Vormdynamiek
(Shape Dynamics) zet je Grootte jitter
(Sizejitter) op 100%. Open Spreiding
(Scattering) en zet deze op 371%. Zet de
voorgrondkleur op een wit-gele tint. Se-
lecteer nude Pen, rechtsklik ermee op je
pad en kies Pad omlijnen (Stroke Path).

TIP

Mengen met Penselen

Als je veel lagen met Penselen wilt
mengen, wil je dat het resultaat zo
naadloos mogelijk is, dus zonder
harde lijnen of duidelijke randen. De
beste manier om dit te doen is door je
Penseel in te stellen op 0% Hardheid
(Hardness). Maar soms is zelfs dit
nog te hard bij bepaalde aanpassin-
gen. In die gevallen kun je de
Dekking (Opacity) en Stroom
(Flow) aanpassen. Door alle
instellingen laag te houden,
kun je het effect heel nau-
wkeurig en zacht opbouwen.

799 Watmeerstijl In het venster van Pad
m ] omlijnen selecteer je de optie Pen-
seelen zet je een vinkje bij Druk simuleren
(Simulate Pressure). Open de Opties voor
overvloeien (klik op het Fx-pictogram onder
in het Lagenpalet) en kies Gloed buiten (Ou-
ter Glow). Stel de kleur hiervaninop een
oranje-gele tint en zet de overvloeimodus
op Kleur tegenhouden (Color Dodge), Dek-
king (Opacity) op 85%, Spreiding (Spread)
op O en Grootte (Size) op 51%. Klik op OK en
herhaal dit voor een tweede lijn

{) Detailstoevoegen Nuis het tijd om je creatief uit te leven! Zoek

& via sites zoals freeimages.com stockfoto’s van paddenstoelen
(http://bit.ly/1oMWcQp) of gebruik foto’s van jezelf die in een fanta-
siewereld zouden passen. Voeg ze toe aan je werk en gebruik laag-
maskers om objecten uit te knippen.

2 Nieuwe objecteninmengen De paddenstoelen zijn te
4 helder enhebben niet de juiste kleur. Voeg dus boven
de paddenstoelenlaag de aanpassingslagen Niveaus en Cur-
ven toe en stel die donker in. Maak er bovendien uitknipmas-
kers van door Ctrl+Alt+G te toetsen, zodat alleen de
paddenstoelen beinvioed worden. Gebruik verder een war-
me kleuraanpassing. Speel met de aanpassingen tot je fan-
tasieboombhuis af is.
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Workshop Verbluffend landschap
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Verbluffend landschap

Maak een goede foto en werk hem af in Photoshop

eersomstandigheden kunnen
het verschil maken tussen
een mooie of een verbluf-
fende foto.
Verrassend genoeg vormt slecht weer
het beste decor voor een indrukwekken-
de landschapsfoto. De dagen die je liever
niet buiten bent vanwege regen en storm
zijn juist dé momenten om er met de ca-
mera op uit te trekken. Je hebt bij het
typisch Nederlandse weer de kans om
prachtige plaatjes te schieten, want de
bijzondere wolkenluchten zorgen voor de
juiste sfeer.

Wolken zijn bij slecht weer veel interes-
santer dan bij zonnig weer. Een paar uur
voor een regenbui heb je de grootste kans
om prachtige luchten te fotograferen. Het
effect wordt veelal versterkt als je de foto
daarna ook nog omzet naar zwart-wit.

Als je een roodfilter op je lens schroeft,
krijg je een donkerder beeld, verhoog je het
contrast en maak je krachtige monochro-
me platen in Photoshop. Er zijn een aantal
filters beschikbaar, zowel filters die je op
de camera kunt zetten als filters die je
gebruikt in de nabewerking. Filters die je
op je camera kunt schroeven zijn onder
andere uv-filters, polarisatiefilters of de

populaire grijsfilters.

Als de lichtomstandigheden goed zijn, is
het gebruik van een statief niet altijd
nodig, maar het geeft je de tijd om na te

Stapvoorstap Landschappen

Sfeerbepalend Denk na over de
sfeer die je wilt oproepen metje
foto: gezellig, griezelig of luchtig? Zoek
naar elementen in het plaatje die helpen
om hetjuiste gevoel op te roepen. Leid de
aandacht van de kijker vervolgens naar
deze elementen met behulp van zichtlijnen
of pas deregel van derden toe. Voorkom
het fotograferen van uitstralingsloze, open
ruimten, zoals in dit plaatje.

PHOTOSHOP MAGAZINE

Inkaderen Als de lucht bestaat uit
wolkenformaties, experimenteer
dan eens met een beeldkader waarbij
tweederde deel uit lucht en eenderde deel
uit land bestaat. Als de lucht een kleurloos
egaalvlakis, leg de focus met behulp van
de compositie dan op de voorgrond. Ga
tijdens het fotograferen ook eens op de
grond liggen voor een andere invalshoek.

denken over de compositie. Met de juiste
nabewerking kun je de kleine dingen die
niet goed zijn gegaan bij het fotograferen
nog herstellen of verbeteren.

Prachtige landschappen vastleggen met de beste opstelling

Probeer verschillendefilters

Een grijsfilter (neutral density,
nd) maakt de lucht donkerder, je verbe-
tert de belichting ermee en het geeftje
foto meer impact. Grijsfilters zijn verkrijg-
baar in rechthoekige of cirkelvorm, maar
je hebt wel een adapter nodig om een
vierkant filter te installeren. Kijk op je
objectief welke filtermaat je nodig hebt.




Indrukwekkende lucht
Deze foto maakten we met
een grijsfilter. Daardoor is

de lucht relatief donker en

hebben de wolken een

| dramatische uitstraling.

Maak fantastischelandscl
Houdeen paar zakenin gedachtenenleg prachtige taferelen vast

l\appen

Zichtlijnen Muren,
hekjes en (wandel)
paden vormen

| allemaal zichtlijnen
die het oog van de
kijker door de foto
kunnen leiden.

TIP
Wees voor-

bereid

Als je buiten fotogra-
feert, is een goede
voorbereiding het
halve werk. Ga dus

Voorgrondelementen

Zorg dat er interessante
objecten in de voorgrond
aanwezig zijn op verschillende
afstanden tot de camera. Dat
maakt de plaat levendig. Dat
kunnen rotsen zijn, maar ook
bomen, silhouetten of mensen.

goed uitgerust op
pad! Een lenskap
beschermt je lens
tegen deregenen
met een simpele
plasticzak
bedekjeje [ )
uitrusting  \=i-
snel als dat
nodig is.

| Dynamische kleur
{ Experimenteer: zet je foto's
@ om naar zwart-wit en bekijk
B of het resultaat er beter van
i wordt. Als de kleur sfeer-
i bepalend is voor het beeld,
is het natuurlijk beter de
kleuren te behouden.

Kijk uitmet zonlicht De zon kan

2% delichtmetervanije camerain
verwarring brengen en je loopt daardoor
hetrisico dat de foto’s onderbelicht wor-
den. Schakel dus over naar de handma-
tige stand (Manual, M) of laat de zon
buiten het kader. Belicht dan de afbeel-
ding, bepaal het definitieve kader en
maak de foto. Kijk goed uit voor door de
zon veroorzaakte lensvlekken (lens fla-
re), tenzij je deze creatief toe wilt passen.

i Vastbrandpunt De meeste kitlen-

/ zen hebben een zoombereik van
18-55 mm. Daarmee kun je groothoek-
foto's maken die zeer geschikt zijn voor
landschappen. Het aanschaffen van een
groothoeklens met eenvast brandpunt
(primelens) is het overwegen waard. Een
lens met een vast brandpunt biedt door de
degelijke constructie vaak een kwalitatief
goedresultaat.

e

NIKON D3000

B S 1/160 F16 EE1600 85mm
EATO 0, 0 B =D
DSC_0001. JPG

11 NORG
09}7675611 16:14:40 5%

[13872x2592

Histogramlezen Controleer het
histogram na elke opname. Als de
grafiek aan de rechterkant een piek heeft,
is er sprake van overbelichting. Als hijaan
delinkerkant een piek vertoont, is er spra-
ke van onderbelichting. Het perfecte histo-
gramis mooiverdeeld over de hele
breedte.
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Overtrekken en schilderen

Overtrekken
en schilderen

Leer hoe eenvoudig het is om een foto in een vector

te veranderen en hem in te kleuren in lllustrator

p deze pagina’s ga je aan de
slag met twee workshops waar-
in je met behulp van simpele en
leuke technieken van een por-
tretfoto een vectorwerk maakt.
In de eerste workshop werk je met de
functie Afbeelding overtrekken. Hiermee
kun je rechtstreeks op foto's en gescande
afbeeldingen tekenen. Als je zonder dit
gereedschap een foto om wilt zetten naar
vector neemt dat erg veel tijd in beslag,
omdat je dan het overtrekken van alle ele-
menten handmatig moet doen.
In de tweede workshop leer je werken

met Emmertje voor Actieve verf, ook al zo'n
tijldbesparend gereedschap. Het is heel
handig als je veel overlappende complexe
lijnen of vormen hebt waar je een vulling
aan wilt toevoegen. Deze methode is snel,
makkelijk en non-destructief. Het werkt
ook heel goed met foto's, omdat het
gereedschap de delen die je kunt inkleuren
herkent. En net als het Emmertje in
Photoshop kun je meteen beginnen met
kleuren en net zo lang doorgaan tot je
tevreden bent met het resultaat.

Deze technieken worden vaak gebruikt,
omdat je daarmee het werk achteraf

Trek eenfoto over
Van foto naar vector
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E Open lllustrator en maak
een nieuw A4-document op 300 dpi. Ga naar
Bestand>Plaatsen (File>Place) en neem Startfoto.psd van
de cd. Deze afbeelding is ook in Ad4-formaat en 300 dpi, dus
je hoeft hem niet te schalen en te verplaatsen.

oneindig kunt schalen zonder kwaliteits-
verlies. Wil je bijvoorbeeld een heel grote
afdruk van een vakantiefoto, dan kun je
deze methode gebruiken zonder je zorgen
te maken over pixelvergroting of verva-
ging. Verder heb je ook veel creatieve
mogelijkheden, omdat je met kleuren kunt
experimenteren en de foto een heel
andere uitstraling kunt geven. Je kunt in
principe elke foto gebruiken, maar een
foto zonder veel details werkt het best.
Het is namelijk lastiger om grote hoeveel-
heden aan details op te pikken en om te
zetten naar vector.

Maak een back-up van de afbeeldingslaag. Toets
Ctrl+C, maak een nieuwe laag en toets Ctrl+V. Vergrendel de

onderste laag en maak hem onzichtbaar.




Ganaar Ven-

Y ster>Afbeelding overtrekken
(Window>Image Trace). Er zijn diverse
opties, maar we willen wel de juiste hoeveel-
heid details in het eindresultaat.

S @ {2l Bs)
Voorinsteling: | [Standaard] Ivj =
Weergave: [ Overtrekresutast iv] ®
Modus: | Zwartwit il iv

Drempel:
Minder

b Gemvanceerd - - oo -
N Paden: 123
% Ankers: 24

Voorvertoning

@@ Klik op Overtrekken
: (Trace) om de standaard overtrek-
lijnen te zien. De instellingen zijn hierna nog
te veranderen. Als Illustrator waarschuwt

dat deze bewerking lang duurt, kun je dit
negeren.

Omdat de
standaard instellingen niet werk-
baar zijn, gaan we ze aanpassen. Bij Modus
(Mode) kies je Kleur (Color) en de knop Kleu-
ren (Colors) steljein op 5. Hiermee vereen-
voudig je de foto tot vijf kleuren, maar blijven
de gezichtskenmerken zichtbaar.

&8 EHEODD

Fiom
Coten (V] Magnatiacha linen voor curves
DI wenegeren
gy e 07 Hanuren: €
W nar: st

[ veorvartsnng

Derandenvande
= vormen zijn nogal rafelig. Klik in
het palet op het driehoekje voor Geavan-
ceerd (Advanced) om meer instellingen
te zien. Stel Paden (Paths) in op 1% en
laat de andere schuifknoppen staan.

‘In dit voorbeeld
houden we het eenvoudig. Werk
je met een andere foto, zoals een land-
schap, dan moet je waarschijnlijk andere
instellingen gebruiken. Speel gewoon met
deinstellingentot je ziet wat goed werkt
voor jouw foto.
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Overtrekken en schllderen

tapvoorstap Geschilderde foto
NESEER kleurenpa!eten kleur de fotoin

Betnd  Beseten [BBIEE Toor

Transformesen

Ordanen

Sitekens makan

Pad
Patroon

Overdoeien

Perspectief
Adieve vedt

Tekstomicep

Knipmasker

Tekengebieden
Grafiek

@1 denNeem het resultaat van
de vorige bladzude als startpunt enklik op

Uitbreiden (Expand) boven in de interface. Hier- 02 1gen degroepers
mee maak je alle paden bewerkbaar en heb je een te doen voor het ge

Semengesteld pad

Omhutsel vervormen

Afeeidingen overtrekien

Deze stapis optioneel, maar het is wel verstandig om

val je vormen apart wilt verplaatsen of veranderen. Klik

goed startpunt om het portretin te kleuren. op het object en ga naar Object>Degroeperen (Object>Ungroup).

Huidtinten
Keureigenschappen
Keur
Kunstgeschiedeniz
betasl

Natuue

Wijgaan voor een
kleurenpalet dat het
portretineen kleur-
rijk kunstwerkje ver-
andert enniet zozeer
ineen natuurge-
trouw schilderij. In
het palet Stalen
(Swatches) kies je
via het menu de bi-
bliotheek Seizoenen
(Season). Je kunt
natuurlijk ook een
ander bibliotheek
kiezen.

Neutraal
Alle ongebriikte selecteren Patronen
Geselecteerde kieuren toevoegen Standardstalen
Systeem (Macintesh)
Systeem (Windows)

Sorteren op nasm
Sorteren cp type
Zoekveld tonen

FRORNRANANALD AT

R&SPoh

Aardetinten
Fest
Hsitinoen
Kewsisenichippen
Newensoeken
Kunstgeschiedenis
Metaal
Natvur
Nestraaf
Al ongebivikt selecteren Patronen
Geselocteerde ewren toevotgen Standaudstsien
| Systeem (Macekesh)
Systeem (Windows)

Sortersn cp nasm
Sortesen optype

Normale ministuren,
Groteministuren
Keing st ergave

Stualiblitheck cpenen
Stasiibliotheck oplsen sls ASE-
Staaliblctheek opsiasn ais

4 ) n De vectorvormen moeten nu omge-
Q zet worden naar een groep die je kunt overtrekken. Toets
Ctrl+A om alles te selecteren en activeer het gereedschap Emmertje
voor Actieve verf (Live Paint Bucket).
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Verrassing

Tijdens het overtrek-
ken is het altijd goed
om te experimenteren
met de instellingen.
Wees niet tevreden
met de standaard in-
stellingen, maar speel
ermee om interes-
sante resultaten te
krijgen. Een extra vijf
minuten ex-
perimenteren

| kan zomaar

| eenverras-

i send effect
opleveren.

Klik op een kleurstaal in het palet met de
seizoenskleuren en klik daarna op de vormen die je
die kleur wilt geven.




? ‘ Kies

eentweede, com-
plementaire kleur.
Inde vorige stap
begonnen we met
de hooglichtenen
we werken nu via
de middentinten
naar de schadu-
wen toe. Datis een
logische manier
van werken.

Kies de
eerste kleur uit het palet Sta-
len en begin met kleuren met het ge-
reedschap Emmertje voor Actieve
verf. Hetis een goed idee om dezelfde
tinten met gelijke kleuren in te vullen.

Asrdetinten

Feest

Huidtinten
Kleureigenschappen
Kleurenboeken
Kunstgeschiedenis
Metaal

Natuur

Nietwwe eurgroep...

Staal dupliceren

Neutraal o S .
Alle ongebruite selecteren Patranen Basisafbeeidingen  »|  Basisafbecldingen Linen
Gebruikte euren toevoegen Standaardstalen Decoratief | V| Basisafbeeidingen Punten
Sorteren op nssm Systeem (Macintosh) | dingen Structuren
Sorteren op type | Systeem (Windows) ]
Zoekveld tonen [ Tadd
Verlcpen
VisiBone2
Voedsel
Violije
Web

Kleine miniaturen
Normale miniaturen
Grote ministuren
Kieine ljstweergave

Grote ljstweergave Wekcrchop

Staslopties... { ijk
Steunideuren...

Staalbibliothesk openen Andere bibliotheel
Staalbibliotheek opslaan als ASE... T
Staalbibliotheek opsiaan als AL

Omdat we eerder
kozen voor vijf kleuren hebben we
nudrie nog te vullen kleuren over. Eenis voor
de achtergrond en die bewaren we voor het
laatst. Kies nu dus nog twee verschillende Voor de achtergrond kun je een volle kleur kiezen, een
kleuren. Klik met het gereedschap Selecte- verloop of een patroon. Via het menu van het Stalenpalet laad je de patronen
ren (Selection) buiten het canvas om het Basisafbeeldingen punten (Basic Graphics_Dots). Pas een patroon toe met hetzelf-
resultaat te beoordelen. de Emmertjesgereedschap.

Maak het uniek

Zodra je klaar bent met kleuren
kun je verder gaan met je project.
Breid het object uit en degroe-
peer (laatste stap) zodat je elke
vectorvorm apart kunt

In principe is het
kunstwerk nu klaar.
Als je nog verder wilt
experimenteren ga
je, net als eerder,

naar Object> | benaderen. Voeg nu meer
Uitbreiden gevolgd i detai]lctoe, \I/er?nder kleu-
door Object> ren of verplaats vormen

om een compleet nieuwe

Degroeperen. Ver- compositie te maken.

plaats enkele vor-
men voor een
interessant en uniek
eindresultaat.
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De makkelijke manier om Photoshop onder de knie te krijgen
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Stap voor stap

Automatische functies ......oceeeeene. 88
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Kleuren verbeteren .......ccovecveeveennn. 94

Buitende kaders.......coovoveeeeeevenennn.
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Photoshop voor begin

ners Automatische functies

. .
Automatische functies

Gebruik automatische verbeteringsfuncties
om je foto's snel en goed te fiksen

oen Photoshop Ele-
ments 12 werd gein-
troduceerd kregen
gebruikers ineens

Automatische slimme tint... Alt+Ctrl+T
Automatisch slim repareren Alt+ Ctrl+M
Automatische niveaus Shift+ Ctrl+L
Automatisch contrast Alt+Shift+Ctrl+L

Automatische kleurcorrectie  Shift+ Ctrl+B

Automatisch verscherpen

Rode ogen automatisch corrigeren  Ctrl+R

NS

meer mogelijkheden om
afbeeldingen automatisch
te verbeteren.

Daardoor kun je niet alleen
snel licht en kleur aanpas-
sen, maar de vernieuwde
functies onthouden ook veel
beter wat de laatste instel-
lingen waren, waardoor Ele-
ments veel efficiénter je
foto's kan verbeteren.

In Photoshop vind je deze
éénklik-aanpassingen in het
menu Aanpassingen (Adjust-
ments) en in Elements staan
ze onder Verbeteren (En-
hance). Ze zijn ontwikkeld
om contrast, tint en kleur te
verbeteren en dankzij slim-
me algoritmes vinden ze
bijna altijd de juiste instellin-
gen die goed werken op de
afbeelding.

In vergelijking met Pho-
toshop heeft Elements meer
van zulke automatische
functies, zoals Automatisch
slim repareren, Automati-
sche niveau's, Automatisch
verscherpen en Automatisch
rode ogen corrigeren. De tijd
om een reeks foto's te be-
werken kun je dankzij deze
functies zeer sterk verkor-
ten.

In Elements Het aantal
! automatische functies
is meer dan genoeg om
"% verschillende aspecten
¢ van je foto, waaronder
€ kleur, te verbeteren.

Shift+Ctrl+L
Alt+Shift+Ctri+L
Shift+Ctrl+B

Automatische tinten
Autocontrast
Automatische kleuren

Hoe

zitdat?

Belichting De belichting is in
principe de hoeveelheid licht die
op het filmrolletje of de sensor
van de camera valt. Deze wordt
beinvioed door de sluitertijd en
de diafragmaopening. Het foto-
resultaat kun je vervolgens  » 4

weer verder bewerkenin  o°
Photoshop.

gosr.

InPhotoshop De drie opties
in Photoshop helpen bij het
verbeteren van tinten,

contrast en kleuren.
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Automatisch verbeteren in Photoshop Elements
Haal het beste uit je foto naar boven met éénklik

Vet . TOSEPEEY  eam il MBe 2

Automatische slimme tint (Auto Smart Tone) Automatisch slim repareren (Auto Smart Fix)
Sleep de muis over de foto, in de richting van één van de vier Deze optie in Elements is heel handig als je snel een foto wilt
voorbeelden die te voorschijn komen, om de belichting en het verbeteren. De functie houdt rekening met allerlei aspecten,
contrast aan te passen. zoals belichting, contrast, kleur en scherpte.

Automatisch verscherpen (Auto Sharpen) Automatische niveaus (Auto Levels)

Je foto wordt met één klik scherper. Het resultaat is niet altijd Hiermee beinvloed je de belichting. Middentinten, hooglichten
zichtbaar van een afstand, maar als je eerst inzoomt en de be- en schaduwen krijgen meer leven. Ook deze functie kan je veel
werking dan toepast, zie je het verschil. tijd besparen bij de bewerking van je foto.

Verbeter snel tint, kleur en contrast
Deze drie autormatische functies vindje in Photoshop

Automatische tinten Automatische kleuren Autocontrast

(Auto Tone) (Auto Color) (Auto Contrast)

Deze aanpassing werkt goed op fletse Hiermee verbeter je problemen op het Deze functie herkent de helderste en
foto's die een gebrek aan levendigheid gebied van kleur en contrast. Dit is heel donkerste delen van je foto. Daarna past
tonen. Soms is de aanpassing heel groot, handig als je te maken hebt met een hij het dynamisch bereik aan, zodat de
en soms ook niet. blauwe of oranje zweem. belichting overal beter wordt.
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! Maak betere
composities

Als objecten
perfect geselec-
teerd zijn, lopen
de lagen naadloos
in elkaar over. J

Eenvoudigere
selecties Lastige
contouren zijn nu
veel gemakkelij-
ker te selecteren.

{
4

Startfoto

Opdecd
Oefen je selectievaardigheden
~ op de meegeleverde foto's J

.
Perfecte selecties
met Rand verfijnen

/et grove selecties in een handomdraai om in gedetailleerde. Het selecteren
van die vermaledijde fijne haartjes was nog nooit zo eenvoudig

Is je niet de luxe hebt van een groen scherm kan het
selecteren van onderwerpen erg lastig zijn, vooral als
dat onderwerp dunne en fijne randen heeft, zoals
haren, vacht of andere kleine details.
Het gereedschap Rand verfijnen is dan een reddende engel,
want hiermee kun je een grove selectie omzetten in een veel
nauwkeurigere versie. In oudere versies van Photoshop en Ele-
ments heet deze optie Hoeken verfijnen. Rand verfijnen heeft
zes hoofdparameters: Straal, Vloeiend, Doezelaar, Contrast,
Rand verschuiven en Kleuren zuiveren. Straal is de grootte van
de rand rond de selectie waarnaar het gereedschap kijkt voor de
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analyse. Vloeiend verwijdert gekartelde randen. Doezelaar ver-
zacht de hele rand, wat handig is voor onscherpe selecties. Con-
trast verscherpt de selectie, waardoor er vlakken meer solide
worden in plaats van semi-transparant. Rand verschuiven is een
reparatiemiddel waarmee je de selectierand vergroot of ver-
kleint. Kleuren zuiveren verwijdert restjes van de achtergrond-
kleur die is achtergebleven in de selectie. Dit gereedschap is
handig, maar ook vrij lastig om precies goed in te stellen. Helaas
is er geen magische formule voor Rand verfijnen. Het is een
kwestie van spelen met de schuifjes tot je de beste instelling
voor je afbeelding gevonden hebt.



Perfecte selecties met Rand verfijnen Photoshop VOOor beglnners

Losse haart]es Met behulp van Rand verfijnen maak je korte metten met lastige randen
/!

Maak eenselectie Gebruik de
b Veelhoeklasso (Polygonal
Lasso) om een grove selectie binnen
de contouren van het onderwerp te
maken. Als je helemaal rond bent
gegaan, klik je weer op het eerste
punt om de selectie te sluiten. Je ziet

Haekan vertinen X,

e : [)straattonen U
I —

ey 1
=
Druk op £ om de weergaven te doariopen. X4

'Druk op X om atie weergaven tjdeliik ult te schakelen.

ok [ mmaeen |

W &as balkgaje naar Selecteren>
Rand (of Hoeken) verfijnen (Select>
Refine Edge). Hier kun je een weergave
kiezen omte zien hoe nauwkeurig de
selectieis. Voor nu selecteer je de optie
Oplagen (OnLayers) omde transpa-

|_Hoeren ertinan

A

7 3 T] B swsattonen iy
U i) ﬂ [longines tanen )

[ stirnme steaat

Stragi; emmoemeeOen 65 px

Viosiend: Qe Q.

Doezslasn Qom0 px

Contast Qrmmtemmemees 0 %
Ra0d verschuiven: sommmeQmasems G %

[Jxeuren zuiveren
Mate: v

Ui nasc: | See

(Jinstehingen onthouden

PasdeStraalaan Verhoog de Straal (Ra-
dius) tot 65%. Zet een vinkje bij Straal
tonen (Show Radius, toets J). De afbeelding zal
voornamelijk zwart zijn. Zichtbare gebieden zijn
de plekken waar het gereedschap op jachtis naar
eenrand. Houd Alt ingedrukt en schilder zwart op
de afbeelding, zodat het zichtbare gebied dunner
dunner wordt. Gebruik eventueel de Spatiebalk

dan een knipperende lijn verschijnen. rante achtergrond weer te geven. omdoor de afbeelding te schuiven.

[ Hosken vedtinen Hoeken verfinen i — gg"
W .= [swraal tonen Uy o " El [Jstraal tonen 0) J
U m ] ® ) Lel Il Clorigineei tonen @1 Wy
@ [Jslimme straal @ [l slimme straat
it d Straal; (O 65 px W

Strag: emrermmmed(emms g5 px

— Rand

r— Rand

Viosiend: Qs

Doezetaay: Ormmmmmmmmns 00 px
Contrast: (Jmmmmmmmmmmnones 0 %
Rand verschulven: emmmme(mmmenm 8%

Vicelend: s(Jmmmmommmmems 13

Doezelasr: (Jremmmememmmmmeen 00 px

Contrast; emmm{moemmmmeems 35 9%
Rand verchuiven: =meee(Qemees o %

— Vitvoer

Uitvoer naar: Selectie i
[linstettingen onthouden

Blijf verfijnen Schakel steeds met behulp van de J-toets
tussen de weergaven om het effect te controleren. Pas
de penseelgrootte aan met de toetsen[en]. Omeen gebied
zichtbaar te maken, schilder je zonder Altingedrukt te houden.
Vergeet niet dat dit geen selectie is, maar slechts het gebied dat
het gereedschap analyseert. Laat het venster geopend wanneer
jetevreden bent met het resultaat tot nu toe.

utvoer naar: [ Miewne sag met asgmasker v |

[Jinsteitingen onthouden

* Rand/Hoeken verfijnen Nu kun je beginnen met het aan-
=/ passenvan de schuiven. Omdat deze afbeelding vrij
scherp is, verhoog je Vloeiend (Smooth) lichtjes en laat je Doeze-
laar (Feather) ongemoeid. Verhoog Contrast met 35% om
scherpte toe te voegen aan de haren en vink Kleuren zuiveren
(Decontaminate Colors) aan. Stel Uitvoer naar (Qutput To) in op
Nieuwe laag met laagmasker (New Layer with Layer Mask).

Yol atk m =

| Normaal

~]  Dekking: [100% [+]

} Randen verbeteren Toets D om de voor- en achtergrond-

Laagmaskers Er zijn een paar gebieden die nog niet

& & helemaal perfect zijn, dus gebruik het laagmasker om
deze plekken bij te werken. Activeer het laagmasker naast de
miniatuurweergave van de laag en selecteer het Penseel
(Brush, toets B).

& Kleurinte stellen op zwart en wit. Schilder met zwart op de
Iaagmaskergebleden die je wilt verbergen en met wit op de gebie-
den die moeten worden weergegeven. Gebruik de X-toets om snel
de voor- en achtergrondkleur om te wisselen. Schilder door tot
alles perfectis.
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Ingewikkelde details
Eenvoudigachtergronddetails verwijderen

Op het eerste gezicht lijken deze gele bloemen en groene bladeren
tegen een volledig contrasterende, rode achtergrond eenvoudig uit
te knippen. Maar dat valt tegen! Let maar eens op de kleine details
op de knoppen aan de linkerkant, die bovendien enigszins on-
scherp zijn. Maar met het gereedschap Verfijnen

(Refine) is dit geen enkel probleem.

Eenvoudig nitknippen
Verwijder een effen
achtergrond met Rand/
Hoeken verfijnen.

Groveselectie Met de Veelhoek-
lasso (Polygonal Lasso, toets L)
maak je een grove selectie rondom de
bloemen. Zorg ervoor dat de selectielijn
binnen de rand van het onderwerp val-
len, want dan werkt het gereedschap
Rand verfijnen veel beter. Voltooi de
selectie door tot slot weer op het begin-
puntvan de selectie te klikken.

01
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Rand verfijnen Klik in het hoofd-
menu op Selecteren>Rand verfij-
nen. Stel Straal (Radius) in op ongeveer 55
pixels, Vloeiend (Smooth) en Doezelaar
(Feather) op 1vanwege de wazigheid in de
foto, Contrast op 37% en Rand verschuiven
(Shift Edge) op -15%. Zet Uitvoer naar (Out-
put To) op Nieuwe laag met laagmasker
(New Layer with Layer Mask) en klik OK.

Opruimen Rand verfijnen heeft
het werk vrij goed uitgevoerd. Ge-
bruik nu het laagmasker om de gebieden
bij te werken waarmee het gereedschap
moeite had, zoals hetrood tussen de
knoppen. Schilder met een zwart Penseel
over de ongewenste elementen om ze te
verbergen. Schilder je te veel weg, gebruik
danwit om het terug te halen.



Frustrerende pluizige

uitknipsels
Je hoeftdierenincomposities
niet uitde wegte gaan

De veren hebben in deze foto
eenzelfde soort kleur als de ach-
tergrond. Dat veroorzaakt bij het
uitknippen van de uil problemen,
want de gebruikelijke Toverstaf
en Snelle selectie kunnen deze
klus niet aan. Rand verfijnen
komt hierbij dus goed van pas,
want hiermee kun je de rand
handmatig selecteren, zonder
dat je al te nauwkeurig hoeft te
werken. Wanneer een grove rand
eenmaal is geselecteerd, zal
Rand (of Hoeken) verfijnen het
verder voor je Verfijnen!

B EERE o LT

Maak deselectie Gebruik de Veelhoek-
lasso (L) om een grove selectie te ma-
ken door net binnen de contouren van de uil te
klikken. Begin onderaan en ga zorgvuldig he-
lemaal rond. Dubbelklik of klik weer op het
eerste punt om de selectie te voltooien.

Weesslim Ga naar Selecteren>Rand
verfijnen. Verhoog de Straal tot 60-
70% om alle kleine veren van de uil in de se-
lectie op te nemen. Deranden zullen erg
zacht zijn, dus vink Slimme straal (Smart
Radius) aan. Slimme straal probeert de rand
van het onderwerp zelf te detecteren, waar-
door het resultaat nauwkeuriger wordt.

Meer details Om de randen
scherper te maken, ver-
hoog je Doezelaar (Feather) naar
3,5a4 pixels, zet je Contrast op
45-50% om de scherpte terug te
brengen en verlaag je Rand ver-
schuiven naar -5%. Vink Kleuren
zuiveren aan en verhoog het naar
54% om het grijs te behouden.

| Strakkerand Maak

van ingewikkelde
onderwerpen.

nauwkeurige selecties

Verfijnen met maskers Stel Uitvoer

& naar (Output To) in op Nieuwe laag
met laagmasker (New Layer with Layer Mask)
enklik op OK. Als er gebieden zijn die nog niet
perfect zijn, klik je op het laagmasker naast de
laagminiatuur. Schilder met een zwart Pen-
seel (B) over die gebieden om ze te verbergen
enmet wit om ze weer te geven. Pas de pen-
seelgrootte aan met de toetsen[en].
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Foto’s bewerken
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Kleuren verbeteren Photoshop voor beginners

Verbeter dekleur tenmooiere fotoinzes 5tappem

| Automatische slimme firt...
|
| Rutomatisch slim repaceren

At Ceri+ M

Automatische niveaus ShiftsCerieL |
| Automatisch contrast  AlteShifts Ctrlel |
futomatische kleurcorectie  Shifts Ctrl+B

Automatisch verscherpen

Rode ogen automatisch corrigeren  Ctrl+R

Schaduwen/hooglichten...
Hdﬁefhed!(untrzst.
Omzetten in zwart-wit... -

Onscherp masker...
Scherpte aanpassen...
Photomerge ..

kleuren kan gebruiken in Elements.
Actlveer de modus Expert. Inonze fotois het
koraal flets en halfdonker. Daarom gaan we

eerst naar Verbeteren>Belichting aanpassen>

Niveaus(Enhance>Adjust Lighting>Levels).

Kleuren wisselen Ga opnieuw naar
Verbeteren, maar kies nu Kleur
aanpassen>Kleurtoon/verzad|g|ng aan-
passen (Adjust Colors>Hue/Saturation).
Met knop Kleurtoon bepaal je het bereik
vandekleureninde foto. Een kleine aan-
passing hierin kan al grote veranderingen
opleveren. Met Verzadiging pas je de inten-
siteit van de kleuren aan.

Openen Open een foto die wel sterkere

NiveausaanpassenIn het nieu-
we venster selecteer je het
zwarte pipet. Klik hiermee in een deel
van de foto dat diepzwart moet zijn. Wij
kliktenin een donkere schaduw. Je ziet
meteen verandering in de donkere
delenvan de foto.

Kleurcurven Open nu via hetzelf-
de menu Kleurcurven aanpassen
(Adjust Color Curves). Indit venster zie je
eenvoorvertoning en het resultaat. Links
onderinvind je voorinstellingen en met de
schuifknoppen kun je het resultaat ook
aanpassen. Daarnaast kun je ook de curve
rechts onderin verslepen.

HelderderKlik op OK en ga naar
Verbeteren>Belichting aan-
passen>Helderheid/contrast (Bright-
ness/Contrast). Er opent een venster met
twee knoppen waarmee je de helderheid
en het contrast van de foto kunt aanpas-
sen. Verschuif de knoppen naar eigen
smaak en klik op OK.

Details fixen Om de kleuren op

\ specifieke delen te bewerken ge-
brwkje het gereedschap Spons (Sponge).
In de Optiebalk selecteer je Verzadigen
(Saturate). Met de knoppen[en]opje
toetsenbord pas je de grootte van de pen-
seelpuntaan. Nu schilder je over de delen
die extra verzadiging kunnen gebruiken.

Schaduwen/hooglichten (Shadows/Highlights)

Hiermee heb je extra bewerkingsmogelijkheden

Details tonien Met de
knop Schaduwen
lichter maken (Lighten
Shadows) maak je
details in de donkere
delen zichtbaar
doordat de schaduw
lichter wordt.

Schaduwen lichter maken: - %

Gloed verminderen
Hooglichten donkerder
maken (Darken
Highlights) vermindert
de heldere delen,
waardoor je details in
overbelichte delen
ziet. Uitgebeten (puur
witte) delen kun je
echter niet verbeteren.

@ Meer informatie over:

Zien wat je doet
Houd Voorvertoning

schaduwen/hooglichten

* Hooglichten donkerder maken: @

(Preview) aange-
vinkt, zodat je het
" resultaat van een
aanpassing aan de
knoppen meteen
kunt beoordelen.

! Tussenlicht en

donker in Deze

knop, Contrast

. middentonen

 (Midtone Contrast),
gebruik je om het

~ verschil tussen licht

en donker in de

middentinten te

bewerken.
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Startfoto’s

AP i

Haal de foto’s van de
cd en probeer het zelf!
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Het buiten-de-kaderseffect Photoshop voor beginners

Het buiten-de-kaderseffect

Denk je dat het uren kost om het onderwerp van je foto eruit te laten
springen? Met Photoshop Elements is het een kwestie van tien minuten!

n de modus Met instructies vind je snelle en eenvoudige
manieren om geavanceerde fotomanipulaties te maken.
Maar wat het nog bijzonderder maakt, is de nabewerking in
de modus Expert. Hier kun je lagen aanpassen en toevoegen,
gereedschappen zoals penselen gebruiken en nog veel meer.
Het is niet zo moeilijk als het klinkt. Met de foto's van de cd
en de stappen op deze pagina'’s laten we zien hoe je eerst het

Buiten-de-grenzeneffect in Elements toepast voordat je verder
gaat in de modus Expert. Hierin voeg je twee resultaten samen

en bewerk je ze, zodat er een interactie tussen de twee ontstaat.
Dit trucje kun je op veel verschillende afbeeldingen toepassen,
zoals familieportretten, foto's van huisdieren, dynamische spring-
foto’s of foto's van bewegende elementen. Nadat je de technieken
hebt geleerd, is je eigen verbeelding de enige beperking!

Ma {beweeg de muis om Yoor 1= Zien)

Tips:

13. VERPLAATS het frame deor de
hoek te slepen.

1b. POSITIONEER het frame

en een deel buiten het frame valt.
1c. TREK het frame SCHUIN door

de hoeken van het frame te slepen.
Khik op het groene vinkje om te.
bevestigen.

1d. Pas de BREEDTE van het frame.
aan doer de hoekgrepen te slepen.
Kiik op het groene vinkjz om te
bevestigen.

Opendefoto’s Start Elements
in de modus Met instructies
(Guided) en open de foto's Bloem.jpg
en Slang.jpg van de cd. Via Venster
(Windows) activeer je Slang.jpg en
rechtsindeinterface ga je naar
Fotoplay>Buiten-de-grenzeneffect
(Photo Play>0ut of Bounds).

KaderbepalenKlik op Frame toe-
voegen (Add Frame) en er ver-
schijnt een soort selectiekader. Met de
handgrepen op de hoeken bepaal je de
grootte. Versleep ze terwijl je Ctrl+Shift+
Altingedrukt houdt om het kader schuin
te trekken. Met een klik op het groene
vinkje leg je deze bewerking vast.

1 Frame toevoegen {

Ctri+Alt+Shift ingednuid te houden en |

Ka (bewesg de mus om Voor te zien)

| Tios:

| 13. VERPLAATS het frame door de
hoek te slapen.

- | en een desl buiten het frame valt.

1c. TREK het frame SCHUIN door
Ctrl+&it+Shift ingedrukt te houden en
de hoeken van het frame te slepen.
Klik op het groene vinkje om te
bevestigen.

1d. Pas de BREEDTE van het frama
3an door de hoekgrepen te slepen.
Klik op het groena vinkje om te
bevestigen.

Selecteer het uitstekende deel Klik dan
op Het gereedschap Selecteren (Selec-
tion Tool). Schilder hiermee over de kop van de
onderste slang die straks buiten het kader zal
vallen. Je kunt navigeren met de gereedschap-
pen (het handje en de loep) die je linksboven
ziet. Heb je te veel geselecteerd? Schilder er
danoverheen terwijl je Alt indrukt.

Gebruik het gereedschap Selecteren
om het gedeelte van de afbeelding te
selecteren dat u uit het kader wilt
laten steken.

Als uw selectie klaar is, stelt u het
Buiten-de-grenzeneffect in.

t&. E Achtergrondverloop to...

Woeg een achtergrondverloop toe om
het effect te vergroten.

5. Woeg schaduw toe:

s JL2 T

Klein Normaal

Groot

Voeg diepte aan de afbeelding toe
door een geschikte schaduwgrootte
te kiezen.

| DegrensAlsje klaar bent, klik je op Buiten-de-grenzeneffect (Out
= of Bounds Effects). Je ziet meteen het kader met de slang die eruit
steekt. Daarnavoeg je met de laatste twee knoppen een eenvoudig verloop

toe enkies je als schaduwoptie Normaal (Medium). Dit ga je later nog
aanpassen. Klik op Gereed (Done).

* Debloem Slaje werk op als Slang.psd en open

via Venster de foto van de bloem. Herhaal de

voorgaande stappen. Zorg ervoor dat stukjes van de
bloemblaadjes links buiten het kader vallen.
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Photoshop voor beginners Het buiten-de-kaderseffect
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werk op als psd-bestand.

0 8 Foto’s samenvoegen Klik op

de afbeelding met de slang.
Activeer de bovenste drie lagen door
er met Shiftingedrukt op te klikken.
Kies dan het gereedschap Verplaat-
sen (Move) en versleep de lagen naar
hetlege canvas.

Eenblik op het effect Dezeinterface neemtje stap voor stap mee

Dezelfde stappen Ook nu voeg je een eenvoudig ver-
loop toe en kies je een normale schaduw. Maak je
geen zorgen als je nog steeds wat groen ziet rond de uitste-
kende bloemblaadjes. Dat gaje later corrigeren. Sla ook dit

ExpertActiveer de modus Expert. Ga naar Bestand>Nieuw>
Leeg bestand (File>New>Blank File) en maak een nieuw can-
vasvan 240 x 300 mm en 300 dpi. Er zijn nu drie bestanden open.
Klik onder in het venster op Lay-out (Layout) en kies Kolommen en

rijen (Columns en Rows) om alle bestanden te zien.

-] oekkng: [T 1~

© Meer nformatie over: Lagstijen

Debloemen In het nieuwe bestand
verschijnen de drie lagen, alledrie

0,

actief. Met het kader dat om de afbeelding
verschijnt kun je de slangenfoto verkleinen.
Herhaal dit met de bloemenfoto. Zorg dat de
lagen met de bloemin het nieuwe bestand
onder de slangenlagen staan. Sla je werk op.

Snel Expert

[ Voorvertoning

| Betchtingshook; ri) m e ]
| B s i
|

1 Realistische schaduw Je kunt de slan-
gen- en bloemenfoto’s nu sluiten. Se-
lecteer de slangenlaag met het masker in het
nieuwe bestand. Dubbelklik op het fx-symbool.
In het venster dat opent maak je de Grootte
(Size) en Afstand (Distance) groter en verlaag
je de Dekking (Opacity). Herhaal dit bij de an-
dere drie lagen waar je ook zo'n fx-teken ziet.

Weergave kiezen Selecteer hier

& & D am

Fotovak - Gersedschanscoties- Onadaan maken Opnisuw  Roteren Oranar
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wat je wilt zien; de startfoto,
het resultaat of allebei tegelijk.

~
Beginmet hetkader Je krijgt

Dbl kb een basisrand als kader. Dit
kun je in de Expertmodus
veranderen of verfraaien.

1a. VERPLAATS het frame door de

hoek te slepen.

1b. POSITIONEER het frame

ey

deel buiten het frama valt.

i e

A L e R

bevetigen Met de hand selecteren )

oo e e b Het gereedschap waarmee je

Pty chdtald de beeldelementen selecteert

2. O\ Het gereedschap Sele...

Gebruik het gereedschap Seletteren

om het gedeelte van de afbeelding te

selecteren dat u uit het kader wilt
steken.

die buiten de grenzen moeten
vallen is heel gemakkelijk in
gebruik.

e g

Klik en klaar Zodra Elements
alle relevante informatie heeft,
kun je op deze knop klikken om
het effect toe te passen.




vaangy Wedkstand butsnkaderpid @ 152% (askd, Laaomadies) *[[Normaal ] Dekking: [100% [+
‘;:"f“ ® Inside Photo !
v &
e i+
“* u s
Y 1]
=
er-‘
4 55 i
L .
el B - el ﬁ 3 Kieseenachtergrond Activeer de on-
E. MaskerverfunenJe kunt nude 12 Netteranden Schllder over de slor- derste Achtergrondlaag en kopieer de
selecties die je eerder maakte ver- dige, donkererandjesomzetever-  achtergrondfoto van de cd naar het werkbe-

beteren. Activeer het laagmasker (de bergen. Met wit kun je de afbeelding juist stand om je werk te vervolmaken. Je kunt
zwart-witte miniatuur) van de bloemen-  tevoorschijn halen. Herhaal deze techniek ook denken aan een verloop als achtergrond,
laag. Zoominop derandenkiesinde met het laagmasker van de slangenlaag. een effen kleur of een combinatie daarvan,
Gereedschappenbalk het Penseel Let erop dat je de laagmaskerminiatuur terwijl je van de bovenste laag de Dekking
(Brush) met zwart als voorgrondkleur. activeert en niet de laagminiatuur! vermindert. Net wat jij mooi vindt.

— /”;rm

. Een nieuwe achtergrond
Zo geefje het ;_ Prﬂbeer eens eeg realllstl
H sche achtergrond, zoals een
effec;t iets foto. Voeg hierboven een
extra's laag met een effen kleur toe,

gecombineerd met een
overvloeimodus om de kleur
te veranderen.

Het is belangrijk om

te experimenteren.
Probeer verschillende
achtergronden en
kleuren voor verschil-
lende resultaten. Zodra
je goed overweg kunt
met deze techniek kun
je proberen elementen
toe te voegen. Het
Buiten-de-grenzenef-
fect werkt bijvoorbeeld
heel goed met wateraf-
beeldingen. Combineer
dit met waterpenselen
(die je online kunt vin-
den) om fantastische
werken te maken. On-
dertussen leer
je waardevolle
Photoshop-
trucs en -tech-
nieken.

= Llementen verwijderen
Je kunt delen van de

¢ compositie ook verwijderen
door ze uit te gummen met
het Gummetje (Eraser)

Wees creatief Een andere
achtergrond kan een heel
andere sfeer geven.
Experimenteer met
verschillende stockfoto's.
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Afbeeldingsresolutie

Hoe zit het nou eigenlijk met die pixels? Hier leer je er het fijne over

fbeeldingsresolutie zegt iets

over de kwaliteit en de grootte

van een foto.

Het wordt vaak gemeten in pixels
per inch (ppi, bij beeldschermen) of dots
per inch (dpi, bij prints) en beschrijft het
aantal beeld- of inktpuntjes per vierkante
inch. Hoe meer puntjes er op zo'n vier-
kante inch passen, hoe hoger de resolutie
van een foto is en hoe beter (of scherper)

PHOTOSHOP MAGAZINE

de kwaliteit. Hiermee neemt ook de be-
standsgrootte (in MB) toe.

De resolutie heeft ook te maken met de
afmetingen van een afbeelding. De afme-
tingen én het aantal pixels per inch kun je
veranderen via het palet Afbeeldings-
grootte in Elements en Photoshop. Een
reden om dat te doen is om de afbeelding
kleiner te maken, zodat je hem makkelijk
online kan delen. Want hoe kleiner de be-

© Ben Fredericson

standsgrootte, hoe sneller je de foto kunt
mailen of up- en downloaden. Een andere
reden is dat je meer pixels wilt creéren
dan het origineel bevat, zodat je een gro-
tere print kunt maken. Beide bewerkingen
hebben zo hun nadelen; je wilt de te delen
foto niet zo klein maken dat je niet meer
ziet wat er afgebeeld wordt. Aan het erbij
verzinnen van pixels zit ook een grens,
omdat je dan wazige foto's krijgt.

J Hoe
zit dat?

o Ppien dpi In de meeste branches
. wordt gesproken over pixels per inch.
« Dit verwijst naar het aantal beeldpunten $
E in het digitale bestand, waardoor de

printer weet hoeveel inktpuntjes hij

. het papier moet zetten. Hoe dichter

5 de punten op elkaar zitten,

., hoe hoger de resolutie -

per vierkante inch (dots per inch) op _-'

.. en hoe scherper de .
SO print oogt. o*




Het venster Afbeeldingsgrootte /o verk e metdeinstellingen

De huidige afmetingen
Onder Pixelafmetingen
(Pixel Dimensions)

zie je hoeveel pixels

de afbeelding bevat.
Deze waarden veran-
deren wanneer je

nieuwe beeldpixels gaat
berekenen en de opties
bij Documentgrootte

Fysieke grootte
Bij Document-
grootte zie je de
hoogte en breedte
van de afbeelding.
Je kunt hier kiezen

(Document Size)
aanpast.
Breedte: 1920
Hoogte: 1081
— Documentgrootte
In verhouding

Breedte: M | m

Als je Laagstijlen (Layer
Styles) hebt gebruikt, is
het verstandig de optie
Stijlen schalen (Scale
Styles) aan te vinken.
Sommige stijlinstellingen
zijn namelijk afhankelijk 3

van de documentgrootte L0

en resolutie en moeten Stijlen schalen

His oolrveranderaimale Verhoudingen behouden
Nieuwe beeldpixels berskenen:
A

Hoogte: 9,15 cm

Resolutie: 300 pixelsfinch

je de omvang aanpast.

Kwaliteit behouden

Vink Nieuwe beeldpixels berekenen (Resample
Image) aan als je wel de grootte en/of breedte
van het document wilt aanpassen, maar niet
de resolutie. In het menu hieronder kies je op
welke manier Photoshop de pixels erbij moet
verzinnen. Hierbij wordt uitgelegd in welke
situatie je welke optie het beste kunt kiezen.

e ——

of je deze waarden
in procent, inch,
centimeter, milli-
meter, punten of
pica’s wilt bekijken.

( Automatisch aanpassen
Wanneer je de optie Verhoudingen be-

| houden (Constrain Proportions) aan-

| vinkt, verandert de hoogte automatisch
als je de breedte aanpast en vice versa.
Zo voorkom je uitgerekte beelden.

Debesteinstellingen Controleer enbewerk deresolutie

Breedte: 1919

Hoogte: 1080

i i
Sccthekn | |
- — Documentgrootte I
- | SEEEL Pt et o bk
@ Breedte: 67,7 cr
Netwerc Hoogte: 58,1 cm

| | Resotie: 72 pxelyinch -

[ stjlen schalen
[l verhoudingen behouden
[C]Nieuwe beeldpixels berekenen:

: 1 Bicubisch (meest geschikt voor vioeiende verlopen}

Vergroten Ga naar Afbeelding>

| Maakeenkopie Open een
eigen foto (in Elementsinde
Expert). Slahem eerst op,
want na een verandering kun je niet
meer terug naar de beginwaarden.
Door hem op te slaan onder andere
naam of Als kopie (As a Copy) houd
je het origineel intact.

Afbeeldingsgrootte (Image>Image Size)
in Photoshop of Afbeelding>Vergroten/verklei-
nen (Resize)>Afbeeldingsgrootte in Elements. In
het nieuwe venster zie je bovenin de pixel-
afmetingen en onderin de documentgrootte. Op
dit moment is deze foto zo'n 68 bij 38 cm met
eenresolutie van 72 ppi. Met de vakjes ernaast
verander je de eenheden.

Breedte: 1919

[ Annyieren ]
Automatisch... | ff

Hoogte: 1080

Breedte: 1625  cm

Hoogte: 3,14 -

B

Ol | Resohte: B | pmeinch

| (3 stylen schaien
| (1 verhoudingen behouden
[Tinieuwe beeldpixels berekenen:

I [‘Bicubisch (meest geschikt vaor vioeiende verlapen)

Resolutie veranderen Verander de
' waarde bij Resolutie (Resolution)
van 72 naar 300. Met deze resolutie kun

je de foto printen. Je ziet dat de hoogte en
breedte van de foto veranderen als je de
resolutie hebt aangepast. Dat komt door-
dat het aantal pixels nu op een kleiner
oppervlak wordt geperst. Hiermee be-
houd je dezelfde scherpte bij het printen,
maar worden de afmetingen dus kleiner.
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Nikon1V3

102

i=ca.€975

www.nikon.nl

ook hdr-foto’'s maken.

Foto's zijn goed belicht.
Met de optie D-Lighting
| verbeter je het dyna-
L\misch bereik. Je kunt

Info

Nikon

« Specificaties

* Megapixels:18,4

» Max.resolutie:
5232x3488

»Sensor: CXCMOS

* Sluitersnelheden:
30s-1/16000s, bulb

SO gevoeligheid:
160-12800

* Opslag: microSD,
microSDHC, microSDXC

*Lcd: 3-inch,
1.037.000 pixels

« Zoeker: optioneel

Dezenieuwste Nikon1
camerakan zichmetzijn
concurrenten metenqua
uiterlijken prestaties. De
sensorisminder goed,
maardecameraiserg
compact.

Oogvoo I Met de
meegeleverde 10-30 mm

zoomlens maak je

scherpe en gedetail-
leerde foto's.

Nikonl1lV3

Drie keer is scheepsrecht: is dit de beste Nikon 1 tot nu toe?

e Nikon 1-camera’s zijn de snelste came-
ra’'s tot nu toe. Daarmee zijn ze perfect
voor sportfotografen en wildlifeliefheb-
bers.
De V3 doet de Nikon 1-naam eer aan. Hij kan twin-
tig foto's per seconde maken op volledige resolutie
met fulltime autofocus. Als je zelf een scherpstel-
punt vastzet, kan de camera zelfs tot zestig foto's
per seconde schieten. Bovendien heeft het hy-
bride scherpstelsysteem van de Nikon 1 een

fraaie upgrade gekregen: hij heeft nu 171 scherp-
stelpunten. Daarvan zijn er 105 bedoeld voor de
fasedetectie die je onderwerp zoekt. De overige
zijn voor contrastdetectie. Hierdoor is de V3 snel-
ler dan andere camera's in omgevingen met matig
licht en bij het volgen van snelbewegende onder-
werpen.

De foto’s zijn haarscherp en ruisvrij tot ISO 1600.
Bij ISO 3200 zijn de foto's nog prima bruikbaar. De
belichting en kleur zijn goed uitgebalanceerd in

¢ ! 1 Je kunt het Icd-scherm
kantelen zodat Je vanuit vreemde standpun-
ten kunt fotograferen Stel scherp met het

touchscreen.
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i ' De V3 heeft geen elektroni-
sche zoeker Deze kun je als extra accessoire
aanschaffen en op de camera bevestigen

1 < Een moduswiel bovenop de
camera geeft toegang tot snelle aanpas-
singsmogelijkheden. Daar vind je ook de
aan-uitknop.



omgevingen met daglicht, hoewel de kleuren
een beetje flets zijn. Ondanks de kleine
l-inchsensor is er een mooie hoeveelheid
details waar te nemen in de foto’s.

De Nikon 1V3 heeft een draaiwiel op de
achterkant en de bovenkant waarmee je

de sluitertijd en het diafragma snel kunt
instellen bij het handmatig scherpstellen.
Bovenop de camera vind je een moduswiel
waar je de gangbare P, A, S, M-modi aantreft.
Je kunt ook filmen met 120 fps op 720p of in
een automatische stand. Ook mogen de
modi Bewegingssnapshot en het unieke
Beste Moment Vastleggen niet ontbreken. De
laatstgenoemde blijft foto’s schieten als je de
ontspanknop half indrukt, waarbij je de actie
in slowmotion ziet op het Icd-scherm. Zie je
een mooi moment, druk je de knop helemaal
in en wordt de foto opgeslagen.

Dankzij het lcd-scherm met een indrukwek-
kende resolutie van 1.037.000 pixels kun je de
gemaakte foto's goed beoordelen. Je kunt het
scherm bovendien naar voren trekken en naar
onder of boven kantelen voor het fotograferen
vanuit rare standpunten. De Nikon 1V3is
uitgerust met een gevoelig touchscreen,
waarop het terugkijken van je foto's heel intuitief
verloopt. Je bedient het scherm net als op je
smartphone. Het nadeel van enkel een Icd-
scherm is duidelijk: in omgevingen met helder
licht kun je niet alles even goed zien. De optio-
nele zoeker kan in die gevallen uitkomst bieden.
In tegenstelling tot de Nikon 1 V2 heeft deze
versie namelijk geen ingebouwde zoeker. Via wifi
kun je de camera koppelen aan je smartphone of
tablet.

De V3 moet het niet alleen zonder ingebouwde
zoeker doen: ook de grip heeft het moeten
ontgelden. Hierdoor ziet hij er meer uit als een
systeemcamera en lijkt hij minder op een DSLR.
Die ontwikkeling zal hem ongetwijfeld meer fans
opleveren. De camera heeft overigens nog wel
een ingebouwde pop-upflitser en een accessoire-
schoen voor een optionele zoeker of flitser.

Naast deze accessoires wordt er een toene-
mend aantal lenzen voor de Nikon 1 ontworpen.
Momenteel zijn er dertien verschillende objectie-
ven beschikbaar. Deze variéren van een 10 mm

“ Ondanks de Kleine linchsensor is er een mooie
hoeveelheid details waar te nemen in de fotos =

f2.8 pancakelens tot de forsere 70-300 mm f4.5-
5.6. Bij de Nikon 1V3 krijg je standaard de 10-30
mm f3.5-5.6 zoomlens geleverd. Als de camera is
uitgeschakeld kun je het objectief mooi compact
in elkaar schuiven. Zoomen gaat makkelijk via

de zoomring. Wil je handmatig scherpstellen,
dan moet je het menu induiken. Daar vind je de
optie Scherpstelstand, waar je kunt kiezen voor
MF (handmatig scherpstellen). Met het draaiwiel
maak je nu aanpassingen. Dat is een redelijk
omslachtige manier van werken, die je overigens
bij alle Nikon 1-objectieven moet gebruiken.

Op alle andere vlakken is de V3 erg efficiént en
praktisch. De beeldkwaliteit is indrukwekkend en
dankzij het weglaten van een anti-aliasingfilter
geweldig scherp. De vraag is welke invloed het
weglaten van de zoeker heeft op potentiéle
kopers.

Met de meegeleverde
10-30mm zoomlens maak
je scherpe en gedetail-
leerde foto's.

Foto's zijn goed belicht.
Met de optie D-Lighting
verbeter je het dynamisch
bereik. Je kunt ook
HDR-foto's maken.

pac v Het ontwerp is iets aangepast
ten op21 hte van de V2 en de grip is kleiner. Er
is een optionele grip met ontspanknop
leverbaar.

mm meegeleverd maar er zijn genoeg
andere opties verkrijgbaar.

= De V3 krijgt een veelzijdige 10-30

Aanpa " Achter op de cameravind je twee
mstelbare functletoetsen Hiermee kun je de
camera naar wens aanpassen.
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15 $50

reFine |

Het programma reFine bewijst dat je niet alles hoeft te verscherpen
om details in je foto versterken

Info

Digital Film Tools

* Windows Vista +

*MacOS X10.6 +

* Adobe Photoshop CS3 +

+ Adobe Photoshop
Elements6 +

7’0

Natuurlijk wilje zoscherp
mogelijke foto's, enreFine
kanje daar bijhelpen.De
grotehoeveelheid extreme
encreatievefilterszijn
minder goed bruikbaar.

PHOTOSHOP MAGAZINE

et programma reFine van Digital Film

Tools is ontworpen om je foto’s scher-

per en gedetailleerder te maken.

De effecten zijn gegroepeerd en je kunt ze
met goed doordachte instelmogelijkheden aan-
passen. De software is te koop als plug-in voor
verschillende programma'’s, zoals Lightroom, Pho-
toshop en Aperture. We ontdekten al snel dat we
met die programma'’s eenzelfde resultaat konden
bereiken.

Het programma biedt de mogelijkheid om delen
van je foto te maskeren, waardoor het effect
plaatselijk wordt toegepast. De lagenfunctie is erg
bruikbaar en geeft je ruimte om effecten te
combineren en te stapelen. Je bent dus niet
afhankelijk van één filter om het gewenste
resultaat te bereiken.

De schuifknop Detail is het geheime wapen van
deze plug-in. Je kunt daarbij kiezen uit Coarse,
Medium en Fine om zowel grove texturen als fijne
details te verscherpen. Daarnaast heb je invioed
over de scherpte en de gloed rondom de randen.

I www.digitalfilmtools.com

Als je zoekt naar een manier om je foto's te
verscherpen kun je net zo goed aan de slag met je
fotobewerkingsprogramma. ReFine heeft echter
een paar creatieve opties die vooral bij foto's met
een lage resolutie erg handig zijn.

Me ming Geef wolken een sterke HDR-uitstraling
met de verscherpmgsﬂlters en detailschuiven.
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PhotoDirector 6 Ultra Heview

www.cyberlink.com

PhotoDlrector 6 Ullra

Wat maakt deze fotobewerker zo'n verstandige keuze?

et is een lastige markt voor softwarepro-
ducenten. Programma's worden steeds
goedkoper, beter en veelzijdiger, waarbij
koplopers als Phase One, Adobe en DxO
Labs telkens nieuwe revoluties ontketenen en
hun software versnellen. Dankzij al die ontwik-
kelingen profiteer jij als consument natuurlijk
van een groot gebruiksgemak en een ontzettend
hoge snelheid.
Ook CyberLink heeft met PhotoDirector 6 een heel
overzichtelijk en veelzijdig programma gemaakt. Er
zijn drie versies, waarbij de meest eenvoudige ver-
sie verwarrend genoeg PhotoDirector 6 Deluxe
heet. De meest uitgebreide is de PhotoDirector 6
Suite, waarbij je ook een videobewerker krijgt gele-
verd.

Wij gingen aan de slag met het middelste pakket,
PhotoDirector 6 Ultra. Deze versie is het meest
gericht op ervaren fotografen. De leukste functie is
de Face Swap. Daarmee kun je het ideale familie-
portret maken uit verschillende foto's. Er is ook
een Skin Tone aanpassingsgereedschap waarmee
je portretten verbetert, en een Radial Filter voor

het aanpassen van specifieke elementen in je
foto's. Foto's samenvoegen gaat trouwens ook heel
prettig met de Photo Composer en voor het maken
van panorama's heeft het programma een speciale
Panoramafunctie. Beide functies gebruiken
Content Aware-technieken om lege plekken op te
vullen.

De verschillende onderdelen van de software zijn
verdeeld over een aantal tabbladen. Daardoor
schakel je snel over vanuit de Library met je
verzameling foto's naar de Print-interface. Met de
tabbladen Edit en Adjustment kun je alle denkbare
aanpassingen maken, eventueel via een laagmas-
ker. Je kunt die gemaakte bewerkingen kopiéren
en over andere foto's plakken. Er zijn geen
bewerkingslagen zoals in Photoshop, maar er is
wel een History waarin je alle aanpassingen kunt
terugzien.

PhotoDirector 6 Ultra heeft de belangrijkste
bewerkingsmogelijkheden in huis, plus een paar
extra. Het programma is snel, krachtig en geschikt
voor ervaren fotografen. Natuurlijk kun je ook
gewoon raw-bestanden bewerken.

Info
CyberLink

* Windows Vista +
*Mac0S X10.6.8+

8,0

Eeneenvoudige fotobewer-
kerwaarmeejeinenkele
minuteneenmooiresultaat
maakt. Hetprogrammais
ook schappelijk geprijsd.
Wijradenhetje zekeraan.

Met Ph&oDﬁéctor 6
Ultra kun je raw-
| bestanden bewerken.

~. @ Deinterface lijkt erg

‘B op dievan Lightroom.
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Helpdesk
Photoshop & Elements

» ot
Hebje prangende :
Photoshopvragen?
Wij steken je een
helpende hand toe!

Watvindjeop

dezepagina's?
VRAAG&

/ ANTWOORD

\\ over beeldbewerking

Wij spitten al je vragen
: uit. Tot op de bodem!

OPLOSSINGEN

Met voorbeelden en
tips om het nog duide- PhOtOShOp

lijker te maken

D€ . > H OLO DD €€ dll O USIUQ DEICE E
STUURIJE oD die - T QO nhnde ate areld NATO
VRAGENNAAR:
helpdesk@ ) 0an Jaspe
photoshopmagazine.nl
/ aak o e beg en ee euwe laag en breng daa oeimod eb ook ee asker en be de
Stuur je een voorbeeldfoto een aonke e pla erloopopaan.D e aat plaatse et een za art Penseel om de
mee? Dan kunnen we je vraag achtergrond. Plaats de foto met de tram (op de cd eflectie e dde de baar te make
makkelijker beantwoorden en electeer de 3 er de gebo " et biivoo Dubliceer de laao cer de kopie ve aal o
maak je kans je vraag terug - = 5
te zien in Photoshop Magazine Deelid OSKIaSSOAFOLYE0Nal La>50 2 d REWETRG drisIorinatie=ve ddl ormaraale
Delete. Open de aanpa g Kleurtoo erzadiging d a 0 p Ve al) en positioneer deze
e/Saturatio e e et kle eflectielaag op de aat. Voeg eer elemente
DEEXPERTS olorize) aa ersleep de regelaa odat je we o€ zoa en, een haai e aterplanten om de
Joseph Ahmad, Amro Ashry, ee O0le groenblauwe g electeer vervo cer e benaad e OeK o € naar bubpIe D
Sara Biddle, Kirk Nelson, gens de gebouwen en pas he er Ga aa erva es e der op een aparte laag met een gewoo
Daniel Sinoca, Peter Smolens, ge 3 an B oe o eo erp te make 3 Penseel op een lage De g (Opa
Sandra Troost, Andre Vil- D A soidote et raflseterand . de - _— otte het Fotofilter (Pho
lanueva, Charis Webster e ar=l g “ < &
bovenka an je werk e es een ge e ove er) Onderwate derwater) toe
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Photoshop & Elements Helpdesk

Waardienthet
Stalenpalet vo
en hoe gebrui

ikhet?

I Kleuren overbrengen

| | Dankzij dit palet kun je
. | dekleurenuit hetene :
project eenvoudig laden ¢
in het andere. |

=3
&

277

Kleur selecteren Ga om te
beginnen naar Venster>Stalen
| | (Window>Swatches). Voeg

| | vervolgens je favoriete kleuren
I | toedooreen monsterte
nemen met het Pipet (Eye-
dropper, I) en dan op het linker
pictogram onder in het Stalen-
palet te klikken.

© Nieuwe stalen Gebruik de
. knop Nieuwe kleurstaal
maken van voorgrondkleur
(Create New Swatch of
Foreground Color) om de
kleur waarmee je werkt te
veranderen in een kleurstaal.

Voorinstellingen Het Stalenpalet is
het beste hulpmiddel wat je kunt
bedenken als je je eigen kleurenpalet
wilt samenstellen, maar het is ook
reuzehandig als je de voorinstellingen
van Photoshop wilt gebruiken.

Stalen verwijderen Verwij-
der overbodige stalen uit
het palet door erop te
Alt-klikken, of gebruik het
prullenbakpictogram.

r— Inhoud

Gebruik: ‘>\7la>rgrondldeur T

— O

Modus: Normaal
Dekking: L%
"1 Transparantie behouden

i ' 0 Verfiinhet schilderijmet
0 Voeg eenllegelaagtoe als Met het Mixerpenseel 0 Gebruik het/Penseel verschillende aanpassings-
achtergrond envul hem met (Mixer Brush) wek je het (Brush) opeenapartelaag  lagen, waaronder Selectieve kleur

bruinvia Bewerken>Vullen (Edit> kunstwerk tot leven. Een portret- om hier enidaar wat kleur toe'te (Selective Color), Levendigheid
Fill)iof met het Emmertje (Paint foto.op eenaparte laag meteen voegenop de achtergrond, rond het  (Vibrance) en Niveaus (Levels). Een

Bucket). Deze tint vormtide basis geringe Dekking (Opacity) dient gezichtvanhetmodel. Zocreéerje  subtiel geel tintie maakt hethele-
van het schilderij. als'referentie. diepte. maal af:
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Fiotoshops

; 0 Controleerofide tekstele-

01 Gebruik het gereedschap 0 Activeer detekstin het o Selecteeropnieuw,de tekst menten actief ziinenga,

Tekst (Type) omwoorden 3D-palet doorerop te inhet3D-palet. Concen- als je tevreden bent metide huidige
aan jewerkbestand toe te voegen klikken. Roteerendraaidelletters  treerjevervolgens op hetpalet instellingen, naar 3D>Rendering
en klik vervolgens opde 3D-knop metbehulpvan de3D-modusge- Eigenschappen/(Properties)rechts  (3D>Render)iof toets Ctri+Alt+ ,
rechtsiindeOptiebalk. Schakelvia  reedschappeninde©ptiebalk:Pas inlhetvensterenkies Schuinekant.  Shift+R. Je kuntook de knopionder
hetmenu Venster/(Window) over deHuidige weergavei(Current (Bevel) bij Vormvoorinstelling in'het 3D-palet gebruikeni(het'der-
naarde 3D-werkruimtealsdatniet  View) eventueelaanensspeelmet  (Shape Presets). Verhoogde de pictogram). Leunachterover
automatisch gebeurtenneemhet,  deinstellingenivan Oneindig licht Extrusiediepte (Extrusion/Depth) tenwijl Photoshop de definitieve
gereedschap Verplaatsen (Move). (Infinite Light). vandelletters. versiewvan jewerk produceert.

3D-palet Het 3D-palet laat zien uit welke elementen W
de 3D-scéne bestaat, zoals objecten, lichten, ’
netten, materialen en weergaven. Het palet
Eigenschappen (Properties) past zich aan

k afhankelijk van het onderdeel dat je hier selecteert.

( )

3D-modusgereedschappen Gebruik de
extra opties die het gereedschap Verplaat-
sen (Move) in de 3D-modus (3D Mode) te

PS Bestand Bewerken Afb ding Llaag Tekst Selecteren Filter 3D Weergave Venster Help

|

g8 B i oo 0. o 1o | i g |
e e e e B UL U bieden heeft om 3D-objecten te roteren,
om hun z-as te draaiten, te verslepen, te
kverschuiven of te schalen.

(=%

=,

",

z

£,

<.

&,

=,

&,

&, Eigenschappen Het palet
0. Eigenschappen (Properties)
& heeft een sterke band met
2 het 3D-palet en verandert
T afhankelijk van de situatie.

: Hij toont steeds de relevante

Wi . instellingen die je kunt

&1 1 | aanpassen. Houd beide
o0 | paletten constant open om
QL " zo efficiént mogelijk te
w S (SO G kunnen werken.

® Grensrastricba 18

% ® & Onendglchts

o) e L Ol

o) >

{7) Keuren Ineariseren V] Schaduwen
Verborgen verwiderans

(Bronbewerken Staat er een typfout in

| jetekst? Geen nood! Klik gewoon op
Bron bewerken (Edit Source), wijzig de
tekstlaag die je als basis hebt gebruikt,
sla de wijzigingen op en sluit het
bestand om terug te keren naar je
bijgewerkte 3D-project.

Schaduwen Als je de 3D-typografie
selecteert, kun je via het Eigen-
schappenpalet Opgevangen
schaduwen (Catch Shadows) en
Projectieschaduwen (Cast Sha-
| dows) toevoegen. Vink ze aan en uit
| om te kijken wat het beste staat.

(] tinen

& =

\
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Photoshop

Waarvoor gebruik ik het filter Voor :
Camera Raw in Photoshop CC? R {
Lisette Kruijsen “k\

Camera Raw is tegenwoordig ook in Photoshop te vinden *‘ t g p
in de vorm van een filter. Daardoor is deze software wat [ » —
toegankelijker geworden en kun je de aanpassingen | \ . "
direct op elke willekeurige laag toepassen. Om non- L s =
destructief te kunnen werken, moet je de te bewerken
laag eerst omzetten in een Slim object (Smart Object)
via een rechtsklik op de laag in het Lagenpalet. Kies in
het menu dat verschijnt Omzetten in slim object (Con-
vert to Smart Object). Ga vervolgens naar Filter>Camera
Raw Filter (Filter>Camera Raw-filter). Je foto komt nu in
een apart venster te staan, met tal van instelmogelijk-
heden die misschien een tikkeltje overweldigend ogen.
Maak je echter geen zorgen, want Camera Raw werkt
heel intuitief. Gebruik de pictogrammen onder het histo-
gram om te bladeren tussen de verschillende catego-
rieén en verander de bijbehorende instellingen met de
schuifregelaars. In het voorbeeld hebben we de Tempe-
ratuur (Temperature) en Helderheid (Clarity) aangepast
om meer warmte en details te genereren. Bij het tabblad
Effecten (Effects, klik op de fx-knop) pasten we de instel-
lingen bij Vignettering na uitsnijden (Post Crop Vignet-
ting) aan. Zo maakten we de randen van de foto
donkerder, om de blik van de kijker naar binnen te leiden.

Photoshop

Ik wil graag zelf een decoratieve
rand om mijn foto maken in Photo-
shop. Hoe pak ik dit aan?

Jaap Hooghof

Met wat hulp van maskers en filters kun je eenvoudig het
rechtlijnige karakter van je Photoshopwerk veranderen
door een rafelige rand toe te voegen. Maak om te begin-
nen een nieuwe laag onder de Achtergrondlaag (ontgren-
del deze eventueel eerst met een dubbelklik) en vul hem
met wit (Ctrl+Backspace). Maak met het Rechthoekig
selectiekader nu een selectie binnen de grenzen van het
canvas, op de plek waar de rand moet komen. Klik op de
knop Laagmasker toevoegen (Add Layer Mask) onder in
het Lagenpalet. Ga terwijl het masker actief is naar
Filter>Penseelstreek>Spetters (Filter>Brush
Strokes>Spatter). Maximaliseer de Straal (Radius) en
stel Vloeiend (Smoothness) in op 10. Als je de rafels wil
intensiveren, pas je het filter gewoon nog een keer toe
door Ctrl+F te toetsen. Voorkom dat er een patroon
zichtbaar wordt door hier en daar met de Natte vinger
(Smudge) over het masker te vegen.
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Helpdesk Photoshop & Elements

Scherptediepte toevoegen aan een portret-
foto in Elements, hoe doe ik dat?
Isa Wolde

Een van de beste manieren om een portretfoto op te laten vallen is door
scherptediepte toe te voegen. Op die manier kun je de achtergrond
vervagen en laten contrasteren met het scherpe model. Photoshop Ele-
ments biedt een handige methode aan waarmee je het gewenste effect
stap voor stap kunt realiseren. Open de foto die je wilt bewerken in
Photoshop Elements en schakel over naar de modus Met instructies
(Guided). Je vindt Scherptediepte (Depth of Field) bij Foto-effecten
(Photo-Effects). Je kunt het effect op twee manieren toepassen: Eenvou-
dig (Simple) of Aangepast (Custom). Doorgaans leidt de laatste optie tot
betere resultaten. Elements vraagt je om een selectie van je onderwerp
te maken met Snelle selectie (Quick Selection). Schilder hiermee ge-
woon over het gezicht. Houd Shift ingedrukt als je delen aan de selectie
wilt toevoegen, of Alt om ze eruit te verwijderen. Klik op de knop Verva-
ging toevoegen (Add Blur) en stel met de bijbehorende regelaar de
sterkte van het effect in. Klik op Gereed (Done) als je tevreden bent.

Hoe laat ik een foto oud lijken?
Jan de Winter

De modus Met instructies (Guided) van Photoshop Elements
bevat een aantal leuke bewerkingen, waaronder Ouderwetse
foto (Old Fashioned Photo), waarmee je een gewone foto
interessanter kunt maken. Hiermee wek je de suggestie dat de
foto uit vervlogen tijden stamt. Klik op Ouderwetse foto onder
Foto-effecten (Photo Effects) om de aanpassing te openen. De
eerste stap bestaat uit het omzetten naar zwart-wit. Hierbij kun
je uit drie stijlen kiezen: Krant (Newspaper), Urban en Levendig
(Vivid). Wij gaan in dit geval voor Urban, omdat deze optie het
vaak goed doet bij architectuurfoto's, maar elke afbeelding is
anders. Kies dus de optie die bij jouw foto past. In de tweede
stap pas je de Tint (Tone) aan. Werk in deze fase subtiel! In de
derde stap voeg je met elke druk op de knop structuur toe. Tot
slot geef je de foto de gewenste (sepia)tint door de Kleurtoon/
verzadiging (Hue/Saturation) te veranderen.

Verscherp je close-ups met Hoog-
doorlaat (of Hooglichten)

: O Ga naar Filter>0verige>
Hoogdoorlaat (Filter> eT e 7
modusivan de gekopi- Other>High Pass). Stel de Straal o Door deschuifregelaar

01 Hoogdoorlaat (High/Pass, in O Verander de overvloei-
Elements Hooglichten (High:

lights) geheten)is geen verscher- eerde laagin Fellicht((Hard Light)  (Radius)eerstinop 0,1 pxenver- onder Straal helemaal'naar
pingsfilter, maarkan primazo met behulpivan het uitklapmenuiin hooghem vervolgensigeleidelijktot  rechts te'schuiven verander jede
gebruikt worden. Dupliceer om te het Lagenpalet. Het contrast 5 px omdescherpte van jefotoite belichting van de afbeelding enkun
beginnen de Achtergrondlaag. wordt nu aanzienlijk hoger. verbeteren. je een theatraal effect.creéren.
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Photoshop

Ik wil een gewone foto graag op
een afbeelding uit een oud tijd-
schrift laten lijken. Hoe doe ik dat?

Samantha Roads

Om deze foto van het Lincoln Memorial er anders uit te
laten zien dan alle andere afbeeldingen van dit monu-
ment die er in omloop zijn, duiken we in de catacomben
van Photoshop. De methode die we gebruiken, werkt
het best met een foto die niet al te veel contrast bevat.

Open om te beginnen de foto die je wilt bewerken in
Photoshop en maak meteen een kopie van de Achter-
grondlaag (Ctrl+J). Pas het filter Posterranden (Poster
Edges) toe via Filter>Artistiek. Hoewel we je aanmoedi-
gen om te experimenteren en aan de schuiven te slepen,
kun je in dit geval rustig vertrouwen op de standaardin-
stellingen. Ga nu naar Laag>Nieuwe aanpassingslaag>
Drempel (Layer>New Adjustment Layer>Threshold).
Stel Drempelwaarde (Threshold Level) in op 165. Welke
instellingen het beste werken is uiteraard afhankelijk van
je startfoto. Dupliceer de Posterrandenlaag, sleep hem
naar de bovenkant van het Lagenpalet en verander de
overvloeimodus in Vermenigvuldigen (Multiply). Om de
kleuren van de afbeelding te verfijnen gebruik je een
aanpassingslaag Kleurtoon/verzadiging (Hue/Satura-
tion) en stel je Kleurtoon in op +12, Verzadiging op +79
en Lichtheid (Lightness) op +8.

Wat kan ik in Photoshop Elements doen om van een kleu-
renfoto een krachtige zwart-witafbeelding te maken?

Hellevi Pettersson

Soms wordt een foto flets en oninteressant als
je alle kleur verwijdert. Gelukkig beschikt Photo-
shop Elements over een aantal middelen waar-
mee je heel gericht een sterke zwart-witfoto
kunt produceren. Het is namelijk mogelijk om
de belichting van elk kleurkanaal apart aan te
passen, waardoor je meer controle hebt over de

omzetting. En dat is te zien!

Open de betreffende foto in
Elements en dupliceer voor de
veiligheid de Achtergrondlaag
(Ctrl+J). Ga naar Verbeteren (Enhan-
ce) en kies Omzetten in zwart-wit
(Convert to Black and White) of toets
Ctrl+Alt+B). Links het dialoogvenster
dat verschijnt kun je een keuze maken
uit een aantal voorinstellingen. Met de
regelaar rechts kun je de intensiteit
van elke kleur aanpassen. Experimen-
teer en onthoud daarbij dat je iedere
stap ongedaan kunt maken met
Ctrl+Z. Je kunt ook helemaal opnieuw
beginnen als je op de knop Herstellen
(Reset) klikt.

Combineerde
natuur meteen
dierenportret

oy
v

01 Open jefavoriete dierenfoto om
telbeginnen en dupliceer'de
Achtergrondlaag: Toets Ctrl+Shift+U
om de kopie zwart:wit te makenien sleep
een fotovan gras op je canvas.

] [

Dupliceer delaag met het gras

(eventueel meerdere keren)en
verzamel dellagenineengroepi(selec-
teer zeen toets Ctrl+G). Activeer Vrije
transformatie (Ctrl+T) enroteer de/lagen
zodat het gras de richtingivan de vacht
volgt. Gebruik maskers om de zichtbaar-
heidvan de stukken gras te beperken.

0 nogmaals ensleepde kopie
bovenop delaagstapel. Stelde overvioei-
modus in op Kleur tegenhouden(Color
Dodge). Ga naarFilter>Vervagen>Gaus-
siaans vervagen (Filter>Blur>Gaussian
Blur), experimenteermet deiinstellingen
en klik op OK als je tevredenibent.

0 Zijn we'toe aan de laatste lood-
jes. Verzamel alle zichtbare lagen opieen
nieuwe, samengestelde laag door Ctrl+
Alt+Shift+E te toetsen. Gebruik vervol-
genshet Retoucheerpenseel (Healing
Brush) en de Natte vinger (Smudge) om
oneffenheden weg te werken.
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Helpdesk Photoshop & Elements

Photoshop

Ook als ik met een statief fotografeer, is de
horizon in mijn foto's vaak een beetje scheef.
Kan ik hier wat aan doen in Photoshop?

Willem van der Meer

Sinds de introductie van CS6 kun je een foto rechtzetten en
direct bijsnijden met het gereedschap Uitsnijden. Voor die tijd
was je aangewezen op de Liniaal (Ruler), in de gereedschap-
penbalk verscholen achter het Pipet (Eyedropper).

Open de foto die je wilt bewerken, activeer het gereed-
schap Uitsnijden en klik op de liniaal voor het woord Recht-

trekken (Straighten) in de Optiebalk (of neem meteen de Lini- g

aal uit de gereedschappenbalk als je geen CS6 of CC hebt).
Sleep een lijn langs de horizon in je foto. In oudere versies van
Photoshop moet je nu nog op Rechttrekken (Straighten) of
Laag rechttrekken (Straighten Layer) in de Optiebalk klikken,
maar in Photoshop CS6 of CC wordt je afbeelding meteen
geroteerd en bijgesneden. Je moet de transformatie dan nog
wel even bevestigen door Enter te toetsen. Een kind kan de
was doen! Houd er wel rekening mee dat de foto wat kleiner
wordt door deze bewerking, want Photoshop snijdt rondom
de lege randen weg. In CS6 en CC blijven de originele pixels
bewaard als je dat wilt, ook al zijn ze niet zichtbaar.

Deze schitterende foto van mijn kleindochter zou ik
graag digitaal 'inlijsten’, zodat ik hem op die manier in een
PowerPoint-presentatie tijdens een familiefeest kan tonen.

Is er een manier om dat snel voor elkaar te krijgen?
Nellie de Swart

Photoshop Elements bevat een gigantische bronnen-
bibliotheek met onder meer achtergronden, sier-
ornamenten en fotolijstjes, dus open de foto die je
wilt inlijsten in dit programma. Schakel over naar de
Expertmodus en klik op de knop Afbeeldingen (Grap-
hics, het plusteken) énder het Lagenpalet. Met behulp
van het uitklapmenu linksboven in het rechterpaneel
sorteer je de bronnen op Type (Style) en kies je rechts
de optie Kaders (Frames). Zoek een lijstje dat je bevalt
en dubbelklik om hem rond de foto te plaatsen. Niet
tevreden? Dubbelklik gewoon op een ander exemplaar
om te wisselen. Let op! Photoshop Elements down-
loadt veel bronnen pas op het moment dat je ze nodig
hebt. Zo staan er niet onnodig veel data op je compu-
ter, maar het betekent wel dat je een internetverbin-
ding moet hebben om alle kaders te kunnen
gebruiken.

Schaal je foto met de schuifregelaar linksboven met
het transformatiekader op het canvas en positioneer
hem binnen de lijst door te slepen. Toets Enter als je
tevreden bent en sla de afbeelding op. Als je de
ingelijste foto zonder witte achtergrond in een ander
bestand wilt plaatsen, kun je het beste de bestands-
indeling 'png' gebruiken. PowerPoint kan daarmee
. overweg, in tegenstelling tot psd.
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Kijk voor de meest actuele aanbieding op

www.fnl.nl/photoshopmagazineabo

- Profiteer van kortingen

- Abonnement met cadeau

-ledere editie de leukste workshops
- In huis nog voordat hij in de winkel ligt

Klantenservice Nederland

De klantenservice in Nederland is bereikbaar
via photoshopmagazine@aboland.nl of via
Postbus 20, 1910 AA Uitgeest t.a.v. Klanten-
service Photoshop Magazine. Telefonisch is
de klantenservice bereikbaar op werkdagen
van 9:00 tot 17:00 uur via telefoonnummer
0251-760122.

Klantenservice Belgié

De klantenservice in Belgié is bereikbaar
via photoshopmagazine@aboland.nl of

via Diependaalweg 6, 3020 Herent ta.v.
Klantenservice Photoshop Magazine.
Telefonisch is de klantenservice bereikbaar
op werkdagen van 9:00 tot 17:00 uur via
telefoonnummer 028-085523. Het afsluiten
van een abonnement kan telefonisch of
via www.bladenbox be.

Abonnementsprijzen

Photoshop Magazine kost €7,99 per num-
mer. Het standaardtarief voor Photoshop
Magazine is €72,50 voor 10 nummers. Deze
prijs is bij betaling via automatische incasso.
Voor betaling per acceptgiro geldt een
toeslag van €2,50. Abonnementen worden
na een jaar automatisch verlengd tegen het
dan geldende standaardtarief. Het opzeg-
gen van een abonnement kan schriftelijk
per post of e-mail of via www.aboland.nl of
www.aboland.be. Vermeld voor een spoedig
antwoord duidelijk de abonnee- en adres-
gegevens (zie adresetiket).

Algemene voorwaarden

De algemene voorwaarden zijn te vinden
op de website www.fnl.nl. Deze voor-
waarden zijn ook schriftelijk op te vragen
bij Abonnementenland, Postbus 20,

1910 AA Uitgeest.
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Community Volgend nummer

Vijf fantastische filterprojecten

Ontdek de flexibiliteit van de filters
van Photoshop

Volgend nummer

Photoshop Magazine 31 ligt vanaf 10 februari in de winkels en je kunt hem vanaf 3 februari
al vooruit bestellen via www.fnl.nl. Zo zit je nooit om een Photoshopworkshop verlegen!

AL - 1
Maak griezelige lichteffecten =~ Verrassend fruitig |
Creéer betoverende beelden met Ook met Photoshop Elements maak
eenvoudige technieken | Je geavanceerde fotomanipulaties

Aankondiging artikelen onder voorbehoud
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